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Electronic Health Record (RPMS-EHR) Version 1.1

Preface

This document targets all users of the Indian Health Service Electronic Health Record
(RPMS-EHR). The RPMS-EHR represents a novel approach to electronic health
records. Built on the VueCentric® Framework, the RPMS-EHR is a highly
customizable window into a patient’s health record. Because of its flexibility, the
RPMS-EHR can be tailored to meet the needs of a wide range of user roles:
providers, nurses, pharmacists, clerks, and so on. This document describes the
functional components of the RPMS-EHR. Because the exact layout and
configuration of the RPMS-EHR will vary among user roles and healthcare facilities,
the components available to a given user will also vary. As a result, each available
component occupies its own chapter and some chapters might not be applicable to all
settings.
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1.0 Introduction

The Indian Health Services Electronic Health Report (EHR) application is based on a
component framework. This means that the application the user sees is actually
composed of functional components most suited to the user’s role in patient care.
Thus, the application used by a ward clerk will look much different from that used by
a physician. This User Manual is organized into chapters, where each chapter is
devoted to a particular functional component (e.g., order entry). Depending on a
user’s role, some chapters will be valid while others will not.

1.1 Rules of Behavior

This mandatory section was written by the IHS. It does not explain any of the
functionality of the RPMS-EHR software.

1.1.1 RPMS User

In addition to these rules, each application may include additional RoBs, which may
be defined within the individual application’s documentation (e.g., PCC, Dental,
Pharmacy).

1.1.1.1 Access
RPMS Users shall:
e Only use data for which you have been granted authorization.

e Only give information to personnel who have access authority and have a need to
know.

e Always verify a caller’s identification and job purpose with your supervisor or the
entity provided as employer before providing any type of information system
access, sensitive information, or non-public agency information.

¢ Be aware that personal use of information resources is authorized on a limited
basis within the provisions Indian Health Manual Chapter 6 OMS Limited
Personal Use of Information Technology Resources TN 03-05, August 6, 2003.

Users Shall Not:

e Retrieve information for someone who does not have authority to access the
information.

e Access, research, or change any user account, file, directory, table, or record not
required to perform your OFFICIAL duties.

e Store sensitive files on a PC hard drive, or portable devices or media, if access to
the PC or files cannot be physically or technically limited.
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Exceed their authorized access limits in RPMS by changing information or
searching databases beyond the responsibilities of their job or by divulging
information to anyone not authorized to know that information.

1.1.1.2 Logging On To The System
RPMS Users shall:

Have a unique User Identification/Account name and password.

Be granted access based on authenticating the account name and password
entered.

Be locked out of an account after 5 successive failed login attempts within a
specified time period (e.g., one hour).

1.1.1.3 Information Accessibility

RPMS shall restrict access to information based on the type and identity of the user.
However, regardless of the type of user, access shall be restricted to the minimum
level necessary to perform the job.

Users Shall

Access only those documents they created and those other documents to which
they have a valid need-to-know and to which they have specifically granted
access through an RPMS application based on their menus (job roles), keys, and
FileMan access codes. Some users may be afforded additional privileges based on
the function they perform such as system administrator or application
administrator.

Acquire a written preauthorization in accordance with IHS policies and
procedures prior to interconnection to or transferring data from RPMS.

Behave in an ethical, technically proficient, informed, and trustworthy manner.
Logout of the system whenever they leave the vicinity of their PC.
Be alert to threats and vulnerabilities in the security of the system.

Report all security incidents to their local Information System Security Officer
(ISSO)

Differentiate tasks and functions to ensure that no one person has sole access to or
control over important resources.

Protect all sensitive data entrusted to them as part of their government
employment.

Shall abide by all Department and Agency policies and procedures and guidelines
related to ethics, conduct, behavior and IT information processes.
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1.1.1.4 Accountability
Users Shall:

Behave in an ethical, technically proficient, informed, and trustworthy manner.
Logout of the system whenever they leave the vicinity of their PC.
Be alert to threats and vulnerabilities in the security of the system.

Report all security incidents to their local Information System Security Officer
(ISSO)

Differentiate tasks and functions to ensure that no one person has sole access to or
control over important resources.

Protect all sensitive data entrusted to them as part of their government
employment.

Shall abide by all Department and Agency policies and procedures and guidelines
related to ethics, conduct, behavior and IT information processes.

1.1.1.5 Confidentiality
Users Shall:

Be aware of the sensitivity of electronic and hardcopy information, and protect it
accordingly.

Store hardcopy reports/storage media containing confidential information in a
locked room or cabinet.

Erase sensitive data on storage media, prior to reusing or disposing of the media.
Protect all RPMS terminals from public viewing at all times.
Abide by all HIPAA regulations to ensure patient confidentiality. Users Shall Not:

Allow confidential information to remain on the PC screen when someone who is
not authorized to that data is in the vicinity.

Store sensitive files on a portable device or media without encrypting.

1.1.1.6 Integrity
Users Shall:

Protect your system against viruses and similar malicious programs.
Observe all software license agreements.

Follow industry standard procedures for maintaining and managing RPMS hard-
ware, operating system software, application software, and/or database software
and database tables.

Comply with all copyright regulations and license agreements associated with
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RPMS software. Users Shall Not:

Violate Federal copyright laws.
Install or use unauthorized software within the system libraries or folders.

Use freeware, shareware or public domain software on/with the system without
your manager’s written permission and without scanning it for viruses first.

1.1.1.7 Passwords
Users Shall:

Change passwords a minimum of every 90 days.
Create passwords with a minimum of eight characters.

If the system allows, use a combination of alpha, numeric characters for pass-
words, with at least one uppercase letter, one lower case letter, and one number. It
is recommended, if possible, that a special character also be used in the password.

Change vendor-supplied passwords immediately.

Protect passwords by committing them to memory or store them in a safe place
(do not store passwords in login scripts, or batch files.

Change password immediately if password has been seen, guessed or otherwise
compromised; and report the compromise or suspected compromise to your 1SSO.

Keep user identifications (ID) and passwords confidential

Users Shall Not:

Use common words found in any dictionary as a password.

Use obvious readable passwords or passwords that incorporate personal data
elements (e.g., user’s name, date of birth, address, telephone number, or social
security number; names of children or spouses; favorite band, sports team, or
automobile; or other personal attributes).

Share passwords/IDs with anyone or accept the use of another’s password/ID,
even if offered.

Reuse passwords. A new password must contain no more than five characters per
8 characters from the previous password.

Post passwords.

Keep a password list in an obvious place, such as under keyboards, in desk
drawers, or in any other location where it might be disclosed.

Give a password out over the phone.
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1.1.1.8 Backups
Users Shall:

¢ Plan for contingencies such as physical disasters, loss of processing, and disclo-
sure of information by preparing alternate work strategies and system recovery
mechanisms.

e Make backups of systems and files on a regular, defined basis.

e If possible, store backups away from the system in a secure environment. Users
Shall Not:

e Violate Federal copyright laws.
e Install or use unauthorized software within the system libraries or folders.

e Use freeware, shareware or public domain software on/with the system without
your manager’s written permission and without scanning it for viruses first.

1.1.1.9 Reporting
Users Shall:

e Contact and inform your ISSO that you have identified an IT security incident and
you will begin the reporting process by providing an IT Incident Reporting Form
regarding this incident.

e Report security incidents as detailed in IHS SOP 05-03, Incident Handling Guide.
Users Shall Not:

e Assume that someone else has already reported an incident. The risk of an
incident going unreported far outweighs the possibility that an incident gets
reported more than once.

1.1.1.10 Session Time QOuts

RPMS system implements system-based timeouts that back users out of a prompt
after no more than 5 minutes of inactivity.

Users Shall:

e Utilize a screen saver with password protection set to suspend operations at no
greater than 10-minutes of inactivity. This will prevent inappropriate access and
viewing of any material displayed on your screen after some period of inactivity.

Users Shall Not:

e Utilize a screen saver with password protection set to suspend operations at no
greater than 10-minutes of inactivity. This will prevent inappropriate access and
viewing of any material displayed on your screen after some period of inactivity.
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1.1.1.11 Hardware
Users Shall:

Avoid placing system equipment near obvious environmental hazards (e.g., water
pipes).

Keep an inventory of all system equipment.

Keep records of maintenance/repairs performed on system equipment. Users Shall
Not:

Do not eat or drink near system equipment.

1.1.1.12 Awareness
Users Shall:

Participate in organization-wide security training as required.

Read and adhere to security information pertaining to system hardware and soft-
ware.

Take the annual information security awareness.

Read all applicable RPMS Manuals for the applications used in their jobs.

1.1.1.13 Remote Access

Each subscriber organization establishes its own policies for determining which
employees may work at home or in other remote workplace locations. Any remote
work arrangement should include policies that:

Are in writing.

Provide authentication of the remote user through the use of 1D and password or
other acceptable technical means.

Outline the work requirements and the security safeguards and procedures the
employee is expected to follow.

Ensure adequate storage of files, removal and non-recovery of temporary files
created in processing sensitive data, virus protection, intrusion detection, and pro-
vides physical security for government equipment and sensitive data.

Establish mechanisms to back up data created and/or stored at alternate work
locations.

Remote Users Shall:

Remotely access RPMS through a virtual private network (VPN) whenever
possible. Use of direct dial in access must be justified and approved in writing and
its use secured in accordance with industry best practices or government
procedures.
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Remote Users Shall Not:

Disable any encryption established for network, internet and web browser
communications.

1.1.2 RPMS Developers
Developers Shall:

Always be mindful of protecting the confidentiality, availability, and integrity of
RPMS when writing or revising code.

Always follow the IHS RPMS Programming Standards and Conventions (SAC)
when developing for RPMS.

Only access information or code within the namespaces for which they have been
assigned as part of their duties.

Remember that all RPMS code is the property of the U.S. Government, not the
developer.

Shall not access live production systems without obtaining appropriate written
access, shall only retain that access for the shortest period possible to accomplish
the task that requires the access.

Shall observe separation of duties policies and procedures to the fullest extent
possible.

Shall document or comment all changes to any RPMS software at the time the
change or update is made. Documentation shall include the programmer’s initials,
date of change and reason for the change.

Shall use checksums or other integrity mechanism when releasing their certified
applications to assure the integrity of the routines within their RPMS applications.

Shall follow industry best standards for systems they are assigned to develop or
maintain; abide by all Department and Agency policies and procedures.

Shall document and implement security processes whenever available.
Developers Shall Not:

Write any code that adversely impacts RPMS, such as backdoor access, “Easter
eggs,” time bombs, or any other malicious code or make inappropriate comments
within the code, manuals, or help frames.

Grant any user or system administrator access to RPMS unless proper
documentation is provided.

Not release any sensitive agency or patient information.
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1.1.3 Privileged User

Personnel who have significant access to processes and data in RPMS, such as,
system security administrators, systems administrators, and database administrators
have added responsibilities to ensure the secure operation of RPMS.

Privileged Users Shall:

Verify that any user requesting access to any RPMS system has completed the
appropriate access request forms.

Ensure that government personnel and contractor personnel understand and
comply with license requirements. End users, supervisors, and functional
managers are ultimately responsible for this compliance.

Advise the system owner on matters concerning information technology security.

Assist the system owner in developing security plans, risk assessments, and sup-
porting documentation for the certification and accreditation process.

Ensure that any changes to RPMS that affect contingency and disaster recovery
plans are conveyed to the person responsible for maintaining continuity of
operations plans.

Ensure that adequate physical and administrative safeguards are operational
within their areas of responsibility and that access to information and data is
restricted to authorized personnel on a need to know basis.

Verify that users have received appropriate security training before allowing
access to RPMS.

Implement applicable security access procedures and mechanisms, incorporate
appropriate levels of system auditing, and review audit logs.

Document and investigate known or suspected security incidents or violations and
report them to the ISSO, CISO, and systems owner.

Protect the supervisor, superuser or system administrator passwords.

Avoid instances where the same individual has responsibility for several functions
(i.e., transaction entry and transaction approval).

Watch for unscheduled, unusual, and unauthorized programs.
Help train system users on the appropriate use and security of the system.

Establish protective controls to ensure the accountability, integrity,
confidentiality, and availability of the system.

Replace passwords when a compromise is suspected. Delete user accounts as
quickly as possible from the time that the user is no longer authorized system.
Passwords forgotten by their owner should be replaced, not reissued.
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e Terminate user accounts when a user transfers or has been terminated. If the user
has authority to grant authorizations to others, review these other authorizations.
Retrieve any devices used to gain access to the system or equipment. Cancel
logon IDs and passwords, and delete or reassign related active and back up files.

e Use asuspend program to prevent an unauthorized user from logging on with the
current user's ID if the system is left on and unattended.

e Verify the identity of the user when resetting passwords. This can be done either
in person or having the user answer a question that can be compared to one in the
administrator’s database.

o Shall follow industry best standards for systems they are assigned to; abide by all
Department and Agency policies and procedures

Privileged Users Shall Not:

e Access any files, records, systems, etc., that are not explicitly needed to perform
their duties.

e Grant any user or system administrator access to RPMS unless proper
documentation is provided.

e Not release any sensitive agency or patient information.

1.2 Package Management

Because the EHR provides access to sensitive clinical data, all appropriate
precautions as outlined by the Health Insurance Portability and Accountability Act
(HIPAA) of 1996 and the Federal Privacy Act of 1974 must be undertaken.
Unauthorized use or disclosure of this information is a violation of federal law and
can result in criminal or civil penalties.

1.3 Package Operation

Operation of each functional component is described in the respective chapters.
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2.0 Activity Time

The Activity Time panel refers to how much provider time was involved in providing
and documenting the service or performing an activity. The activity is always
recorded in minutes. EHR will calculate the total activity time for both the Encounter
Time and Travel Time fields.

To add values to the Activity Time panel, you can either click in the Encounter Time
or Travel Time fields and directly type the time spend, or click on the up and down
arrows (B) to adjust the value up or down in one minute increments.

ﬂ Activity Time: DOCTOR,TEST

Enu:u:uunterTime:|3U E [rrirLtes]
Travel Time: Iﬂ E [rrirtes]

Tatal: B0 minutes

Figure 2-1: Activity Time Panel
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3.0

3.1

3.2

Adverse Reactions

Adverse Reactions

Agent - | Reaction |
ACETAMINOPHEM/COD...  MAUSEANWOMITIMNG

CALAMIME HIVES
GEMTAMYCIMN

Figure 3-1: Sample Adverse Reactions Panel

The Adverse Reactions component shows a list of the causative agents associated
with the patient’s allergies or adverse reactions, in alphabetical order. You can sort
any column by clicking on its heading.

Adverse Reactions apply to allergies and to adverse drug reactions. Allergies/adverse
reactions can be entered via the allergy tracking package.

Refresh

You can select Refresh from the right-click menu to re-display the patient’s
information in this component so that recent changes will be reflected.

Adverse Reaction Detall

When configured as a pop-up, the Adverse Reaction Detail displays when a table
entry is selected in the Adverse Reaction panel:

User Manual Adverse Reactions
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_lpix

Canzative agent: PENICILLINS ;I
Slgns/svymptons: FASH

Drug Classes: PENICILLTINA

Originated: HAGER MARY - CLINICAL COORDINATOR
Verified: Mo

ObservedsHistorical:Historical

4 o

Eli:lzr::l 55‘ Frirt... | Cloze |

Figure 3-2: Sample Adviser Reaction Detail Pop-up;

Click Close to dismiss the pop-up.

You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your
application is configured.

The detail pop-up has a right-click menu where you can copy selected text and paste
it into any free-text field within the EHR or into another application (like MS Word).
See Section A.2for more information.

User Manual Adverse Reactions
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4.0 Appointments and Visits
The Appointments component lists the appointments for the current patient. The list
includes future appointments created through scheduling where no visit currently
exists.
Appointmentz and Vizsits
AppaintrentSizit | Date « | Statuz |-'~
01GEMERAL 16Feb-200511:47  AMEULATORY
01GEMERAL 18Jan-200513:01  AMEULATORY
01GEMERAL 14-Jan-20051351  AMEULATORY
01GENERAL 25-4ug-2004 10:14  AMEULATORY
01GENERAL 13-4ug-2004 14:40 AMEULATORY
01GEMERAL 08-Jul-2004 16:24  AMBULATORY
01GEMERAL 21Map-2004 1437 AMEULATORY
29 PHARMALCY 28-4pr2004 1200 AMEULATORY
O1GEMERAL 19:4pr-2004 11:26 AMEULATORY
39 PHARMALCY 15-4pr-2004 12200 AMEULATORY
01GEMERAL 14-Apr2004 1328 AMEULATORY
05 DERMATOLOGY 14-4pr-2004 10:04  AMEULATORY
39 PHARMALCY 14-4pr-2004 10:04  AMEULATORY
05 DERMATOLOGY OF-4pr-2004 10:10 AMBULATORY |
01GEMERAL 02-4pr-2004 10:21  AMEULATORY
29 PHARMALCY 24Mar-2004 0835 CHART REVIEW
39 PHARMALCY 24-Mar-2004 08:29  AMEULATORY d
Figure 4-1: Sample Appointments and Visits Panel
The date range of appointments that appear on this panel is controlled by a parameter
that is setup by the Clinical Applications Coordinator.
The default sort is by date (newest first). You can sort any column by clicking its
heading.
4.1 Refresh
Select Refresh from the right-click menu to re-display the patient’s information in this
component so that recent changes will be reflected.
4.2 Appointment/Visit Detail
When configured as a pop-up, the Appointment/Visit Detail displays when a table
entry is selected (this is the contents of the Visit File).
User Manual Appointments and Visits
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_ioix

HRH: 3423 pOS: 23-May-2Z0D& 10:14 VISIT IEN: 76 &

---------------------------- PFC ACUTE CAFE VISIT =====escesccscssscccccsscssses
<Page L>

AUTHOR: HAGER,MARY G PATIENT MAME: DEMO,MOTHER R

SIGHED» BY: HAGER,MARY G ZTATUS: COMPLETED

WISIT: MAY 23, 2006R10:14 LOCATION: TEST CLINIC

DEMO,MOTHER R i3 a 48 year old FEMALE who
presents for
Chief Complaint: Sore arm after falling from chain while tring to change
a light bulh
HISTORY OF PRESENTING INJURY
Provided to provider by patient

Baszic Data
When did injury occur? 7 hours ago.
Where did injury occur? Home
Recent alecohol or drug use:
Ho

y _f

Figure 4-2: Sample Appointment/Visit Detail Pop-up
Click Close to dismiss the pop-up.

You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your
application is configured.

The detail pop-up has a right-click menu where you can copy selected text and paste
it into any free-text field within the EHR or into another application (like MS Word).
See Section A.2 for more information.

User Manual Appointments and Visits
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5.0 Awaiting Review

You use the Awaiting Review (&') icon on the Patient/Visit Tool Bar to
simultaneously sign several orders and documents (like notes).

Follow these steps:

1. Click the Awaiting Review icon (i‘) on the Patient/Visit Tool Bar.

2. The Review/Sign Changes dialog displays.

Review,/Sign Changes for Demo,Rayen Danielle

Signature will be applied to checked itemsz

Orders - Other Unsigned

Hold HYDROCHLOROTHIAZIDE TAB 250G TARE TwWO TABLETS E
Dizcontinue ERYTHROMYCIM SUSP 200mMG/AML TAKE 1 TEASPOOD

Electraonic Signature Code;

Ixxxxx71

| Sian I Cancel

Figure 5-1: Sample Electronic Signature Dialog for Simultaneous Signing

3. Each item that requires a signature will have a check in the checkbox in front of
it. Uncheck any items that you do not want to sign by clicking the checkbox to the
left of the item. Optionally, you can click on a group heading to alternately check
and uncheck all of its member items.

4. Enter your electronic signature code and click Sign. The checked items will now
be signed.

User Manual Awaiting Review
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6.0 Chief Complain
The Chief Complaint component is where you enter/edit information about the
current patient’s chief complaint/patient requests/diagnosis.
. Chief Complaint IFI e | |
______ | Creed Comelaint
USER.DEMO 1.] Patient complains of Chest Pamn
Figure 6-1: Chief Complaint Panel
The pretext of each pick list item can be configured by your local CAC. The pretext
of the complaint in the above example is “Patient complains of” and what appears
after the pretext is what pick list items the user selected.
The Chief Complaint dialog has three methods for entering a chief complaint: (1)
using the Symptoms radio button, (2) using the Patient Requests radio button, and
using the Diagnosis radio button.
6.1 Entering Symptoms
Follow these steps to have the symptoms automatically populate the Chief Complaint
dialog.
1. Click Add (or select the “Add Chief Complaint” option on the right-click menu)
to display the Chief Complaint dialog.
x|
= ok |
o] _Cocal |
Rash . f's“:lf'lﬁﬂi: R
Eﬂﬁw " Modesate I"" il
Sore Throat " Severs " Hous
J.-llhﬂf].I F‘mbh:m = i.'-"-' alion— | D
Venereal Disease g e
Vision Problem 'd " esks
£ Lef € Months
H Bot " Yeas
- 4
¥ Symptom " Disgnosiz Patient Request Clear |
Figure 6-2: Chief Complaint Dialog
The pick list can be configured; see your local CAC.
User Manual Chief Complain
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Enable the Symptoms radio button on the Chief Complaint dialog.

Highlight the chief complaint and then click the Append Symptom button. This
will add the chief complaint to the top panel on the Chief Complaint dialog.

If there is more than one chief complaint, highlight the complaint and then click
the Append Symptom button, then highlight the next complaint and then click the
Append Symptom button, etc. In this case the text box could look like this:

1.] Patient complaing of Back Ache, Chest Pain, Cough. ﬂ

[

Figure 6-3: Multiple Chief Complaints

5.
6.
7.

Complete the Severity and Duration panels, if necessary.
You can remove all of the text in the text box by clicking Clear.

The Chief Complaint field has a right-click menu that you can use to edit the text
of the complaint. See Section A.2 for more information.

When complete, click the OK button on the dialog. You return to the Chief
Complaint panel, with the specified symptom information in the panel.
(Otherwise, click Cancel.) Each record shows the author and the text of the
complaint.

6.2 Entering Symptoms Having a Location

The symptoms that have an asterisk following its name is one that requires you to
enter a location (for example, Infection).

Follow these steps to enter symptoms having a location:

1.
2.

Highlight a symptom (that has an asterisk following its name).
The Location panel becomes available.

Click the drop-down list at the bottom of the Location panel and make a selection.
Enable the appropriate radio button in that panel to determine the location of the
symptom.

Complete the Severity and Duration panels, if necessary.

Click the Append Symptom button. The Chief Complaint dialog could look like
this:

User Manual
October 2007

Chief Complain
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i, Chief Complaint: Ei
|

1.] Patient complaing of Infection (& baft Ear for 2 Days, ;I ok,
2 et
. Eve Pain Pain [ f.“'w."" AR =y
ety Fevei Fash® Miror ﬁ =,
ack Ache Head Ache Running Hose " Modetate s
st Pain Hemonhoidal discomfiort™  Sinuz Pam | © Severs " Hours
Iz Hoarseness Sleaplessness® T L
oid Sore Throat f‘me f. Days
ough Insomnia Wenereal Diseare Rlaght Weeks
ecieased Appelite Joink Pain" Wision Problem 0+ Left " Months
iarhea Lacesation” " Both " Years
[ o MNauses E = | & L
at Ache Oeccurs late at night | -
& Sumploms ¢ [ieace O Patient Bequess Cloa |

Figure 6-4: Sample Chief Complaint with Location Specified

5. You can remove all of the text in the text box by clicking Clear.

6. When complete, click the OK button on the dialog. You return to the Chief
Complaint panel, with the specified symptom information in the panel.
(Otherwise, click Cancel.)

6.3 Entering Patient Requests

Follow these steps to have the patient requests automatically populate the Chief

Complaint dialog.

1. Enable the Patient Requests radio button on the Chief Complaint dialog.

User Manual
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x

Cazt Femoval ‘Wotk Excuse
Corsult

E wam

| iz ation

| mjecton

Med Redill
Medical Suppl
Physical
Prenatal Vizit

5 chool Excuse
[v/eldl child wisit

 Symplom (" Diagnosis (= Palient Rlequest Clewr | Append |

Figure 6-5: Patient Requests

The pick list can be configured; see your local CAC.

2. Select the patient request and click the Append Symptom button. This will add the
request to the top panel of the Chief Complaint dialog.

3. If there is more than one patient request, highlight the request and then click the
Append Symptom button, then highlight the next request and then click the
Append Symptom button, etc. In this case the text box could look like this:

1.] Patient requests Immunization, kMed Refill. ﬂ

Figure 6-6: Multiple Patient Requests\

4. You can remove all of the text in the text box by clicking Clear.

5. When complete, click the OK button on the dialog. You return to the Chief
Complaint panel, with the specified request in the panel. (Otherwise, click
Cancel.)

6.4 Entering Diagnosis

Follow these steps to have the patient diagnoses automatically populate the Chief
Complaint dialog.

1. Enable the Diagnosis radio button on the Chief Complaint dialog.

User Manual Chief Complain
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6.5

%

Back Pan
Diabetes
Hypettansion

™ Symplom & Diagnosis  ( Patient Request Clear | Apperd |

Figure 6-7: Sample Chief Complaint for Diagnosis

The pick list can be configured; see your local CAC.

2. Select the diagnosis and click the Append Symptom button. This will add the
diagnosis to the top panel of the Chief Complaint dialog.

3. If there is more than one diagnosis, highlight the diagnosis and then click the
Append Symptom button, then highlight the next diagnosis and then click the
Append Symptom button, etc. In this case, the text box could look like this:

1.] Patient reportz Back Pain, Dishetes. =]
H

Figure 6-8: Multiple Diagnosis
4. You can remove all of the text in the text box by clicking Clear.

5. When complete, click the OK button on the dialog. You return to the Chief
Complaint panel, with the specified diagnosis in the panel. (Otherwise, click
Cancel.)

Editing a Chief Complaint Record

Follow these steps to edit a chief complaint record:

1. Select the chief complaint record you want to edit.

User Manual Chief Complain
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6.6

6.7

2. Click Edit (or select the “Edit Chief Complaint” option on the right-click menu)
to display the Chief Complaint dialog.

3. You can change any information on this dialog. See Entering Symptoms as a
guide as to how you can change the dialog.

4. When all information has been updated, click OK. You return to the Chief
Complaint panel. (Otherwise, click Cancel).

Deleting a Chief Complaint Record

Follow these steps to delete a chief complaint record:
1. Select the chief complaint record you want to delete.

2. Click Delete (or select the “Delete Chief Complaint” option on the right-click
menu) to display the “Delete Chief Complaint?” information message.

Delete Chief Complaink? x|

»._?/ Are wau sure you wank ko delete the chief complaink?

Figure 6-9: Delete Chief Complaint Information Message

Click Yes to remove the selected chief complaint record. (Otherwise, click No.)

Visit Detall

Select the “View Visit Detail” option on the right-click to view the Visit Detail pop-
up for the selected record. See Section A.3 for more information about this feature.

User Manual Chief Complain
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7.0 Consults

Consults are requests from one clinician to a hospital, service, or specialty for a
service; in addition, the Consults component permits hospital services to track the
progress of a consult order from the point of receipt through to its final resolution.
The clinician can enter an order for a consultation from within the patient’s EHR
medical record on the Consults component.

Note: Because there is no Medicine Package in EHR, any
function involving Procedures is not used by the IHS. All
procedures are included in the available consults. Also, the
Medicine Results and Remove Medicine Results are not
used.

7.1 Basic Operation
The Consults process involves the following steps.

1.

The clinician orders a consult. From within the patient’s EHR medical record, the
clinician enters an order for a consultation. The ordering clinician might first have
to enter Encounter Information.

The consult service receives an alert and a printed report (SF 513). The receiving
service can then accept the consult, forward it to another service, or send it back
to the originating clinician for more information.

The consult service accepts or rejects the consult request. To accept the consult,
the service uses the receive action. The service can also discontinue or cancel the
consult. Cancelled consults can be edited and resubmitted by the ordering
clinician. A consult service clinician sees the patient.

The Edit/Resubmit action is available for cancelled consults. The consult must be
capable of being resubmitted and the user must be authorized to resubmit
consults.

The consult service enters results and comments. Resulting is primarily handled
by writing a note to complete the consult.

The originating clinician receives a CONSULT/REQUEST UPDATED alert that
the consult is complete (if the provider has that alert turned on). The results can
now be examined and further action can be taken on behalf of the patient.

The SF 513 report becomes part of the patient’s medical record. A hard copy can
be filed and the electronic copy is online for paperless access.

The Consults component presents a list of consults in a tree view. Consults are
represented by the [#icon.

User Manual
October 2007

Consults

22



Electronic Health Record (RPMS-EHR) Version 1.1

9. Right-click in the Consults text and you can select the Find in Selected Consult
option from the pop-up menu. This option allows you to search for the specified
text. A Replace Text option is also available, but it is only active when a consult
is being edited.

10. The field below the list of consults shows a list of documents related to the
highlighted consult. These related documents are also in a tree view.

7.2 Viewing Consults

When you select a specific consult, you will see an area that lists any notes associated
with the consult. You can also click on a note entry to view the full text of the note.
See Section 7.14 for information about the icons on the Consults window.

An asterisk (*) preceding the title indicates that there are significant findings for that

consult.
—
[Pastiesnt Chal : d
 Peggy LYNH | Vizil not celected ] I [ | are | Ho
S B e ﬁ .-.-._4' "‘" ﬂ "m
[Eie Wiew Acton Oiptions
Al Conquits Sep 2304 [c] “ENT-AUDIOLOGEY ConsConme B 30
- E- Al ety Current Pat. Status: futpatcient -
]
'. Sep 2204 |p) FOC Order Information
! To Servics: ENT=AUDIOLOGY
17 |
2] Aug 1704 i) CAR From Service: OGLCENERLL
Ragquaseing Provider:  DOCTOR, TEST
Service id te Ba rendeted on an OUTPATIENT basis
Plasa: Conguleane s cholew
e garuy: Bone e
Orderable Item: ENT-AUDIOLOGY
Consult: Consult Padquest
Reason For Request: =
lII I LI PATIENT IS BEING REFERRED TO CROW ENT-AUDIGLOGY
DEPARTHENT FOR EVALUATION.
tem 1. PATIENT IS A WEWLY DIAGHOSISED WITH
New Proceshes ; 2 :
= [ Reloted Documents
Bl Sep 2304 ENT
- “|z. arrENTION:
AMIOLOCY-K. KOEBER
3. SERVICES DESIRED: This pacisnc nesds hearing cesced in boch sars.
4. ADDITIONAL COMMENTS:
I L | -

Figure 7-1: Sample of Text of Selected Consult
Follow these steps to view consults for the selected patient:

1. Go to the Consults window and highlight the consult to view (from the All
Consults list.)
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2. The text of the consult will appear in the right panel. Any notes associated with
that consult will appear in the Related Documents panel. To view the text of a related
note, click on the note.

3. You can print the contents of a selected consults by selecting File > Print. See
Section 7.12 for more information.

7.3 Consult Status
You can determine the status of a consult by the letter (abbreviation) that follows the
date. In the following example, the status of the highlighted consult is a (for active).
All Congults
= 'E'g All congults
----- [H May 1006 [a] PHYSICAL THERARY Cons Consult #: 4
L [H kay 08,06 [c] DIETETICS Cons Consult #: 3
Figure 7-2: Example of Consult Status
The following table describes the status of a consult.
Abbreviation | Name Description
a ACTIVE Orders that are active or have been
accepted by the service for processing.
c COMPLETE Orders that require no further action by
the ancillary service.
dc DISCONTINUE Orders that have been stopped prior to
expiration or completion.
p PENDING Orders that have been placed but not yet
accepted by the service filling the order.
pr PARTIAL RESULTS All or part of a consult completion report
has been entered but has not yet been
signed.
S SCHEDULED The receiving clinic has scheduled an
appointment for the patient.
X CANCELLED Orders that have been rejected by the
ancillary service without being acted on.
7.4 Changing Views
Changing the Consults view allows you to view the list of consults based on one of
several criteria. This action could speed up the selection process.
User Manual Consults

October 2007

24




Electronic Health Record (RPMS-EHR) Version 1.1

7.4.1  Types of Views
You can change the Consults view to only include the following problems:
e All Consults (this displays all consults for the current patient)
e Consults by Status (you select a status and sort order)
e Consults by Service (you select a service and sort order)
e Consults by Date Range (you select a date range and sort order)

To change the view, select the View menu and then select the desired list items. This
action changes what consults are listed in the upper-left panel of the Consults
window.

7.4.2 Custom View

Select the Custom View option on the View menu to further focus the list of consult
notes you want to view.

Alce A Consults

[ Consults by Status
Consults by Service
Consults by Dabe Range

Custom Wiew

Sawe &5 Default Wiew
Return bo Default Yiew

Icon Legend

Figure 7-3: Selecting the Custom View Option

From the List Selected Consults dialog, you can choose to display consults by any
combination of service, status, date range, group, and sort order.

User Manual Consults
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List Selected Consults

Senvice Shatus
m = Discontinued -
J Complete
P I'"WD
= All Services 'agm
Cardiclogy Sehaduled
Chaplin Partial Resuls
Cortact Lens Request Canceled =
Ekg Beginni
eginring D ate
Erndactinology I _I
Ent-Audiclogy
Epeglazz Request Ending Date
Horme Dxpgen Regquest IT DAY J
Mutnition R equest
Pharmacy Group By
Padistiy finone) =l
Prosthetcs Reguest
Pudmonary “Sicat Drder
Resparatony Thetapy " Ascendng [oldest fust)
Test Corngudt ; ;
o
Well Cd Conaul ¥ Descendng (newest firs] |
ok |  Concel |

Figure 7-4: List Selected Consults Dialog for Custom View

After clicking OK, the consults with the specified features display in the upper, left
panel of the Consults window.

7.5 Consult Participants
The Consult Originator initiates a new consult. The Consult Receiver takes the
appropriate action concerning the consult.

7.6 Initiating Consults
You can initiate a consult request by using either the Consults or the Orders
component. Both techniques are described below.
When the new consult is complete, this triggers a notification so that the recipient can
take appropriate action.

7.6.1  New Consult using the Consults Component
The following steps describe how you enter a generic consult. Your site might have
quick orders to replace the generic consult; quick orders will not be described.
Make sure that a visit is selected. Follow these steps to enter a new consult on the
Consults tab:

User Manual Consults
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1. On the Consults window, click the New Consult button (or select Action > New >
Consult) to display the Order a consult dialog.

€. Order a consult
Corsul 1o Senice/S pecially Urgency Abtention
| 1| [RouTine BN k|
gugmb:-_rgpﬂ<ért-ﬂ:dm> i‘ Patient wil be seen asan:  Place of Consullation

oD Lle [kl L ' 2 oy - = m
Caike ok = s Rl [CONSULTANT'S CHOIC 2]
T T : -
Reason for Request | Lt

il AcceptOrder|  Qut |

Figure 7-5: Order a consult Dialog

2. There are two ways to select a consult.

Method 1: Click the = button to display the tree view of the consult services.

= .-'-‘-._II Services
Dental

Dietetics
‘o Physzical Therapy

Figure 7-6: Sample Tree View of Consult Services

Method 2: Select a consult from the list below the “Consult to Service/Specialty”
field.

Conzult to ServicesSpecialty
E hdocrinology =

Digtary <Mutntion Fequest: ;I
Ek

Fwt Fnbk-doodinlamm:

Figure 7-7: Sample Consult Service to Select

After you select a consult to service by using either method, you need to complete
the steps below. In certain cases, your selection might cause a template to display;
this template information will complete the Reason for Request field.
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7.6.2

10.

Type the reason in the Reason for Request field (required). This field has a right-
click menu to aid in editing the text. See Section A.2 for more information.

The message box in the lower, left panel gives critical information. This panel has
a right-click menu to allow you to select the text and paste it into another free-text
field in the EHR or into another application (like MS Word). See Section A.2 for
more information.

Make sure the following have the correct values:

e Inpatient or Outpatient

e Urgency

e Place of Consultation

e Attention (use if you talked to someone about this consult)

You use the Provisional Diagnosis by how it is set up in RPMS. If this field is set
to REQUIRED, then you must enter the text in the field. It can be set to
SUPPRESS, so the Provisional Diagnosis field does not display. Or, it can be set
to OPTIONAL, where you can enter a provisional diagnosis or just bypass it.

The input method is determined by how it is set up in RPMS. If it is set to FREE
TEXT, then you can type any text from 2 to 80 characters in length. If it is set to
LEXICON, then you must use the Lexicon button to select a coded diagnosis
from the Clinical Lexicon.

Click Accept Order.
If there are no other consults for this patient, click Quit.

You can sign the consult now or later. If you do not sign it now, it will not appear
on the Consults tab (this is how it operates in RPMS). In addition, if you do not
sign it now, the application will notify you that the consult needs your electronic
signature.

The status of the consult will be (p) for Pending (showing that it has not been
accepted by the service filling the order).

New Consult using Orders Component

The following steps describe how you enter a generic consult. Your site might have
quick orders to replace the generic consult; quick orders will not be described.

Make sure that a visit is selected and that the view is Active Orders. Follow these
steps to order a consult using the Orders component:

1.

Select the Orders window.
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2. Select Consult in the Write Orders list to display the Order a Consult dialog.

€. Order a consult
Corsult 1o Senice/S pecialty Urgency Abtention
| 1| [RouTinE BN B
gugmngpﬂ< 15:. m-ﬂ-:dd@g& i‘ Patient wil be seen as an Place of Consulation

on <l e ] r 3 oy = v m
Cardio <Carchology> ] Irpatient  Dupatient [CONSULTANT'S CHOIC -]
Mkl g 2
Reason for Regueest | LEROn

il Accept Drder aut |

Figure 7-8: Sample Order a Consult Dialog

Note: The consults order can be labeled differently or might not
be available from your Write Orders field.

You complete this Order a consult dialog like you do when you initiate a new consult
using the Consult component. See Section 7.6.1 for more information.

7.7 Completing Consults

A consult can be completed using either the Consults component or the Notes
component. Both methods are described below.

The Complete action updates the CPRS status of a consult from Active to Completed.
The Completed status links you to TIU so that you can enter findings.

This action informs the system that you are finished with the consult. An alert is sent
to the Consult Originator and marks the record as complete.

This action not only updates the current status on the consult but also updates the Last
Activity field to COMPLETED.

7.7.1  Completing a Consult using the Consults Component

Make sure you have visit selected. Follow these steps to complete a consult using the
Consults component:

1. Select the Consults window.
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2. Select Action > Consult Results > Complete/Update Results.
3. The Consult Note Properties dialog displays.

4. Inthe Progress Note Properties dialog, select a consult note title for the Progress
Note Title field so the note can be auto-saved.

Consiilt Nobe Properties

Progress Mote Titke: | | o |

AUDIOLOGY <ENTAUDIOLOGY CONSULT> =

CHILD <WELL CHILD CONSULT NOTE> E _ Cencal |
CONSULT <EMT-AUDIOLOGY CONSULTS g

CONSULT <PHARMACY CONSULT NOTE>

CONSULT <WELL CHILD CONSULT NOTE>

ENT <ENT-ALDIOLDGY CONSULT>

ENT-AUDIOLOGY CONSULT -

Date/Time of Hote: [28-5ep-2004 10026 ui]

Author; |I:l|:-|:l:1:-|,T est j

Figure 7-9: Sample Consult Note Properties Dialog

The application automatically populates the date and time of the note as well as
the author. You can correct these fields if necessary.

The note titles listed on the Consult Note Properties dialog come from the
CONSULT document class. The Clinical Applications Coordinator is responsible
for this document class.

5. Click OK.

6. Create your note by typing the text in the right panel, by using templates (click the
Templates button), and by including any reminders (click the Reminders button).
Be sure to include any test results. See Section 30.1.3 or Section 30.1.4 for more
information.

7. You can change the title of the note by clicking the Change button (above the text
of the note in the right panel) or by selecting Action > Consult Results > Change
Title. This action causes the Consult Note Properties dialog to display.

8. The right panel has a right-click menu for editing the text of the note. These
features are the top-most options on this menu.
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Paste Clri+v
Reformat Paragrapgh Ctri+R
Check Grammar

Check Speling

Figure 7-10: Edit Options on Right-Click Menu

10.

The “Reformat Paragraph” option can be used when there are two sentences that
are separated by a return and you want them to become one paragraph. In that
case, place the cursor before the first sentence and then select the “Reformat
Paragraph” option.

From the Action > Consult Results menu, select either Sign Note Now or Save
without Signature. These same features are available on the right-click menu.

If you “Save Without Signature” the status of the consult becomes (pr) for Partial
Results. If you “Sign Note Now” the status of the consult becomes (c) for
Completed. See Section 9.0 for more information about signing the note.

7.7.2 Completing a Consult using the Notes Component
Make sure a visit is selected. Follow these steps to complete a consult using the Notes

component:

1. Select the Notes window.

2. Click the New Notes button (or select Action > New Progress Note).

3. Inthe Progress Note Properties dialog, select a consult note title for the Progress
Note Title field so that the note can be auto-saved.

4. 1f you pick a consult title, the application will search for any non-completed
consults and ask you to attach your note to the consult. You must pick a consult in
order to use a consult note title.
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Progress Nobe Properbies

(i A IR ELL CHILD CONSULT MOTE ! [1]4 I

CRISIS MOTE ~ . I
CLIMICAL WARMING j ,—I
Adverse React/lergy

A0NVAMCE DIRECTVE

PATIENT CHART REVIEW

WELL CHILD CONSLLT MOTE

Date/Time of Note: [124pr2005 1024 ..J]

Autior: |D|:ul:bu,T|:st =]

Thes progress note bile must be associated with a consult request.
Select one of the following of press cancel and chioose a different title.

R ' Procedue Stats Bioley
Oct 07,04 1336 ENT-AUDIOLOGY COMPLETE 1
Oct 07,04 1336 ENT-AUDIOLOGY PARTIAL RESULTS 1
Sep 23.04 1224 ENT-ALDIOLDGY COMPLETE 1

Figure 7-11: Sample Progress Note Properties Dialog

Additional items will appear on the dialog for titles that require entry of a

cosigner or an associated consult after you complete the Consult Title.

If necessary, change the note date and time by clicking the =] button next to the

date and selecting a new date.

If necessary, change the note author by selecting the author from the Author drop-

down list.

5. Click OK.

6. Type your note, including any test results.

7. You can use the Templates button to insert template information in the text of the

note. In addition, there is a right-click menu to aid in editing the text.

Paste Clri+y
Reformat Paragraph Chrl+Re
Check. Grammar

Check Speding

Figure 7-12: Edit Options on Right-Click Menu
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8. From the Action menu, select either Sign Note Now or Save without Signature.

These same options are available on the right-click menu in the text of the note.
See Section 9.3 for more information.

9. The note will appear on the Notes component as well as on the Consults
component.

10. If you “Save Without Signature” the status of the consult becomes (pr) for Partial
Results. If you “Sign Note Now” the status of the consult becomes (c) for
Completed.

7.7.3  Administratively Complete a Consult

If a person is set up as either an Administrative User or on an Administrative User
Team, this option exists to perform an Administrative Complete action. An
Administratively Complete does not have results attached to it.

Follow these steps to administratively complete a consult.
1. Select the Consults component.

2. Select the consult that you want to administratively complete.

3. Select Action > Consult Tracking > Administratively Complete to display the
Administratively Complete dialog.

Administratively Complete

Sigrahcant Findings - Curent slatus; Yes
ez " Mo ™ Urknown

Lomenents

Rdministratively completed this consult 9=9=04

Datetime of this action  Responsible Person
| _I Hohnzon,Caroln _'.J

(] Cancel

Figure 7-13: Sample Administratively Complete Dialog

User Manual Consults
October 2007

33



Electronic Health Record (RPMS-EHR) Version 1.1

4. Enable the appropriate radio button in the “Significant Findings” panel.

5. Add comments about the consult in the “Comments” field. This field has a right-
click menu to aid in editing the text. See Section A.2 “for more information.

6. Enter the date/time in the “Date/time of this action” field, or click the > button to
select the date and time from a calendar.

7. When the Administratively Complete dialog is finished, click OK. (Otherwise,
click Cancel.)

8. You will see “COMPLETE/UPDATE” in the Activity Grid of the text of the
consult, along with any comments below that row in the grid.

7.7.4  Using the Information in a Signed Consult
You can select text in the text of the consult. The right-click menu contains text-
editing options (like copy). Then you can paste the selected text into another free-text
field with the EHR application or into another application, like MS Word. See
Section A.2 for more information.
7.8 Consult Tracking and Consult Results Features
If someone has been chosen as a ‘service individual to notify an update user or an
update user’ or an ‘administrative user’, that person will be able to track the consults
using the EHR. This means, if that person has update status for cardiology, that
person will not be able to track ENT consults, for example.
The Action > Consult Tracking menu contains several features for tracking a consult.
Becesne
Schedule
Cancel (Deny)
;. .I'“_E‘.
Forward
Add Comment
Displary Detals
Display Results
Display 5F 513
Print SF 513
Figure 7-14: Tracking Consult Options
You can determine which options are available for a particular consult because the
active ones are those you can select.
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The Action > Consult Results menu contains several features for entering results for a

consult.

Completeflpdate Recults...

Add to Signature List

Edik Note...

Save Without Signaturs
Shgn Moke Now, ..
Idenitify Additional Sigriers
Print Mote

Figure 7-15: Consult Results Options

The EHR application does not use the “Attach Medicine Results” nor the “Remove
Medicine Results” options. These options require a medicine package not available in

the EHR.

The following table explains what the different information about the consult does:

Information Type

What It Does

Comments Adds a note to the text of a consult regarding how to administer the
consult.

Note Updates the consult and changes its status from Active to Complete.
The note becomes a Related Document of the consult.

Addendum Allows one or more people to add their medical opinions about the

consult. This becomes a Related Document of the consult.

Significant Findings

Allows the Consult Receiver to enter significant findings about a
consult. This marks the consult with an asterisk (*).

7.8.1 Receive a Consult

The Consult Receiver uses this feature to acknowledge receipt of a new consult in the
Service and to change the current CPRS status of the consult from Pending to Active.

This action puts the receiving service on record as accepting responsibility for
completing the consult. Follow these steps:

1. Select the Consults window, and select the Consult you want to receive.

2. Select Action > Consult Tracking > Receive to display the Receive Consult

dialog.
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Receive Consult

Comments
=]

Date/time of this achion Achon by
[D ochor, Test j

Ok Canvcel

Figure 7-16: Sample Receive Consult

3. Enter comments about receiving the consult in the Comments field, for example,
if there is anything unusual about the consult. This field has a right-click menu to
aid in editing the text. See Section A.2 for more information.

4. You can change the date and/or time if you need to. Enter the date/time in the
“Date/time of this action” field, or click the = button to select the date and time
from a calendar.

5. If this action should be by another person, select a name from the drop-down list
for the “Action by” field.

6. When the Receive Consult dialog is complete, click OK. The status of the consult
becomes (a) for Active.

7. The received consult information is added to the text of the consult in the Activity
grid, followed by any comments added.

Aotivity Late/Time/Zone Besponsible Person  Entered By
CPRS BELEASED OBRDER lo/07,/04 13:36 DOCTOR, TEST DOCTOR, TEST
PRINTEL TO 10/07/04 13:36

BAOD OHCP 33 COMPR

LECEIVED DOCTOR, TEST DOCTOR, TEST

Figure 7-17: Sample of Received Consult in the Text of the Consult
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7.8.2 Schedule a Consult

The Consult Receiver uses this action. The Schedule a Consult does not actually
schedule an appointment or link to a scheduling package. It does allow a convenient
way to annotate a consult after an appointment has been scheduled by some other
means. The Comments most likely will explain when the consult is scheduled.

This action changes the status of the consult to (s) for Scheduled. Follow these steps
to schedule a consult:

1. Select the Consults window.
2. 2Select the Consult you want to schedule.

3. Select Action > Consult Tracking > Schedule to display the Schedule Consult
dialog.

Schedule Consult
Comments
Seheduled with Sars| =]

™ Send aledt
Drate/time of this action  Responsible Peison

x| [Doctor.Test |

OF. Cancel

Figure 7-18: Sample Schedule Consult Dialog

4. Type the comments about the scheduled consult in the Comments field. This field
has a right-click menu to aid in editing the text. See Section A.2 for more
information.

5. Enter the date/time in the “Date/time of this action” field, or click the = button to
select the date and time from a calendar. The date/time here must established by
the healthcare facility as to its meaning. Either it is the date the Schedule a
Consult dialog was completed or it is the date for which the consult is scheduled.
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Send Alert

Select or enter name

If this action should be by another person, select a name from the drop-down list
for the Responsible Person field.

If you want to send an alert about the scheduled consult, check the Send alert
checkbox to display the Send Alert dialog.

=]|

Currently zelected recipients

Dactar, Test

Doctor, Tony
Doctor MCPRS
DontrnizJ ames 5
Doty Patsy K.
Davle Clanizza
Doyle lhs
Davleames O
Drale.5 andy L
DR Malene
DirewJermy
Drill.Droug

] | Carizel

Figure 7-19: Sample Send Alert Dialog

8. Select a name in the “Select or enter name” field. That name will appear in the
“Currently selected recipients” field.

9. To remove a name from the “Currently selected recipients” field, select it.

10. When the Send Allert is complete, click OK to have an alert sent. (Otherwise,
click Cancel to not send an alert.)

11. When the Schedule Consult dialog is complete, click OK; the status of the consult
change to (s) for Scheduled. (Otherwise, click Cancel.)

12. The scheduled consult information is added to the text of the consult in the
Activity grid, followed by comments that were added.
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Activity Date/Time/Zone Besponsikble Person Entered By
CPRS RELEASED OFRDEER lo/07/04 13:36 DOCTOR, TEST DOCTOR,TEST
PRINTED TO 1007704 13:36

EAD OHCP 33 COMPR
RECEIVED 1070704 DOCTOR, TEST DOCTOR,TEST

lentered) 1007704 13:37
Conszult received and handled over to G. Jeanotte

SCHEDULED DOCTOR, TEST DOCTOR,TEET

lentered) 10,/07/0¢4

Scheduled consult with Dana

Figure 7-20: Sample of Scheduled Consult in Text of the Consult

7.8.3 Cancel (Deny) a Consult
The Consult Receiver uses this feature to cancel a consult for completion. You must
enter a comment concerning the reason for this action.

The Consult Originator is automatically sent an alert that the request has been
cancelled (if the provider has the CONSULT REQUEST DENY/HOLD turned on).
The Consult Originator then has the option of editing and resubmitting the request.

Follow these steps to cancel a consult:
1. Select the Consults window.

2. Select the Consult you want to cancel.

3. Select Action > Consult Tracking > Cancel (Deny) to display the Cancel (Deny)
Consult dialog.
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Cancel {Deny) Consult

D ate/time of this acion  Action by

| x| [Doctor.Test |

OF. Carvel

Figure 7-21: Sample Cancel (Deny) Consult Dialog

4. Type the reason for the denied consult in the Comments field. Be specific enough
so that the Consult Originator can correct and resubmit the consult. This field has
a right-click menu to aid in editing the text. See Section A.2 for more information.

5. Enter the date/time in the “Date/time of this action” field, or click the =1 button to
select the date and time from a calendar.

6. If this action should be by another person, select a name from the drop-down list
for the “Action by” field.

7. When the Cancel (Deny) dialog is complete, click OK to have the cancelled
consult information added to the text of the consult in the Activity grid, followed
by any comments that were added. The status of the consult becomes (x) for
Cancelled. (Otherwise, click Cancel.)

7.8.4 Edit/Resubmit a Consult

The Consult Originator or the Consult Receiver uses this feature to edit a cancelled or
denied consult and then resubmit the consult. When a consult is cancelled or denied
for clerical reasons (such as insufficient data), then the information on the consult can
be edited and resubmitted with this action. Alternatively, the Consult Originator can
perform this function from the alert.

Follow these steps to edit and resubmit a consult:
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1. Select the Consults component.
2. Select the cancelled or denied consult that you want to edit and resubmit.

3. Select Action > Consult Tracking > Edit/Resubmit to display the Edit/Resubmit a
Cancelled Consult dialog.

€ Edit /Resubmit a Cancelled Consult

Cansult ko Serice/Specially Uigency Adtention
: : Place of Consultation
i g Patient will be seen as an
Display Commerds: _Cancelaion | P2 e Ay CONSULTANT'S CHOICE |
P Provisional Di -
New Commnts: I _I
Reason for Consult
=
4. ADDITIOMAL COMMENTS:
5. RECOMENDATIONS-TREATMENT GOALS:The testing should determine if the
[pacient heaeds a hearing aid.

FRezubmit I Cancel I

Figure 7-22: Sample Edit/Resubmit a Cancelled Consult

Click the Cancellation button to review the reason for denial on the Cancellation
Comments pop-up. (Click Close to dismiss the pop-up.)

€ Cancellation Comments

CANCELLED: Sep 23, 2004@810:35:06 BY: DOCTOR,TEST
Heed to have more informacion about the blow to the head, like which side
and what analysis did yvou use to determine there might be a hearing loss?

Figure 7-23: Sample Cancellation Comments Pop-up

4. You can add a new comment in the Reason for Consult field (on the Edit/
Resubmit a Cancelled Consult dialog).
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5. If needed you can add more comments in the “New Comments” field. This field
contains a right-click menu to aid in editing the text. See Section A.2 for more
information.

6. When the Edit/Resubmit a Cancelled Consult dialog is complete, click Resubmit.
(Otherwise, click Cancel.)

7. The edit/resubmit information is added to the text of the consult in the Activity
grid.

EDIT/BRESUEMITTED 1007704 17:15 DOCTOR, TEST DOCTOR, TEST

Figure 7-24: Sample Edit/Resubmitted Information in Text of Consult

7.8.5 Discontinue a Consult

The Consult Originator uses this feature to stop a consult request after it has been
signed (the Consult Receiver uses cancel). A comment can be added concerning the
reason for discontinuing the consult. You use this feature, for example, to cancel a
duplicate consult order.

The Discontinue action differs from the Cancel action in that there is not the Edit/
Resubmit action available on a discontinued order.

This action changes the status of the consult to (dc) for discontinued. A notification is
automatically is sent to the Consult Service, with information about why the consult
was discontinued.

Follow these steps to discontinue a consult:
1. Select the Consults component.

2. Select the consult that you want to discontinue.

3. Select Action > Consult Tracking > Discontinue to display the Discontinue
Consult dialog.
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Discontinue Consulk

Comments

Thiz consult needs more informarion about the blocked nasal pasfage &xXam. ‘;I

DrabeMtime of this achion  Achion by

| x| [Doctor.Test |

DOE Cancel

Figure 7-25: Sample Discontinue Consult

4. Type the reason for discontinuing the consult in the Comments field. This field
has a right-click menu to aid in editing the text. See Section A.2 for more
information.

5. Enter the date/time in the “Date/time of this action” field, or click the =] button to
select the date and time from a calendar.

6. If this action should be by another person, select a name from the drop-down list
for the “Action by” field.

7. When the Discontinue Consult dialog is complete, click OK. (Otherwise, click
Cancel.)

8. The status of the consult changes to (dc) for discontinue.

9. The discontinue consult information is added to the text of the consult in the
Activity grid, followed by any comments that were added.

[ISCONTINUED

DOCTOR, TEST DOCTOR,TEST

f04 1&: 50
This consult needs wmore information about the blocked nasal passage exam.

fentered) 10

Figure 7-26: Sample Discontinued Information about the Consult

User Manual Consults
October 2007

43



Electronic Health Record (RPMS-EHR) Version 1.1

7.8.6 Forward a Consult

You use this feature when the incorrect service receives the consult. For example, this
action could be used when Cardiology Service has mistakenly received a consult that
should have been sent to Hematology Service.

Follow these steps to forward a consult:
1. Select the Consults component.

2. Select the consult that you want to forward.

3. Select Action > Consult Tracking > Forward to display the Forward Consult
dialog.

Add Comment to Consult

Comments
Pt iz bringing care giver ve this wisic. -

[T Send alet
Datetime of this achion

(o

0k LCancel

Figure 7-27: Sample Forward Consult Dialog
4. Select the correct service in the “To service” panel.
5. If appropriate, type in or select the Attention care giver in the Attention field.

6. Type the reason for forwarding the consult in the Comments field. This field has a
right-click menu to aid in editing the text. See Section A.2 for more information.

7. Enter the date/time in the “Date/time of this action” field, or click the - button to
select the date and time from a calendar.

8. When the Forward Consult dialog is complete, click OK. (Otherwise, click
Cancel.)
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9. The forward consult information is added to the text of the consult in the Activity
grid, followed by any comments that were added.

DOCTOR,TEST

FORWAFRDED FROM 0/07,/04 DOCTOR, TEST

ENT-ATTD IO

This consult was sent to s in mistake.

Figure 7-28: Sample Forwarded Consult Information in Text of the Consult

7.8.7 Add a Comment to a Consult
The Add Comment action allows you to append a comment to a consult when
important information about the consult needs to be added to the original order or
when a caregiver needs to furnish information before the consult is ready to be closed
out.
Anyone can add comments to a consult. These differ from Addendums in that a
comment should contain information needed to administer the consult, while an
addendum is a medical statement by a patient care professional about a specific
consult.
Follow these steps to add a comment to a consult:
1. Select the Consults window.
2. Select the consult to which you want to add a comment.
3. Select Action > Consult Tracking > Add Comment to display the Add Comment

to Consult dialog.
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Add Comment to Consult

Comments

[T Send alet
Datetime of this achion

(o

Pt i= bringing care giver to this wvisie.

Figure 7-29: Add Comment to Consult Dialog

Y

4. Type the text of the comment in the Comments field. This field has a right-click

menu to aid in editing the text. See Section A.2 for more information.

5. Enter the date/time in the “Date/time of this action” field, or click the -] button to
select the date and time from a calendar.

6. If you want to send an alert about this comment, check the “Send alert” checkbox
to display the Send Alert dialog.

Send Alert x

Select or enter name

Curterily selected recipients

[DoctoTeq]

Doctor.Tomy

Doctor VCPRS

Dantro:J ames S

Droty Patsy K. j |
Dole, Clarissa

Doye Ihe

Doyde James D

Dowde,Sandy L

DR Valarie

Direw Jeary

Dibas ]

oK

Dhoctor, T est

Cancel

Figure 7-30: Sample Send Alert Dialog
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Select a name in the “Select or enter name” field. That name will appear in the
“Currently selected recipients” field.

To remove a name from the “Currently selected recipients” field, select it. When
the Send Alert dialog is complete, click OK to have an alert sent.

(Otherwise, click Cancel to not send an alert.)

7. When the Add Comment to Consult dialog is complete, click OK. (Otherwise,
click Cancel.)

8. The added comment information is added to the text of the consult in the Activity
grid, followed by any comments that were added.

Facility

Actiwity Date/Time /Zone RBesponsible Person Entered By
CPEZ RELEASED ORDER 03728704 10:25 DOCTOR, TEST DOCTOR, TEST
PRINTED TO 03/28/04 10:25

BiO OHCP 23 COMPR

ADDED COMMENT 0 4 »ICTO 5 DOCTOR,TEET

Figure 7-31: Sample of Added Comment in the Text of the Consult

7.8.8  Significant Findings for a Consult
The Consult Receiver uses this action to mark a consult has having significant
findings. When this action is completed, an asterisk (*) precedes the name of the
consult.
The significant findings action allows a clinic or service to append a significant
findings flag onto a consult (whether completed or not).
Follow these steps to enter significant findings for a consult:
1. Select the Consults component.
2. Select the consult to which you want to add significant findings.
3. Select Action > Consult Tracking > Significant Findings to display the Update

Significant Findings dialog.
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Update Significant Findings

Sigrificant Findings - Curent stabus: Yes

+ Yes " No " Unknown
Comments
Pt experiencing 60% loss in breaching efficiency.| 3
™ Send alert
D ate/tirne of this action
OF. Cancel

Figure 7-32: Sample Update Significant Findings Dialog
4. Enable the appropriate radio button in the Significant Findings panel.

5. Type information about the findings in the Comments field. This field has a right-
click menu to aid in editing the text. See Section A.2 for more information.

6. Enter the date/time in the “Date/time of this action” field, or click the = button to
select the date and time from a calendar.

7. If you want to send an alert about the significant findings, check the “Send alert”
checkbox to display the Send Alert dialog.
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Send Alert I

Select or enter name

Currently zelected recipients

Droctar, Test

Dractar, Tony

Doctar WCPRS

DantrnixJ ames S

Doty Patsy K _|
Doyle Clarissa

Doayle,lhs

DovleJames D

Daovle Sandy L

DR Walene

Direw Jermy

Drill Doug L'

] | Cancel

Figure 7-33: Sample Sent Alert Dialog

Select a name in the “Select or enter name” field. That name will appear in the
“Currently selected recipients” field.

To remove a name from the “Currently selected recipients” field, select it. When
the Send Alert is complete, click OK to have an alert sent. (Otherwise, click
Cancel to not send an alert.)

8. When the Update Significant Findings dialog is complete, click OK. (Otherwise,
click Cancel.)

9. An asterisk (*) will be before the consult containing significant findings.

Al Eu:unslts

Figure 7-34: Sample of Consult with Significant Findings in Left Panel

10. The signification findings information is added to the text of the consult in the
Activity grid, along with comments that were added.

SIC FINDING UPDATE 10/07,/04 14:06
Significant findings were: (1) left

DOCTOR,TEST

2 of patient needs corrective

lenses, () lump in throat was nob cancerous.

Figure 7-35: Sample of Significant Findings in the Text of the Consult
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7.8.9 Display Results of a Consult
This display gives only the signed results and addendum information, making it easier
to focus on the information you need. It also gives author information on unsigned
and/or released notes.
Follow these steps to display the results of a consult.
1. Select the Consults component.
2. Select the consult of which you want to display the results. Then select the
associated note in the Related Documents.
3. Select Action > Consult Tracking > Display Results to display the results of the
selected consult.
Al Contul Sep 2304 1 "ENT-AUDIOLOGY Cors Corsull 8: 30
= E- .:'lcmsd: ﬁ\l!l:mtEF!nd!ﬂgl.! b { T bl
[Z] Oct07.04 (5] "ENT-AUDIOLOGY Cors Cormt #: 35 | --——==——===========
:ﬂ Oet 0704 [p] ENT-AUDIOLOGY Cors Coreult 3: 38 e
(7] Dct07.04 [p] ENTAUDIDLOGY Cons Corsult #; 34 : s J
) S0 804 ) ENT AUDIOLOGY ConsConnt 32 |47 O TOTR: 0 2 mondmsgizs s pyrss s 29, zondas
:. Sep 2304 [c] "ENT-ALDIOLOGY Cons Consult #: 3 URCENCY: STATUS: COMPLETED
(#] Sep 2204 [p] PODIATHY Cons Corsull 3 26
2] #uag 1704 [p) CARDIOLOGY Cons Consuk i 10
*LITTLEWOLF , PECCY LYNN
406345~ 1L4 54
CROW ACENCY HMOMTAMAE 53022
(1
Hew Contult fesf TEST DOCTOR
Hew Procedure signed: 09/23/2004 12:28
S B ReltedDocumenis =~ | eeeeeseeessssseseesseee e L
B Sep 2304 ENTAUDIOLOGY COMSULT (#1718 G
Figure 7-36: Sample of Results of a Consult
7.8.10 Display Details of a Consult
The details of a consult includes:
e Current Primary Care information
e Current Eligibility information
e Order information
e Activity record
e All signed notes
e Information about unsigned notes
e Notes, Results, and Addenda
e All other fields associated with the consult
You use this when you have displayed the results of a consult and would like to return
to the details of a consult.
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Follow these steps to display the details of a consult:

1. Have the results of a consult displayed in the right panel.

2. Select Action > Consult Tracking > Display Details.

3. The details about the consult display in the right panel.

Fis Yiew pction [ptions

Sep 2304 fel  "EMT-AUDIOLOGY ConsConsul 8: 30

[5] Oct07.04 [s) ENT-AUDIOLOGY Cors Corult 8 35
|2] Dct07.04 [p] ENT-AUDIOLOGY Cors Conault 3: 35
[#] Det 07,04 [p] ENTAUDIOLOGY Cores Corvul 3: 34
|z] Sep 2804 I'DI ENT MJNEILEIGY Coﬂs Cw—* lt 33

|| Sep 2204 [nl Pﬂnmﬁ\rcm I:Dnsuiﬂ 35
a8 A0317.04 (p) CARDIOLOGY Cons Consut B 10

Hews Conaul

Currant Pat. Status: fatpatient

Ir

Order Information
To Service:

From Service: OLGENERAL

Pequesting Provider: DOCTOR, TEST

Service is to be rendered on an OUTPATIENT basis

ENT=AUDIOLOGY

Flace: Consultant"s choice
Urgency: Routine
Orderable Item: ENT=AUDIOLOGY

Consult:

Peason For Bequest:
FATIENT IS BEING REFERRED TO CROW ENT=-AUDIOLOGY
DEPARTHENT FOR EVALUATION.

Consult Request L]

Hew Procedure

1. PATIENT I35 A NEWLY DIAGNOSISED WITH:

= B Fielabed Documents

B Sep 2304 ENTAUDIOLOGY CONSULT [#118] GI

Figure 7-37: Sample of Details of a Consult

Z. ATTENTION:

7.8.11 Display SF 513 for a Consult

Follow these steps to display the SF 513 information about a consult:

1. Select the Consults component.

2. Select the consult about which you want to display SF 513 information.

3. Select Action > Consult Tracking > Display SF 513.

4. The SF 513 information displays in a pop-up window. (Click Close to dismiss the

pop-up).
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€ Sep 23,04 (c) YENT-AUDIDLOGY Cons Consult &: 30

Consult Begquest: Consulc IConsult Ne.: 30

To: ENT-AUDIOLOGY
From: OLGENERAL | Baquestad: 09,/23/72004 12:24

Requasting Facilicy: CROW HO —

NS S N S I I I I I I I I I I I N I I N I N N S S I S I I S I S S I I E I I E NI EEEEEEEEEEEED
REASON FOR REQUEST: (Complaints and findings)

PATIENT IS BEING REFERRED TD CROW ENT-AUDIOLOGY

DEPARTHENT FOR EWALUATION.

1. PATIENT I3 A NEWLY DIAGHODSISED WITH:

2. ATTENTION:
AUDIOLOGY=E. EKOBER

L
> | SERTITOATE MBCTATH Thide ward ane wands bhosvdwme mamesd den loamis smwe I —’J

Figure 7-38: Sample SF 513 Information about a Consult

7.8.12 Print SF 513 for a Consult
Follow these steps to print the SF 513 information about a consult:

1. Select the Consults component.
2. Select the consult about which you want to print SF 513 information.

3. Select Action > Consult Tracking > Print SF 513 to display the Print SF 513
dialog.
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€. Print 5F 513 M=k
Sep 2304 [2] *ENT-AUDIOLOGY ConsConsult : Frint
30 {= Chart Copy
" ‘Work Copy
Davice
[
Windows Prnter -
¥ 1 I W | - | T r—
3 <Bal QIM FFRIMTER:
9 <BAD CHS 9PRINTER> g0
33 <BAD OHCP 33 PRINTER:
35 <BAD OIM 35 SECRETARY PRINTER> &0
46 <MULL DEVICE>
74 «CR PCC DATA EMTRY PRINTER>
139 <CR LA&B LABEL PRIMTER: Li
Righit I angar | Page Length
[ ok | coxe |

[T Save as user's delault printes |

F

4.
S.

igure 7-39: Sample Print SF 513 Dialog

Enable the appropriate radio button in the Print panel.

Normally the right margin and the page length values (measured in characters) are
already defined by the printer. Select a printer to which you want to output the
information.

Whatever you select adds a label to the dialog box, such as: Print Chart Copy on:
<selected device>.

Check the “Save as user’s default printer” checkbox if appropriate.

Click OK to have the information output to the selected printer. (Otherwise, click
Cancel.) You return to the Consults component.

7.8.13 Make Addendum to a Consult
An Addendum is a medical statement by the patient care professional about a specific
Note; it supplies supplementary information on the patient. It differs from a Comment
in that an Addendum is about medical matters, where Comments, which can be
written by anyone, should contain information needed to administer the consult.
This action allows one or more people to add their medical statements about the
results of a consult. Contrast this to Add Comment, which adds a note to the consult
before it is resulted.
Follow these steps to add an addendum to a consult.
1. Select the Consults component.
2. Select the note about the Consult.
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3. Select Action > Consult Results > Make Addendum (or select the “Make
Addendum?” option on the right-click menu).

Notice the word “Addendum” appears above the consult note. Any diagnoses
appears in the lower panel.

4. Type the supplementary information about the patient’s condition in the right
panel.

Addendium lo; PHARMACY CONSLULT NOTE Sep 27 200630927 TEST.DOCTOR Charge.
Wit (/30004 MGEMERAL —I

Subyect |

r F

1] il

Disgroaes Disbeles Ml Typs | [Pamany]. Hyperiansion

Figure 7-40: Sample Addendum in Right Panel

As with other TIU objects, you can add information to the addendum by clicking
the Templates button and/or the Reminder button. Both buttons add boilerplate
information to the addendum text. See Section 30.1.3 or Section 30.1.4 for more
information.

5. You can change the properties of the addendum, click the Change button or select
Action > Consult Results > Change Title to display the Addendum Properties
dialog.
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Addendum Properties

Addendum by | Addendum b ENT-AUDIOLOGY COMNSULT Addendum to (1] 4 I
Addendum bo; EMT-AUDIDLDGY CONSULT Addendum to

Date/Time of Note: [23:5ep20041312 1

Auther: [Doctor, T est B

Figure 7-41: Sample Addendum Properties Dialog

Change the information on the Addendum Properties dialog as needed. Then click
OK. The information above the text of the addendum will reflect your changes.

6. When the addendum is complete, you can save it without a signature or sign it
now.

To save it without a signature, select Action > Consult Results > Save Without
Signature (or select the “Save Without Signature” option on the right-click menu).

To sign it now, select Action > Consult Results > Sign Note Now (or select the
“Sign Note Now” option on the right-click menu). See Section 9.3 for more
information.

7.9 Notes Associated with a Consult

The notes associated with a consult appear in the lower left panel of the Consults tab
under Related Documents.

The 2 icon indicates a note, while the Flicon indicates an addendum.

=15 Related Documents

- [ Sep23.04 ENT-
» Oct 03,04 &

] =
Figure 7-42: Sample of Related Documents for a Consult

There are several edit features associated with notes. They are found on the Consult
Results menu as well as on the right-click menu (in the text of the note).
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it ZhE| 3
o ZhElHE
Paste Chrl+y
Reformat Paragraph Ckel+R

Find in Selected Mate/Consult
Replace Text

Check Grammar
Check Spelling

Figure 7-43: Edit Features for Notes

7.9.1  Add to Signature List for Notes of Consult

The “Add to Signature List” feature places the unsigned note with other orders and
documents you need to sign for the current patient on the Notification window.

Follow these steps to add the note of a consult to your signature list:

A w o o

Select the Consults component.
Select the consult having the unsigned note.
Select an unsigned note.

Select Action > Consult Results > Add to Signature List (or select the “Add to
Signature List” option on the right-click menu.)

The selected note will appear on the Notifications window (along with other
documents and orders).

7.9.2 Delete Note of Consult

The delete note applies to a note or addendum associated with a consult (that is not
complete).

Follow these steps to delete a note:

1.
2.

Select the Consults window.
Select the note (or addendum) of a consult that is not complete.

Select Action > Consult Results > Delete Note (or select the “Delete Note” option
on the right-click menu) to display the Confirm Deletion information message.
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Conlfirm Deletion

\f\’) Oct 08,04 Addendur ba ENT-AUDTIOLOGY COMSLLT, 01GENERAL, TEST DOCTOR

Delete this note?

Figure 7-44: Sample Confirm Deletion of Note

4.

Click Yes to delete the note. (Otherwise click No.)

If you selected to delete the note, it will be removed from the Related Documents
of the selected consult.

7.9.3 Edit Note of Consult

The edit note applies to a note or addendum associated with a consult (that is not
complete).

Follow these steps to edit a note:

1.
2.
3.

Select the Consults component.
Select the note (or addendum) of a consult that is not complete.

Select Action > Consult Results > Edit Note (or select the “Edit Note” option on
the right-click menu).

The text of the note appears in the right panel where you can change the note.
You can use the Templates button or the Reminder button to add text to the note.
See Section 30.1.3 or Section 30.1.4 for more information.

When the note is complete, you can sign now or save without signature.

To save it without a signature, select Action > Consult Results > Save Without
Signature (or select the “Save Without Signature” option on the right-click menu).

To sign it now, select Action > Consult Results > Sign Note Now (or select the
“Sign Note Now” option on the right-click menu). This will require you to add
your electronic signature to the next dialog.

7.9.4 Identify Additional Signers for Consult Note

Upon occasion, a signed note might need additional signers, such as for people in a
training capacity.

Follow these steps to identify additional signer for a signed note associated with a
consult:
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1. Select the Consults component.
2. Select the note of the consult for which you need additional signers.

3. Select Action > Consult Results > Identify Additional Signers (or select the
“ldentify Additional Signers” option on the right-click menu) to display the
Identify Additional Signers dialog.

Identify Additional Signers

Author [rvot editable] Expected Cosigner [not editable]

EUnkncv.m t J

Select o enter addiional signers Cuirent additional sigrers

f
Acton,Enc |
Ef

Adairne Flobeit C

Fugadar | hs
Adcobolsmoounselon, Steven Fol
Alcobobsmeounselon, 5 teven Rol
Alden. Contract

Alcder K athy

Alden,Mailan

Alden,May

Allard Brian Albert

Allard |hs

Allard Lowi S ;l

Figure 7-45: Sample Identify Additional Signers Dialog for Notes to Consults

4. Select the additional signers from the scroll list of the “Select or enter additional
signers” panel.

5. The additional signer names will appear in the “Current additional signers” panel.

If do not want a particular name in this panel, select it and the selected name will
be removed from the panel.

6. When this dialog is complete, click OK. (Otherwise, click Cancel.)

7. In the text of the progress note near the bottom, you will see:

* AWAITING SIGNATURE * <selected names>

7.9.5 Print Note

The print note action prints the information about the selected consult note. Follow
these steps to print the information within a note:
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1. Select the Consults component.

2. Select the note of the consult that you want to print.

3. Select Action > Consult Results > Print Note (or select the “Print Note” option on
the right-click menu) to display the Print dialog.

t_, Prink !E
Sep 23,04 ENT-AUDIOLOGY CONSULT [#118], Pk
O1GENERAL. TEST DOCTOR & Chart Copy

" ‘Wodk Copy

Device .

[

Windows Printer -
FTPTROTRTRRIG 1 1. = T . =i
3 «BaDd OIM 3FRINTER: —
3 «<BAD CHS IPRINTER> 80

33 <BAD OHCP 33 FRINTER:

35 <BAD DIM 35 SECRETARY PRINTER: &0

46 <NULL DEVICE>

74 <CR PCC DATA ENTRY PRINTER>

139 (CR LAB LABEL PRINTER> =
Right Marqh| Page Ler'gth|

[~ Sava a3 default prinier 0K | cancel |

Figure 7-46: Sample Print Dialog

4.
S.

Enable the appropriate radio button in the Print panel.

Normally the right margin and the page length values (measured in characters) are
already defined by the printer. Select a printer to which you want to output the
information.

Whatever you select adds a label to the dialog box, such as: Print Chart Copy on:
<selected device>.

Check the “Save as user’s default printer” checkbox if appropriate.
Click OK. The information about the note outputs to the selected printer.

You return to the Consults window.

7.10 Defaults for Editing/Saving Consult Notes

You can configure the defaults for editing and auto-saving consult notes. This action
will define the interval to auto-save your notes as well as identify any default
cosigners.

Follow these steps to set the defaults for editing and saving consult notes:
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1. Select Tools > Options > Notes to display the Options dialog.

Options [ 7] x|
Motifications | Ordet Checks | Teams [Fiotes | Repons |

Motes
Conhgure defaults for editing and zaving notes,

Notes...
Document Titles |
Confhgure document list preferences.

Document Titles...
| 1] 4 | Cancel

Figure 7-47: Options Dialog

2. Click the Notes button to display the Notes dialog.

€ Notes 7] x|
Intenval for sutcsave of notes (sec)
h20 :I [ Ask subject for progress notes
Detault casigner: I~ Verky note tile
]{ Mo j
| 0¥, I Cancel

Figure 7-48: Notes Dialog

3. Change the interval for auto-saving your notes, if necessary. The units of measure
are seconds. You can type the new interval, or click the up and down arrows to
change the settings in five second intervals.

4. If you want a default cosigner for your consult notes, select the person from the
drop-down list for the “Default cosigner” field. This name will appear in the
Expected Cosigners field on the Identify Additional Signers dialog when you
select “Identify Additional Signers” on the Consults window.
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5. Check the “Ask subject for progress note” checkbox if you want to enter a subject
line when you write a new note. This will group your notes by particular subjects.
The sort and search options in TIU can use the subject line to find them. This
means you could have a subject line for bronchitis and then later find how many
notes you wrote for people with bronchitis.

{BLOOD PRESSURE MACHIMNE EDUCATION Ot 18,2004¢217:57 DOCTOR.TEST  Change... I
et 10418404 01GEMERAL
Subject: l|

[ »

Figure 7-49: Sample New Note for Entering a Subject Line

6. You use the “Verify note title” if you have a default note title selected. You can
create a selection list of titles that you use most often and then make one of them
the default. That note title will come up automatically even if you needed to use a
different title. This is just a reminder to ask the provider if this is the correct title
to use.

7. When the Notes dialog is complete, click OK. (Otherwise, click Cancel.)

7.11 Document List Preferences for Consults

You can configure your document list preferences. This means that when you select
your note title, your preferences are listed at the top. In addition, you can select a
default title; that note title will come up automatically (if you check the “Verify note
title” checkbox on the Notes dialog).

Follow these steps to determine your list preferences.

1. Select Tools > Options > Notes and click the Document Titles button to display
the Document Titles dialog.
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€ Document Titles

Document List Preferences

Document class:
- Dt
[rocument btes: <re defaull speciied:
Yous list of titles:
ENT-AUDIOLOGY CONSULT =] Ald |
PHARMALY CONSULT NOTE

'WELL CHILD CONSULT MOTE _I | _I

[ ok ] cance | .
Figure 7-50: Document Titles Dialog
Select Consults from the drop-down list for the “Document class” field.
Highlight the title you want from the “Document titles” scroll list.
Click Add to add that selected title to the *“Your list of titles” field.

You can keep selecting titles and adding them to your list, as needed.

o g > DN

If there is a title you do not want in your list, highlight it and click the Remove
button.

~

You can arrange the order of the list of titles by using the up and down arrows.

8. You can have a title in your list be the default title by highlighting the title and
clicking the Set as Default button. In this case, the title will appear below the
“Default” label on the dialog. If this is the correct default, then click the “Save
Changes” button.

9. You can remove the default by selecting it and clicking the Remove Default
button.
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€ Document Titles

Document List Preferences

Document class:

Corsult =

[Consus E Deefaul:

Dracument lithes: ENT-AUDIOLOGY COMSULT
[E WT-AUDIOLOGY COMSULT Your Est of Kthes:

EMT-ALDIOLOGY CONSLILT

ENT-ALDIOLOGY COMSLILT

-

PHARMALY COMSULT NOTE

WELL CHILD CONSULT NOTE _|__Remove ]
ﬂﬂmﬂefﬂl

|

Figure 7-51: Document Titles Dialog to Remove Default
10. When the Document Titles dialog is complete, click OK. (Otherwise, click
Cancel.)

7.12  Printing a Consult

You can print a selected Consult by selecting the Print option on the File menu.

If necessary, you can set up the printer by selecting the Printer Setup option on the
File menu. See Section A.4 for more information.

You can specify to print a Chart Copy or a Work Copy of the consult. Follow these
steps:

1. Select File > Print to display the Print SF 513 dialog.
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£ Print 5F 513 _ O] =]
Sep 2304 [2] *ENT-AUDIOLOGY ConsConsult : Frint
30 {= Chart Copy
" ‘Work Copy
~Device
|
Windows Prnter -
SRR T T . F'II.I"U:ETQ----------------------
3 <Bal QIM FFRIMTER:
9 <BAD CHS 9PRINTER> £0

33 <BAD OHCP 33 PRINTER:

35 <BAD OIM 35 SECRETARY PRIMTER> &0

46 <MLL DEVICE >

74 «CR PCC DATA ENTRY PRINTER>

133 «<CH L&B LABEL PRIMTER: LI

Right M.angan | Page Length

[ ok | coxe |

[T Save as user's delault printes |

Figure 7-52: Sample Print SF 513 Dialog

2. Enable the appropriate radio button in the Print panel.

If you select Chart Copy, the output will be labeled: MEDICAL RECORD.

If you select Work Copy, the output will be labeled: ** WORK COPY - NOT
FOR MEDICAL RECORD **

Whatever you select adds a label to the dialog box, such as: Print Chart Copy on:
<selected device>.

3. Normally the right margin and the page length values (measured in characters) are
already defined by the printer. Select a printer to which you want to output the
information.

4. Check the “Save as user’s default printer” checkbox if appropriate.

5. Click OK to have the information output to the selected printer. (Otherwise, click
Cancel.)

7.13 Consult Templates

You can make a consult template by selecting the appropriate option on the Options
menu. See Section Appendix B: for more information.

7.14 Icon Legend for Consults Window

Select View > Icon Legend on the Consults window to view the icon legend pop-up.
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Motes Cm.ls:[
Consulls treeview
E’: Top level roupng
=i} Selected subgrouping
Consull iequest

Y Procedue iequest
Initesfaciity consult request
T Intesdachly procedure request

—— ——
B Toplevel - allielated documents
Diocument
[l Addendum
EE] Drocument vath addenda
W Document with sitached image(s)
=  Chid document has attached magels]
B Document's image: cannot be viewed

Figure 7-53: Icon Legend for Consults Window

This pop-up provides information about the various icons on the Consults window.
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8.0

8.1

8.2

Crisis Alerts

Alerts

Crigiz flert | D ate

CLINICAL *ARNING

Figure 8-1: Sample Crisis Alerts Panel

13-Jun-2006 10:53

The Crisis Alerts component shows a list of notes from the document classes CRISIS,
CLINICAL WARNINGS, and ADVANCED DIRECTIVE. These are notes that are
deemed important enough that everyone should be aware of them. You can sort any

column by clicking on its heading.

Refresh

You can select Refresh from the right-click menu to re-display the patient’s
information in this component so that recent changes will be reflected.

Crisis Detall

When configured as a pop-up, the Crisis Detail displays when a table entry is

selected:

& Crisis Detail

| TITLE: PATN CONTRACT

DATE OF NOTE: MAY 23, Z006QL0:Z3
AUTHOR: HAGER, MARY
URGENCY:

ENTEY DATE: MAY 23, Z006[10:23:24

EXP COSIGHNER:

3TATUOS: COMPLETED

Patient has signed a pain contract with physician.

Patient will be seen in pain clinic.

Please do not order or renew any pain

medications without contacting the pain clinic.

fes/ MARY G HAGER

Signed: 05/23/2006 10:24
il
Font -
: I 9 5
Size:

=10l x|

F

Figure 8-2: Sample Crisis Detail Pop-up
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You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your
application is configured.

The detail pop-up has a right-click menu where you can copy selected text and paste
it into any free-text field within the EHR or into another application (like MS Word).
Click Close to dismiss the pop-up. See Section A.2 for more information.
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9.0

9.1

Electronic Signature

Most orders or documents, such as progress notes, reports, or health summaries,
require an electronic signature. Generally, orders that require a signature are not
released to services or activated until they are signed.

Note: There are two exceptions to this rule:

e Orders that can be designated as “signed on chart.”
e Generic orders that do not require a signature.

To electronically sign an order or a document, you must have an electronic signature
code. If you do not have a signature code, you must create one yourself. You must
keep your signature code a secret and use it properly to help keep an accurate medical
record.

The EHR provides three methods for signing orders and documents. You can sign
orders and documents together from the Review/Sign Changes dialog or you can sign
orders and documents separately using the Sign Selected Orders and Sign Documents
Now commands.

Review/Sign Changes Dialog

The Review/Sign Changes dialog allows you to simultaneously sign several orders
and documents.

You can sign orders and documents by performing any of the following:

e Select File > Review / Sign Changes to sign orders or documents and stay in the
current patient record.

e Select a new patient.
e Logout.

e Click the Awaiting Review icon (E) on the Patient/Visit Tool Bar.
After performing one of the above actions, the Review/Sign Changes dialog displays.
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Review,/Sign Changes for Demo,Raven Danielle

Signature will be applied to checked itemsz

Orders - Other Unsigned

Hald HYDROCHLOROTHIAZIDE TAR 25MG TAKE TwW0 TABLETS B
Dizcontinue ERYTHROMYCIM SUSP 200MG/SML TAKE 1 TEASPOO

Electronic Signature Code;

| Sign I Cancel

Figure 9-1: Sample Electronic Signature Dialog for Simultaneous Signing

Follow these steps to complete this dialog:

1. Each item that requires a signature will have a check in the checkbox in front of
it.

Uncheck any items that you do not want to sign by clicking the checkbox to the
left of the item. Optionally, you can click on a group heading to alternately check
and uncheck all of its member items.

2. Enter your electronic signature code and click Sign. The checked items will now
be signed.

9.2 Sign Selected Orders

The Sign Selected Orders command allows you to select a number of orders and sign
them all simultaneously. However, you cannot sign documents with this command.

Follow these steps to sign a number of orders:

1. Select the Orders window.

2. Highlight the orders you want to sign.

Note: To select a range of items, click the order at the beginning
of the range; then hold down the SHIFT key and click the
order at the end of the range. To select multiple, individual
orders, select the first order, hold down the CTRL key, and
click the next order.

3. Select Action > Sign Selected (or select the Sign option on the right-click menu).
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4. The Review/Sign Changes dialog displays.

Review /Sign Changes for Demo,Raven Danielle

Signature will be applied ta checked items
Orders - Other Unsigned
Dizcontinue ERYTHROMYCIM SUSP 200MG/SML TAKE 1 TEASPOO

Electranic Signature Code;

Sign I Cancel

Figure 9-2: Sample Electronic Signature Dialog for Signing Selected Orders

5. Enter your electronic signature code and click Sign. The checked items will now
be signed.

9.3 Sign Note Now

The Sign Note Now command allows you to select an unsigned note and sign it.
Follow these steps to use the Sign Note Now command:

1. Go to the Notes window and select an unsigned note.

2. Select Action > Sign Note Now to display the Sign Document dialog.

Sign Document l

Aug 31,06 D EDUCATION, DIABETES, DEMO USER

Signature Code

|| 0k I Cancel

Figure 9-3: Sign Document Dialog

3. Enter your electronic signature code and click OK. The signed note moves to the
Signed Notes list in the left panel.
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10.0 Evaluation and Management
The Evaluation and Management (E&M) component allows you to select the type and
level of service provided at the patient visit. This adds the selected information to the
Visit Services and Historical Services components.
Tupe of Service: Lewvel of Service:
| | & |Hist|:|r_l,l and Exam |Eu:um|:u|e:-:it_l,l |.-'1'-.|:-|:|n:|:-:. Tir
Conzultation [ Erief MurseVisit 5 min
Preventive Medicine ET | Prablem © 4 Shai 3 (10 m
EDHHTI’I’IEI'ICIF_',' Carzult roblerm FocUze ralrorsar ITI!I"I
Emergency Services L] Espanded Lows 15 min
Uther ER Services [] Detailed b oderate 25 min
Initial Hozpital Ean_a [] Comprehenzive  High 40 rnin
Subzequent Hospital C
Obzervation Inpatient |
Hozpital Discharge
Initial Inpatient Conzult
Fallow-up [npatient En:n;l 4 3
Figure 10-1: Sample Evaluation and Management Component
This component can be configured so that a particular user or class cannot add/edit
E&M information.
10.1  Type of Service
The E&M component can be configured so that Confirmatory, Emergency, and
Hospital are suppressed from the Type of Service field.
Tupe of Service:
Office Wigit
Consultation
Prevventive Medicine
Confirmatony Conzult
Emergency Services
Other ER Services
|nitial Hozpital Care
Subsequent Hospital Care
Obzervation [npatient Can
Hoszpital Discharge
Initial Inpatient Consult
Follow-up [npatient Conzu
Mewborn Care
Figure 10-2: Sample Type of Service Component
Each type of service has different levels of service associated with it, and these
choices display in the Level of Service field.
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For “Office Visit” and “Preventive Medicine” types of service, you must indicate
whether the patient is new or established.

10.2 Level of Service
You must have a visit selected to select a Level of Service.

Lewel of Service:

| Higtary and Exam | Complexity |.-’-'-.|:||:|rn:|:-:. 1

[] Brief Murse Visit | 5 min

[] Problem Focuzed | Straitforaard | 10 min
[ Expanded Lo 15 mik
[] Detaied Moderate 25 min

[ Comprehensive High A0 it

Figure 10-3: Sample Level of Service Field

The level of service for each type of service displays in the Level of Service field
with checkboxes next to each choice along with the corresponding CPT code or other
identifier. Making selections in this panel will add visit data to the Visit Services
component.

Any row in the grid contains the “View CPT Long Name” option on the right-click
menu. Selecting this option gives the provider guidance on what level of
documentation is needed in order to select a particular E&M code.

Select this option to display the CPT Long Name pop-up.

&, CPT Long Name x|

33217 Offce Or Oiiver Qutpatient Visit For The E valustion And Management O d
An Eslablzhed Patient, That May Not Requee The Presence OF A Plysician

Usually, The Presenting Problem|s] fee Minimal Typicall, 5 Minutes Ase Spent
Pedormmg Or Supervising These Serices.

Ok

Figure 10-4: Sample CPT Long Name Pop-up
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This pop-up contains a right-click menu for editing the text. For example, you can
copy-paste text using this menu. See Section A.2 for more information. Click OK to
dismiss the pop-up.

10.3 Adding Service Information to Visit Services/Historical
Services

Make sure a visit is selected. Follow these steps to add service information to the
Visit

Services and Historical Services components:

1. Click the type of service you want in the Type of Service panel. The
corresponding levels of service display in the Level of Service field.

2. For “Office Visit” and “Preventive Medicine” types of service, you must indicate
whether the patient is new or established.

Figure 10-5: New Patient and Established Radio Buttons

3. Click the checkbox next to the level of service you want. In most cases you will
only be able to select one item, but some types of service can have more than one
item selected.

4. After completing this process, the information is added to the Visit Services and
Historical Services components (the new record will be in blue lettering).

If you uncheck the selection in the Level of Service field, this removes the
information from the Visit Services and Historical Services components.

If you remove the “new record” from the Visit Services component, that action
also removes it from the Historical Services component.

User Manual Evaluation and Management
October 2007

73



Electronic Health Record (RPMS-EHR) Version 1.1

11.0 Exams
The Exams panel is where you can add, edit, or delete a patient exam.
P Exams: acd | Edt | pette|
Yizit Date | Exams | Fresult | Comments | Provider | Location |
01/29/2004 DIABETIC EYE EX&M MOORE.CATHERINE M CROW HO
01/29/2004  RECTAL ExXaM NORMAL/MNEGATIVE | test MODRE CATHERINE M CROW HO

Figure 11-1: Exams Panel

The Location of the exam (not historical) defaults to the provider’s location (in the
Exams grid).

This component can be configured so that a particular user or class cannot add/edit an
exam.

11.1 Adding an Exam

The Add function creates a current or historical exam or creates a refusal for an exam.
Make sure a visit is selected. Follow these steps to add a patient exam:

1. Click Add in the Exams component (or select the “Add Patient Exam” option on
the right-click menu) to display the Exam Selection dialog.

Code | Exams Bl i———
03  ABDOMEN EXAM | Select |
23 AUDIOMETRIC SCREEMING

24 AUDIOMETRIC THRESHOLD B
3 AUDITORY EVOKED POTENTIAL

06  BREAST EXAM

07 CHEST EXAM

30 DENTAL EXAM

22 DIABETIC EXAM

03  DIABETIC EYE EXAM

73 DIABETIC FODT CHECK

28 DIABETIC FOOT EXAM, COMPLETE

02 EAR EXAM —

33 EYE EXAM - GENERAL

18 EYE MUSCLE BALANCE EXAM

32 FOOT EXAM - GEMERAL

16 GENERAL DEVELOPMENT EXAM

01 GENERAL EXAM

17 HEARING EXAM

08  HEART EXAM

10 HERNIA EXAM hd

Figure 11-2: Exam Selection Dialog
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2. Highlight the exam you want to add. Use the scroll bar to view all available
exams. Note that you can sort either column by clicking its heading.

3. Click Select to display the Add Exam dialog. (Otherwise, click Cancel.)

x|
Exam [FALL RISK =] o
Resut [ ~ | Cancel
Cotamen ‘ =l
_".] (% Curent
Provider [TETER SHIRLEY = | | Historical
 Relusal

Figure 11-3: Add Exam Dialog

4. To redisplay the Exam Selection dialog, click the = button next to the Exam
field.

11.1.1 Current
1. Enable the Current radio button when the exam if for the current visit.

2. Select the result from the exam from the Result drop-down list. See Section 11.5
for the definitions of the various exam results.

3. Type a comment about the exam (if applicable) in the Comment text field. This
field has a right-click menu to aid in editing the text. You use this field to note
abnormal findings, for example.

4. If the provider of the exam is different from what is displayed in the Provider
field, click the = button to display the Lookup Utility, where you can select the
proper provider. See Section A.1.4 for more information.

11.1.2 Historical

Note: You can add an historical exam by having NO visit selected
and clicking the Add button. The Document an Exam will
display with the Historical radio button enabled.

1. Enable the Historical radio button when the exam is for an historical visit.
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x
Exam [FALL RISK _:J Add
Rest | =} Cancel

Comment E
_d ™ Cusrent
Provider [TETER SHIRLEY =] | Histonca
Histesical £ sl
Event Date | =
Locatior | =]
= Faciily € Other

Figure 11-4: Historic Event Panel

2.

Select the result from the exam from the Result drop-down list. See Section11.5
for the definitions of the various exam results.

Type a comment about the exam (if applicable) in the Comment text field. This
field has a right-click menu to aid in editing the text. You use this field to note
abnormal findings, for example.

If the provider of the exam is different from what is displayed in the Provider
field, click the = button next to display the Lookup Utility, where you can select
another provider. See Section A.1.3 for more information.

Complete the Historical group box.

Enter a date in the Event Date field by either manually typing it or by clicking the
=] button to select from a calendar. It must be a past date; otherwise, you get an
alert.

The Location field has a right-click menu to aid in editing the information.

If the location is an official IHS facility, enable the Facility radio button. You can
select the location from the Lookup Utility dialog by clicking the = button. If you
manually enter a facility name, it must be an official IHS facility; if not, when you
leave the field, the Lookup Utility dialog will display. See Section A.1.2 for more
information.

If your site has been configured with a default outside location, type OTHER in
the Location field. Then when you display the View Visit Detail pop-up, the
default outside location will display at the LOC. OF ENCOUNTER field.

If the location is not an official IHS facility, enable the Other radio button. Enter
the non-official location (for example, Dr. Ray Beck).
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11.1.3 Refusal
1. Enable the Refusal radio button when the patient refuses an exam.

ﬂ
Exam [INTIMATE PARTNER VIOLENCE -] e
Reason | = Cancel
Comment [UNABLE TO SCREEN =
REFUSED SERVICE =l | Cusrent
Frovidet [TETER SHIRLEY | | Historical
& Refusal

Figure 11-5: Sample Refusal to Exam

2. Select the reason for the refusal from the drop-down list for the Reason field.

3. Type a comment about the refusal (if applicable) in the Comment text field. This
field has a right-click menu to aid in editing the text.

4. If the provider of the exam is different from what is displayed in the Provider
field, click the = button next to display the Lookup Utility, where you can select
another provider. See Section A.1.3 for more information.

11.1.4 Completing the Document an Exam Dialog

1. After all fields have been completed, click Add to add the exam to the Exams
panel. (Otherwise, click Cancel.)

2. After clicking Add on the current or historical dialog, the record is added to the
Exams component.

3. After clicking Add on the refusal dialog, the record is added to the Exams
component as well as to the Personal Health component.

11.2 Editing an Exam

You can edit a selected exam by clicking the Edit button (or by selecting the “Edit
Patient Exam” option on the right-click menu). The Document an Exam dialog
displays, with the radio button selected (you cannot change) and the fields populated
with data entered during the Add process. You can edit any of the fields on the dialog.
See Section 11.1 for more information about the fields.

After all fields have been edited, click Save to have your changes saved. (Otherwise,
click Cancel.)

User Manual Exams
October 2007

77



Electronic Health Record (RPMS-EHR) Version 1.1

11.3 Deleting an Exam

You can delete a selected exam by clicking the Delete button (or by selecting the
“Delete Patient Exam” option on the right-click menu) to display the “Remove
Patient Exam?” information message.

Remove Patient Exam?

\‘l:'r) Are you sure you wank to delete the DIABETIC EVE EXAM Exam event?

Figure 11-6: Remove Patient Exam Information Message

Click Yes to have the selected exam deleted from the Exam component. (Otherwise,
click No.)

If you click Yes to a refused exam record, that action also removes it from the
Personal Health component. (Vice-versa is also true).

11.4 Display Visit Detall

The Exams panel has the “Display Visit Detail” option on the right-click menu for a
selected record. See Section A.3 for more information.

11.5 Exam Results Definitions

This section addresses the meaning of the exam results (when adding or editing an
exam).

11.5.1 Intimate Partner Violence

The Intimate Partner Violence (IPV) exam code is used to document results of
screening for current and lifetime exposure to IPV victimization.

The table below provides definitions for Intimate Partner Violence results.

Result Definition

Negative | The patient denies being a current or past victim of domestic violence.

Past The patient denies being a current victim, but discloses being a past victim of
domestic violence.

Present The patient admits being a victim of domestic violence.
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11.5.2 Depression Screening
The Depression Screening exam code used to document the results of a brief
screening for depression. A positive result does not mean that a diagnosis of
depression can be made; it is an indication that further evaluation is warranted.
The following table provides the rating that can be assigned to the following question:
“Over the last two weeks, how often have you been bothered by any of the following
problems?”
Problem Frequency Rating
Little interest or pleasure in doing things | Not at all 0
Several days 1
More than half the days | 2
Nearly every day 3
Feeling down, depressed, or hopeless Not at all 0
Several days 1
More than half the days | 2
Nearly every day 3
The following table provides the scores and what the results should be.
Result Definition
Negative Rating 0-2
Positive Rating 3-6
11.5.3 Diabetic Eye Exam
The Diabetic Eye exam code used to document the administration and results of a
diabetic eye exam.
The table below provides definitions for Diabetic Eye Exam results.
Result Definition
Normal The patient’s eye exam had normal results.
Abnormal | The patient’s eye exam had abnormal results. There is a need to address
abnormal findings in the Comment field (on the dialog).
11.5.4 Diabetic Foot Exam, Complete
The “Diabetic Foot Exam, Complete” exam code is used to document the
administration and results of a formal diabetic foot exam.
The table below provides definitions for “Diabetic Foot Exam, Complete” results.
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Result Definition

Normal The patient’s foot exam had normal results.

Abnormal | The patient’s foot exam had abnormal results. There is a need to address
abnormal findings in the Comment field (on the dialog).

11.5.5 Diabetic Foot Check

The Diabetic Foot Check exam code is used to document the administration and
results of a simple diabetic foot exam

The table below provides definitions for Diabetic Foot Check results.

Result Definition

Normal The patient’s simple foot exam had normal results.

Abnormal | The patient’s simple foot exam had abnormal results. There is a need to
address abnormal findings in the Comment field (on the dialog).

11.5.6 Dental Exam

The Dental Exam code is used to document a dental exam. The table below provides
definitions for Dental exam results.

Result Definition
Normal The patient’s dental exam had normal results.
Abnormal | The patient’s dental exam had abnormal results. There is a need to address
abnormal findings in the Comment field (on the dialog).
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12.0 Health Factors

12.1

Health Factors are data elements used by RPMS to record health status information
about the patient. Tobacco use is an example of a health factor.

=) Health Factors: Add | Edit |DE|EtE|

Yigit Date | Health Factor Category
02/03/2000 | Current Smoker | Tobacoo

0942542000  Previous Smoker  Tobacco

Comment

Figure 12-1: Health Factors Panel

Health Factors describe a component of the patient’s health and wellness not
documented elsewhere or as an ICD or CPT code. Health factors are not visit specific
and relate to the patients overall health status.

Health Factors influence a person’s health status and response to therapy. Some
important patient education assessments can be considered health factors such as
readiness to learn, barriers to learning, and learning preferences.

This component can be configured so that a particular user or class cannot add/edit a
health factor.

Adding a Health Factor

Make sure a visit is selected. Follow these steps to add a Health Factor:

1. Click Add (or select the “Add Health Factor” option on the right-click menu) to
display the Add Health Factor dialog.
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E add Health Factor ; x|

| ALCOHOL/DRUG Add
| BARRIERS TO LEARMING
DIABETES SELF MONITORING Cancel
| LEARNING PREFERENCE
| READINESS TO LEARN
RUBELLA IMMUMITY STATUS
| STAGED DIABETES MANAGEMENT
| TB STATUS
= TOBACCO [
CESSATION-SMOKELESS

FRAAEREERFAREM@M

CESSATION-SMOKER
CURRENT SMOKELESS

CURRENT SMOKER =|

Lo L T ot W ol W o Tl TR o O o TP ol Il ol

Comment:

Figure 12-2: Selecting a Health Factor

2. To expand a Health Factor category, click the plus sign button next to the Health
Factor Category. Highlight the Health Factor you want to add. See Section 12.5
for the definitions of the various health factors.

3. You can add a comment about the selected health factor in the Comment field for
clarification about the documented health factor. This has a right-click menu to
aid in editing the text. See Section A.2 for more information.

4. Click Add to have the selected Health Factor display in the Health Factors panel.

Notice that it displays in blue lettering; this indicates that this health factor is
associated with the current visit. (Otherwise, click Cancel.)

12.2  Deleting a Health Factor
Make sure a visit is selected. Follow these steps to delete a Health Factor:
1. Highlight the Health Factor you want to delete.

2. Click Delete (or select the “Delete Health Factor” option on the right-click menu)
to display the “Delete Health Factor?” information message.

Delete Health Factor?

\?‘) Are you sure you wish to REMOVE the Health Factor?

Figure 12-3: Delete Health Factor Information Message
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Click Yes to delete the selected health factor from the Health Factors panel.
(Otherwise, click No.)

12.3 Editing a Health Factor
Follow these steps to edit a Health Factor:
1. Highlight the Health Factor you want to edit.
2. Click Edit (or select the “Edit Health Factor” option on the right-click menu) to
display the Edit Health Factor dialog with the health factor highlighted.
|
Iberms: H
% RUBELLA IMMUNITY STATUS Save
% STAGED DIABETES MANAGEMENT
% TB STATUS ==
= TOBACCO
CESSATION-SMOKELESS
CESSATION-SMOKER
CURRENT SMOKELESS
CURRENT SMOKER
CURRENT SMOKER & SMOKELESS
EXPOSURE TO ENVIRONMENTAL TOBACCD SMOKE
NON-TOBACCO USER
PREVIOUS SMOKELESS ~
AT EOE siabE =
Comrent
Figure 12-4: Sample Edit Health Factor Dialog
3. You can change the health factor item by highlighting another one in the Items
list. See Section 12.5 for the definitions of the various health factors.
4. You can change the text of the Comment field. There is a right-click menu to aid
in the editing. See Section A.2 for more information.
5. Click Save to have the health factor information changed. (Otherwise, click
Cancel.)
12.4  Display Visit Detalil
The Health Factors panel has the “Display Visit Detail”” option on the right-click
menu for a selected Health Factor record. See Section A.3 for more information.
12.5 Health Factor Definitions
The following provides information about the definitions of various health factors
(when you are adding or editing them).
User Manual Health Factors

October 2007
83



Electronic Health Record (RPMS-EHR) Version 1.1

1251

12.5.2

Alcohol/Drug

CAGE is a screen tool for alcohol abuse. It can be modified for drug use by
substituting “drug use” for “drinking” and replacing the fourth question with “Do you
ever use drugs first thing in the morning to take the edge off?”

The patient is asked the following four questions:

Have you ever felt you ought to Cut down on your alcohol intake?
Have people Annoyed you by criticizing your drinking?

Have you ever felt bad or Guilty about your drinking?

A w o

Have you ever had a drink first thing in the morning (Eye-opener) to take the edge
off or get rid of a hangover?

The table below provides definitions for the Alcohol/Drug health factors:

Health Factor Definition

CAGE 0/4 Answers NO to all four questions

CAGE 1/4 Answers YES to one of the four questions

CAGE 2/4 Answers YES to two of the four questions

CAGE 3/4 Answers YES to three of the four questions

CAGE 4/4 Answers YES to all four questions

Barriers to Learning

Barriers to Learning health factors are patient specific. They usually are not visit
specific, but rather related to the patient’s overall health status. Barriers are assessed
by observation and interview, and then documented to alert other healthcare providers
that may provide education. It is important to accommodate and overcome barriers to
enhance patient learning. Barriers should be assessed annually or anytime the
situation warrants assessment.

The table below provides definitions for Barriers to Learning health factors.

Health Factor Definition

Blind The patient is blind and cannot compensate
with low-vision devices.

Cognitive Impairment The patient may have difficulty learning
because of impaired thought processes.

Deaf The patient is deaf and cannot compensate
with increased volume or hearing devices.

Does Not Read English The patient is unable to read English.

User Manual Health Factors
October 2007

84




Electronic Health Record (RPMS-EHR)

Version 1.1

Health Factor

Definition

Hard of Hearing

The patient has a problem hearing that can
be compensated with increased volume or
hearing devices.

Interpreter Needed

The patient does not readily understand
spoken English.

No Barriers

The patient has no apparent barriers to
learning.

Social Stressors

The patient’s ability to learn is limited due to
social stressors from current personal
difficulties or on-going mental or behavioral
health issues.

Values or Beliefs

The patient has values or beliefs that may
impact learning; this may also include
traditional Native American/Alaska Native
values or beliefs that may impact the medical
or clinical aspects of healthcare.

Visually Impaired

The patient has difficulty seeing even with
best corrected vision. The difficulty can be
compensated with the use of other
measures, devices, or both to improve vision
(large print, better lighting, magnifying
glasses).

Fine Motor Skills Deficit

The patient has fine motor skills impairment
that can interfere with tasks requiring manual
dexterity.

12.5.3 Diabetes Self-Monitoring

Diabetes Self-Monitoring health factors are used to document when patients perform
self-monitoring of blood glucose (blood sugar testing) at home.

The table below provides definitions for Diabetes Self-Monitoring health factors.

Health Factor Definition

No The patient did not perform self-monitoring of
blood glucose.

Refused The patient refused to perform self-
monitoring of blood glucose.

Yes The patient performed self-monitoring of
blood glucose.
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12.5.4

1255

Learning Preference

Learning Preference is listed in the medical record as a Health Factor. Although a
patient may have a predominant way of learning, it is important to use a variety of
teaching methods to optimize an education encounter. Learning preference can be
evaluated when the provider deems it necessary.

The table below provides definitions for Learning Preference health factors.

Health Factor Definition

Do or Practice The patient states that doing or practicing a
new skill is a preferred style of learning new
information.

Read The patient states that reading is the

preferred style of learning.

Small Group The patient, or the patient’s family, states that
participating in small groups is a preferred
style of learning new information.

Talk The patient, or the patient’s family states that
talking and asking questions is a preferred
style of learning.

Media The patient, or the patient’s family states that
media (kiosk, videos, interactive displays) is a
preferred style of learning.

Readiness to Learn

Readiness to Learn health factors can be assessed through both observation and
interview. With few exceptions (emotional, social, and cognitive), Barriers to
Learning tend to be more physical and slower to change.

The table below provides definitions for Readiness to Learn health factors.

Health Factor Definition

Pain The patient/family has a level of pain that
limits readiness to learn.

Receptive The patient/family is ready or willing to
receive education.

Severity of lllness The patient/family has a severity of illness
that limits readiness to learn.

Unreceptive The patient/family is NOT ready or willing to
receive education.
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12.5.6 Rubella Immunity Status

The Rubella Immunity Status health factors are used to document Rubella immunity
during and after pregnancy.

The table below provides definitions for Rubella Immunity Status health factors.

Health Factor Definition

Rubella Immune Immunity to rubella is documented.
Rubella Non-Immune The patient is not immune to rubella.
Rubella Status Indeterminate Immunity to rubella is uncertain.

12.5.7 TB Status

The TB Status health factors are used to document TB treatment status in affected
patients.

The table below provides definitions for TB Status health factors.

Health Factor Definition

TB - TX In Progress The patient is currently receiving TB
treatment.

TB - TX Complete The patient has completed a course of TB
treatment.

TB - TX Incomplete The patient has not completed a course of
TB treatment.

TB - TX Untreated The patient’s TB has not been treated.

TB - TX Unknown The patient’s TB status is uncertain.

12.5.8 Tobacco

The Tobacco health factors are used to document tobacco use and exposure to
tobacco smoke.

The table below provides definitions for Tobacco health factors.

Health Factor Definition

Ceremonial Use Only The patient uses tobacco for ceremonial or
religious purposes only.

Cessation Smokeless The patient is transitioning from a Current
Smokeless tobacco user to a Previous
Smokeless tobacco user. The time period
between stopping smokeless tobacco and 6
months.
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Health Factor

Definition

Cessation Smoker

The patient is transitioning from a Current
Smoker to a Previous Smoker. The time
period between stopping smoking and 6
months.

Current Smokeless

The patient is currently using smokeless
tobacco (chew, dip, snuff, etc.).

Current Smoker

The patient currently smokes tobacco
(cigarettes, cigars, pipe, etc.).

Current Smoker and Smokeless

The patient currently uses both smoke and
smokeless tobacco.

Exposure to Environmental Tobacco Smoker

The patient is exposed to second hand
smoke at work or outside of the home.

Non-tobacco User

The patient does not and has never used
tobacco products.

Previous Smokeless

The patient has quit smoking smokeless
tobacco for 6 months or more.

Previous Smoker

The patient has quit smoking tobacco for 6
months or more.

Smoke-free Home

The patient has no exposure to smoke at
home.

Smoker in Home

The patient is exposed to tobacco smoke at
home.
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13.0 Historical Diagnosis

The Historical Diagnosis component shows the historical visits for the current patient
and information regarding the diagnosis for the visit.

h Historical Diagnosis dtopL | setasT sPl:n-'l

Vst Date| POV Nanative [ICO |10 Name | Faciity E
PROPHYLACT

03/23/2007 IMMUNOTHERARY V072  Prophylact Immunctherapy  Demo Hospital

(5/22/2006] HYPERTENSION 401.9 |Hypertension Moz [vemo Hozpital
TvPE 2 DIABETES Disbetes lifunspec Mot

05/22/2008 w01 | 1TUS 25000 \\rcont Do Hospital
1216/2004 hopertersion 401.1 Benign Hypeienson Demo Hozpital
08/25/2000 L“E‘EI‘%E,;"‘BE TES 260,00 Bﬁr':f WhrspecNot |5 Hospiel
09/25/2000 HYPERTENSION 4019  Hypertenzion Nos Demo Hospital
0E/20/2000 Laborston Procedues W72k  Laboratory Examination Drermo Hospital
04/17/2000 | E 2 DIABETES 2000 [ebetesWunspecNot by Hospita ,

Figure 13-1: Sample Historical Diagnosis Component

13.1  Setting an Historical Diagnosis as Current POV

Make sure you have a visit selected. Follow these steps to add a selected historical
diagnosis as the current POV:

1. Highlight an existing historical diagnosis in the Historical Diagnosis component.

2. Click the Set as Today’s POV button (or select the “Set as Current POV” option
on the right-click menu).

3. The selected diagnosis will display in the Visit Diagnosis component.

13.2 Adding an Historical Diagnosis to the Problem List

Make sure you have a visit selected. Follow these steps to add a selected historical
diagnosis to the Problem List component:

1. Highlight an existing historical diagnosis in the Historical Diagnosis component.

2. Click the Add to PL button (or select the “Add to Problem List” option on the
right-click menu).

3. The selected diagnosis will display in the Problem List panel.
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13.3  Viewing Visit Detall

The Visit Diagnosis panel contains the “View Visit Detail” option on the right-click
menu. See Section A.3 for more information.
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14.0

14.1

14.2

Historical Services

The Historical Services component allows you to see a record of all the codes applied
to any of the patient’s visits. The information listed for each entry will at a minimum
contain the date of the visit, CPT code, Description, and the facility at which the visit
took place; additional information that might be listed is the quantity of the item used
(if applicable), and the primary diagnosis information, including up to two modifiers,
related to the CPT code used.

You can view the records by a variety of categories: surgical, medical, anesthesia,
radiology, laboratory, dental, miscellaneous, and all codes.

;‘2#_ Historical Services @ =] ﬂrﬂj!

Wil Dsle OPT Coste | Dencaphon Fardly Dty | Diaiegrerins P Mokl 1 oo 2
[EAN22007 | 20000 Drarage Abtceds 1 Hansnoma. Maksl inemal Anprosch  Demo Hoaptal 1 COUGH ¥

DFEAR W e Moasdal | 1 | DEHTHERA TETANUS PERTUSSE

Lpl e Ly SN ALK TROHE ADMIN Do oaptal 1 DM THERTA-SEFANUS PERTUSSH

Closzami | mn  0PRCEARITPATIENT VT, NEW [Dem Hoaplal | 1

Figure 14-1: Historical Services Component

Add to Current Visit Button

Follow these steps to add a service to the Visit Services component:

1. Highlight the historical service record and click Add to Current Visit (or select the
“Add to Current Visit” option on the right-click menu).

2. The selected historical service is added to the Visit Services component, with a
visit date as yesterday.

This action also adds another record to the Historical Services component, with a
Visit Date as yesterday. The “new record” will be in blue lettering.

If you delete that record from the Visit Services component, it also deletes it (the
new record) from the Historical Services component. (Vise-versa is also true.)

Add Historical Service Record

You might use this feature when you have a new patient (for example) and you want
to record a historical service.

Click the Add button (or select Add Historical Procedure on the right-click menu) to
display the Add Historical Service dialog.
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m, Add Historical Service
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Figure 14-2: Add Historical Service Dialog

You can enter an option from the Pick List or Procedure tab.

14.2.1 Using the Pick List Tab

1.
2.

Check an item on the Pick List tab.

Enter a date by clicking the =] button to select a date from a calendar (must be a
past date.)

Populate the Location field. This field has a right-click menu to aid in editing the
information. See Section A.2 for more information.

If the location is an official IHS facility, enable the Facility radio button. You can
select the location from the Lookup Utility dialog by clicking the = button. If
you manually enter a facility name, it must be an official IHS facility; if not, when
you leave the field, the Lookup Utility dialog will display. See “Using the Lookup
Utility Dialog for Location” on page 354 for more information.

If your site has been configured with a default outside location, type OTHER in
the Location field. Then when you display the View Visit Detail pop-up, the
default outside location will display at the LOC. OF ENCOUNTER field.

If the location is not an official IHS facility, enable the Other radio button. Enter
the non-official location (for example, Dr. Ray Beck).

Click Save to add a record to the Historical Services component. (Otherwise, click
Cancel.)
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When the record is added, the display changes to the record’s type of service so
that you can view the services in that category. For example, if you selected
Barium Enema, the record will display with other Radiology services.

14.2.2 Using the Procedure Tab
1. Make sure you are on the Procedure tab.

w, Add Historical Service
n

x|

o o s |
[NOTE: If the Procedure is not selected it defaults to 00053 - Uncaded CPT Code) _.l

Manative =

#

Date [ =]
Location | _|
& Facilty " Dther

Figure 14-3: Add Historical Service Dialog Procedure Tab

2. You can manually populate the Procedure field, if needed. Otherwise, click the =
button to display the Procedure Lookup dialog. See Section A.1.8 for more
information.

The selected procedure populates the Procedure field and Narrative fields on the
Procedure tab.

If you do not populate the Procedure, it becomes populated with 00099 (after you
save).

3. The Narrative field is required. If you only populate the Narrative field, make sure
that the description is adequate for the coder to populate the Procedure field.

The Narrative field is limited to 80 characters. If you enter more than 80, the
Narrative Too Long information message displays.
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%
i’/ Provider narrative is longer than the: alowable Fizld lsngth of 80 characters,
.‘_-'l

Do wank bo truncate the narrative to 80 characters?

Figure 14-4: Narrative Too Long Information Message

Click Yes to have the EHR truncate (cut off) the narrative text to 80 characters.
Click No to return to the Add Historical Service dialog where you can edit the
narrative text yourself. This field contains a right-click menu to aid in editing the
text. See Section A.2 for more information.

Enter a date by clicking the = button to select a date from a calendar (must be a
past date.)

Populate the Location field. This field has a right-click menu to aid in editing the
information. See Section A.2 for more information.

If the location is an official IHS facility, enable the Facility radio button. You can
select the location from the Lookup Utility dialog by clicking the = button. If
you manually enter a facility name, it must be an official IHS facility; if not, when
you leave the field, the Lookup Utility dialog will display. See Section A.1.2 for
more information.

If your site has been configured with a default outside location, type OTHER in
the Location field. Then when you display the View Visit Detail pop-up, the
default outside location will display at the LOC. OF ENCOUNTER field.

If the location is not an official IHS facility, enable the Other radio button. Enter
the non-official location (for example, Dr. Ray Beck).

Click Save to add a record to the Historical Services component. (Otherwise, click
Cancel.)

14.3 Delete Historical Services Record
Follow these steps to delete an existing historical services record:
1. Highlight the historical services record that you want to delete.
2. Click the Delete button (or select the “Delete Historical Procedure” option on the
right-click menu) to display the “Delete Entry?” information message.
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%
\?r) e yoU sure Yol want to delete the procedure enbry?
|

Figure 14-5: Delete Entry Information Message

3. Click Yes to have the highlighted historical service removed. (Otherwise, click
No.)

14.4  View Visit Detall

The Historical Services component has the “View Visit Detail” option on the right-
click menu. Use this option to display the Visit Detail for a selected record. See
Section A.3 for more information.
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15.0 ICD Pick-Lists

The ICD Pick-Lists component shows the ICD Pick-List items for the selected pick-
list category (below the ICD Pick-Lists button). How the pick-list items are arranged
in the Display field is determined by what checkbox fields are checked.

(K1 l"nl.-l.i'lll:] Ditrplagr ™ Fieq Rark ¥ Code T Descipbion Colel] 3 :?]

221 (0] - Chabetey Melitus Tppe | Or Linspscdesd I 0 Hpeioies Srd DI Larpune ks

03 00 - Backgrsura Disbehs Fatropatiy 57 - Mypapma M55 Tea Fim lnpahcensy
55 10 - Serde Cataract 6T 2 - AsSgma WL - M ekl drd B ebavoe sl Problama With Leamer
355 3 - Coteract 3T 4 - Pyguteopis W50 - O Dispenas

| |

Figure 15-1: Sample ICD Pick Lists Component

e The default view of the ICD Pick-List categories (Show All unchecked) means
that you will only see those pick-lists that either have no assigned clinic, hospital
location, provider, or provider discipline and those pick-lists that match any of the
parameters just mentioned with those of the currently selected visit.

e Show All, when checked, means to display all pick-lists including those not
related to the visit.

e You must have a visit selected in order to view the pick-list categories and their
items.

Providers can edit the ICD Pick-Lists as well as those with the BGOZ VPOV EDIT
key. A person with the BGOZ CAC key has full manipulation privileges of all ICD
pick-lists even though that person has not been assigned as a manager of them. Those
with the BGOZ VIEW ONLY key cannot edit the pick-lists.

15.1 Displaying the Pick-List Items
Follow these steps to view the pick-list items:

1. Select a pick-list category from the list below the ICD Pick-Lists button.

2. The field below the checkbox fields shows the pick-list items for the selected ICD
pick-list category.

3. When the Code field (only) is checked, the pick-list items will show their ICD
codes.
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™ Description Cals:|2 Ii”

F'har_m_au:_l,l _ [1.9399 - Peripheral Meuropathy 11107 - Orwchomycosis
Adrinistrative [1078.10 -Veruca B Foot \Warts [1110.4 - Dematophytosis OF Foot
%Lﬂdmw ] 078.19 - Plantar Wart [1] Fact [1111.1 - Chronic Tinea Pedis

[1094.0 - Charcot B Foot [1215.9 - Meuroma L Foot

Padiatmy '

Refractive

5 ample Picklist i
[T Showal
Figure 15-2: Sample ICD Pick-List Items Listed by Code
4. When none of the checkbox fields are checked, the pick-list items will be

alphabetical order.

ICD Pick-Lists: | | Display: [~ Freq. Rank [ iCode T Description |:D|SZ|2 Ii”

F'har_m_au:_l,l : [] 1=t Metatarzal Joint Fugion Right Foot [] Anemia

Administrative [] 5tk Drigit[toe]amputation [] Angiopathy

%Ed":'l':'g-'f' [] Abrasion L Ankle [] Angiopathy

BT [1 Achilles Tendonitis L [] Ankle Equinous

Refractive

Sample Pickist .41 i

™ Show Al

Figure 15-3: Sample ICD Pick-List tems When No Checkbox is Checked

5. When the Freq. Rank field (only) is checked, the pick-list item will be listed by
frequency of use.

F'har_m_au:_l,l : [1001: Mole Between 2 Toes B Foot [] 005: Hypoglycemia

Administrative [1002: Arthritiz [] 006: Anermia

%Ed":'l':'g-'f' [] 003 Meuroma L Foat [] 007: Angiopathy

AR 7004 Ulcer B Foot []008: 1=t bMetatarzal Joint Fugion Right Foot

Refractive

Sample Pickist .41 i
[T Showal

Figure 15-4: Sample ICD Pick-List Items Listed by Frequency

6. When the Description field (only) is checked, the description of each pick-list
items will display.
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ICD Pick-Lists: | | Display: [~ Freq. Rank [T Code W Description |:D|SZ|2 Ii”

F'har_m_au:_l,l _ [] Abrormality OF G ait [] Acute Osteompelitiz, Site Unzpecified

-":"-dl'l'!lf'IIStfathE [] Abragion Or Friction Burn OF Hip, Thigh, Leg[” ] Adhesions And Ankplogiz-tm) [bony Or Fibrod

%Lﬂdmlw [ Achilles Bursitis Or Tendinitis [ &nemia, Unspecified

AT [1 Acute Osteampeltiz lnvoling Ankle And Fod ] Ankylosis OF Joint OF Other Specified Sites

Refractive

Sample Picklist  JL4_| i
[T Show &l

Figure 15-5: Sample ICD Pick-List Items Listed by Description

7. If the description of the pick-list items overlap, use the “Cols” field to increase or
decrease the number of columns (range is 1 to 9).

15.2  Adding Pick-List Items to Visit Diagnosis Component
Make sure you have a visit selected. Follow these steps to have selected pick-list
items display in the Visit Diagnosis component:

1. Check the checkboxes in front of one or more pick-list items.
2. As you check each box, it is added to the Visit Diagnosis component.

ICD Pick-Liste: I_ﬂbﬂq.r. I Freq Rack 7 Codd [ Descrgten Coie2 2] @| Chief Complaint

Phamacy F333 - Penphesal Mewopathy 1110, - Orgchoampeos L

| DT 10 - Viesnaca R Foot Wats 110.4 - Demmstophydosss OF Foot
L7519 - Plants ‘Wit [1) Foot & 111.1 - Crennic Tinea Padis
034 0 - Chascot R Foot 12159 - Mewwoma L Fool
|
»Hi«alurimi Diagnosis ﬁddeL] Eﬁ:l’ﬂ'&" | Wisit Diagnosis: M Add I Edit I Ml
Visk Diane] POV Hasative [ICD [ICOMame | ||Provider Hanstive IC0 M0 Name Priocky | Caua

1262004 Corpretnitic T2 Corprekti N Crioric Tinea Peds 1M1 TINEA HIGRA Primasy

11/22/2004 Corurcticti T2 Corpretntis N Florkos Wt [i] Fool a1 E.ET’;:EE-W-""P-“-' Sacondsy
Figure 15-6: Sample of Checked ICD Pick-List Items to Visit Diagnosis Component
3. If you uncheck (the one you just checked) a checkbox, the “Remove POV?”

information message displays.

5

:.‘;:) Are you sure you wank bo delete the purpose of visit?

Yoz
Figure 15-7: Remove POV Information Message
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Click Yes to delete the record from the Visit Diagnosis component. (Otherwise, click

No.)
ICD Pick-Lists: || Displs ™ Freq Rark F¥ Codd [ Descrpton Cols|2 2] ’ @| Chief Camplaint:
= ' | Vitals:
] . 9559 - Periphesal Newopathy 11101 - Drechemycoss
10710 - Vesnaca R Fool Warts 11104 - Demmabophydosms OF Foot
& [ 111.1 - Cheoric Tinea Packs
10340 - Chascot A Foot [ 215.9- Hewoma L Foot
|
™ ShowAl
Historical Diagnosis adioPt | s & ppy | Visit Dingnosis: j,]l 4dd | Edt | Delete |
rm_[_m,e_ FOV Nasative Tico |I'I_2D_H:m_ Eh Frovider Maistie ICD [ICD Name Frioity | Coute |
12N B0 Cormartns T2 30 Cormmrtmitis M= || | Checric Tines Peds 1111 TINEA NIGRA Framary [

Figure 15-8: Sample of Unchecked ICD Pick-List Item from Visit Diagnosis Component

15.3 Managing the Quick-Pick Items

Follow these steps to manage your quick-pick items:

1. Click the ICD Pick-Lists button to display the Manage ICD Quick Picks dialog.

w. Manage [CD Quick Picks

ICD Pick Lists | Pediatrics =] Edit Pick Lists.

BROMCHITIS MOS
CARE OF HEALTHY CHLD NEC
COUGH

Dematophytons OF Hand DERMATOPHYTOSIS OF HAMD

DIPHTHERIA-TETANUS-PERTUSSIS L HERE L MEEEERIY

Active Query | Concel |

Figure 15-9: Sample Manage ICD Quick Picks Dialog

2. The drop-down list for the ICD Pick Lists field shows the pick-list categories. The
items in the ICD Pick List Items group box are the quick-pick items for the

selected category.

3. You can manage the quick-pick items on this dialog using the buttons on the
dialog. These actions are described below.
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15.3.1 Adding a New Quick-Pick Item

This process adds a new quick-pick item to the ICD Pick List Items group box on the
Manage ICD Quick Picks dialog. Follow these steps:

1. Click Add to display the Diagnosis Lookup dialog. See Section A.1.7 for more
information about using this dialog.

2. Select one of the items on the Diagnosis Lookup dialog and click OK to have the
selected item added to the ICD Pick List Items group box on the Manage ICD
Quick Picks dialog.

w, Manage ICD Quick Picks i .ZEI
ICD Pick Lists | Pediairics x| EditPick Lisis

ICD Pick Lit lters -

Fieq | Provider Manatree | ICD | ICD Mame |

2 BRONCHITIS 430 BRONCHITIS NOS Add

1 ChidCae V201 CARE OF HEALTHY CHLD NEC

1 Coush 7852 COUGH ool

1 Demstophstosss Of Hand 1102 DERMATOPHYTOSIS OFHAND | Delele

1 DIPHTHERIATETANUSPERTUSSIS ~ VOB1 oo e TETANUSPERTU e o

Pediatic Pre-bith Visit For Expactant

| Mother

_&s |
Active Query [ Cancel |

Figure 15-10: New Item Added to List

15.3.2 Renaming a Quick-Pick Item

This process renames a selected quick-pick item in the ICD Pick List Items group box
on the Manage ICD Quick Picks dialog.

Follow these steps to rename a quick-pick item:

1. Highlight the quick-pick item in the ICD Pick List Items group box on the
Manage ICD Quick Picks dialog that you want to rename.

2. Click Rename to display the Rename Item dialog.
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Quick Pick Name: [Blergic thintis oK

ICD Code: 477.9

LCancel
ICD Name: ALLERGIC RHINITIS NOS

ICD Descrption: Allergic Rhinttiz, Cause Unspecdied

Figure 15-11: Sample Rename Item Dialog

3. You can type the new name in the Quick Pick Name field. This is the only thing
that you can change on this dialog. Please note that this field has a right-click
menu to aid in editing the text. See Section A.2 for more information.

4. After this dialog is complete, click OK to have the “new’” name appear in the ICD
Pick List Items group box on the Manage ICD Quick Picks dialog. (Otherwise,
click Cancel.)

15.3.3 Deleting Quick-Pick Items
This process deletes one or more quick-pick items in the ICD Pick List Items group
box of the Manage ICD Quick Picks dialog. Follow these steps:
1. Highlight the items you want to delete on the ICD Pick List Items group box.
2. Click Delete to display the “Delete Entries?”” information message.
x|
-?/ Are you sure you want to delete the selected entries?
ves | N |
Figure 15-12: Delete Entries Information Message
3. Click Yes to have the selected items deleted from the ICD Pick List Items group
box of the Manage ICD Quick Picks dialog. (Otherwise, click No.)
15.3.4 Copying a Quick-Pick Item
This process will copy quick-picks from one category to another or import them from
PCC+. Follow these steps:
1. Click Copy to display the Copy ICD Preferences dialog.
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Figure 15-13: Copy ICD Preferences Dialog

o M W

Enable the EHR or the PCC+ radio button, whichever source you want to use.
Click the drop-down list for the Copy From field and select the “from” source.
If you need to change the Copy To field, click the drop-down list and select one.

Click OK to have the ICD pick list items added to the ICD Pick List Items group

box on the Manage ICD Quick Picks dialog. (Otherwise, click Cancel.)

15.3.5 Query Function

The query function allows you to execute a query that uses the ICD pick-lists from a
specified source to populate the current ICD pick-list category. This is useful when

you create a new category.

Follow these steps to query:

1. Click Query to display the POV Query dialog.

. POV Query

Taiget Category: |[FERGIT=g

Erom Date: [3/23/2004 | ToDate: [3/23/2005 _,|| T

Provider. ||

Figure 15-14: POV Query Dialog

2. You can change the Target Category field by clicking the drop-down list and

selecting another category, if needed.

3. The date fields have a calendar from which to select a date.
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4. The Clinic and Provider fields have Lookup Utilities dialogs from which to select
the appropriate clinic/provider. See Section A.1.3 and Section A.1.4 for more
information.

You must select either a Clinic or a Provider.

5. After completing the dialog, click OK to have the items appear in the ICD Pick
List Items group box on the Manage ICD Quick Picks dialog; this might take
some time, depending on the date range and the clinic. (Otherwise click Cancel.)

There will be a progress bar that appears in the Active Query field on the Manage
ICD Quick Picks dialog. You can click Cancel if you want to cancel the query; in
that cause you return to the Manage ICD Quick Picks dialog. When the query
process is complete, the Information message displays.

Information E x

lr) Thie pick list query has finished.
=,

Figure 15-15: Information Message About the Query

15.3.6 Importing Quick Picks

You can import quick-pick items from a file that resides on your hard drive. Follow
these steps to import a quick-pick list:

1. Click Import to display the Open dialog.
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Look i | 23 My Documents | &3 eE-

|| j Open I
|IHS IED PickLists [* zgi =] Cancel /l
e

Figure 15-16: Open Dialog
2. You select the location of the file in the Look in field.
3. You select the file and that populates the File name field.

4. Click Open to have the items added to the ICD Pick List Items group box on the
Manage ICD Quick Picks dialog. (Otherwise, click Cancel.)

15.3.7 Resetting the Frequency of Use

The EHR system keeps track of how many times each ICD code is attached to a visit.
When copying over a pick-list or set of ICD codes from another source, you will
inherit the tracking information recorded for the copied codes. To start tracking your
facility’s frequency information you can zero-out the count of the copied codes and
start over. This is useful when you import quick-picks.

Follow these steps to reset the frequency tracking information:

1. Select the pick-list from the ICD Pick List field for which you want to reset the
frequency.

2. Click the Zero Freg. button to display the Clear Frequency Values information
message.
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5

::) Mote: the frequency values are either populsted by & query or incremented when an Rem & added bo a visit,
-
Do you wank to reset tha frequency values to zero for all items in this pick fist?

Figure 15-17: Clear Frequency Values Information Message

3. Click Yes to have all frequency values set to zero. (Otherwise, click No.)

15.3.8 Exporting Quick-Pick Items

This process exports the selected quick-pick items to a file on your hard drive. Follow
these steps to export quick-pick items:

1. Highlight one or more items in the ICD Pick List Items group box of the Manage
ICD Quick Picks dialog that you want to export as a quick-pick.

2. Click Export to display the Save As dialog.

Save As EHE3

Save ic | {3 My Documents | & e

<3|

Hiztory

@

0] &Sk.ll:m

My Documents

=

s

My Compaiter

oy -
My Hetwork P...

File nanme: |J ﬂ Save I

Save asbpe:  |IHS ICD PickLists .21 ~| Cancel |
7

Figure 15-18: Save As Dialog

Select the location in the Save in field.

Specify the name in the File name field.

Click Save.

o o b~ w

The EHR displays the ICD Pick List Exported information message, confirming
that the export was completed. (Click OK to dismiss the message.)
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ICD Pick List Exported = x|

1 ,' ICD pick. list was saved bo the file named: C:\Documents and Settingsisteter|My Documents\Linzippediped pick lst.2gi

Figure 15-19: Sample ICD Pick List Exported Information Message

15.4 Managing Quick-Pick Categories
Click the ICD Pick-Lists button to get to the Manage ICD Quick Picks dialog.

. Manage ICD Quick Picks

ICD PickLists: [&llergy >|  EditPick Lists |

Figure 15-20: Location of the Edit Pick Lists Button
Click the Edit Pick Lists button to display the Manage Categories dialog.

w. Manage Categories

| Genesal |DOCTOR.TEST |DENTIST I

Figure 15-21: Sample Manage Categories Dialog

Note: If there are no categories in the ICD Pick-Lists field, the
Add Category dialog displays when you click the Edit Pick
Lists button.

15.4.1 Adding and Editing a Category

You can add a category to the ICD Pick Lists field; in addition you can edit an
existing category.

o All free-text fields have a right-click menu. See Section A.2 for more information.

e To add a category, click Add on the Manage Categories dialog to display the Add
Category dialog.

e To edit a category, select a category and click Edit. The Edit Category dialog
displays with the existing information on it.
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w, Add Category [ x]

Category Name: '3ehaw:n|al Health - Bj

oK |
Eancell

Hosp. Locatior: |

Cligic: |leohol And Substance

Frovider: [DOCTOR TEST

aj oy

Frow. Discigline [PS CHIATRIST

Managers: [DOCTOR,TEST

&dd

Delete

Figure 15-22: Add Category Dialog for New Category

Follow these steps to complete the Add Category dialog:

1.
2.

You type the name of the category in the Category Name field.
Each = button at the end of the Hosp. Location, Clinic, Provider, and Prov.

Discipline fields have Lookup Utility dialogs where you can search for entered
criteria. This is how you populate these fields. See Section A.1.5, Section A.1.4,
Section A.1.3, and Section A.1.6 for more information.

You need to choose how the pick-list will display from one of the methods listed
below. If you do not select a display method, the pick-list will be available to all
users in all locations.

Hospital Location The pick-list will be available to anyone who is in the selected hospital

location.

Clinic The pick-list will be available to anyone who is in the selected the

clinic.

Provider The pick-list will be available to the selected provider.

Provider Discipline | The pick-list will be available to anyone who is in the selected provider

discipline.

3.

4.

The current logon user becomes the manager of the category (when adding a new
category). This person’s name appears in the Managers field when editing the
category.

To add managers for the category, click the Add button by the Managers field to
display the Add Manager dialog.
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: oK
Provider | EI —,
LCancel |

Figure 15-23: Add Manager Dialog

Type in a few characters of the provider’s last name in the Provider field and then
click the = button to search for the provider. The lookup utility for the providers
displays. See Section A.1.3 for more information. The selected provider will
display in the Managers field. (Otherwise, click Cancel.)

5. If you need to delete a provider, select the provider’s name in the Managers field
and click Delete. The “Delete Manager?” information message displays.

Delete Manager? i et |

:!rj Are you sure you want to delete this manager?

Figure 15-24: Sample Delete Manager Information Message

Click Yes to remove the provider’s name. (Otherwise, click No). In certain cases,
you cannot delete the selected manager; in that case, the application displays an
alert about the condition.

6. When the Add Category dialog is complete, click OK. (Otherwise, click Cancel).

If this is a new category, it will display on the drop-down list for the ICD Pick
Lists field on the Manage Categories dialog. Also, the “new” category will
display in the list below the ICD Quick-Picks button.

You will need to add quick-pick items to the “new” category (the easiest way is to
use the Query button).

15.4.2 Deleting a Category
Follow these steps to delete an ICP Pick-List category:

1. Select a category on the Manage Categories dialog and click Delete to display the
“Delete Category” information message.
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|
J Are you sure you want to delete this category?

Figure 15-25: Delete Category Information Message

2. Click Yes to remove the selected category from the Manage Categories dialog.
(Otherwise, click No.)
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16.0 Immunizations

The Immunizations component allows you to view, edit, and add immunization
information for a patient into the Resource and Patient Management System (RPMS).
It requires that version 8.0, or later, of the RPMS Immunization package be installed.
This component allows the provider to see immediately which vaccines the patient
has received and which ones are needed.

% Immunization Record 3 [
L/
Forecast Contraindications 1
TaADULT past due Add | Delete |
s E:s:ij: |w4=:||:ELm Hx of Chicken Pox_25-Mas-2007
HEPAPED pastdus _ |
Vaccinations -
Vaccine Wisit Date | Aged@ifit | Locabon Reachon | Volane | Irg Shﬂ
DTaP [PEDLARE) 07/291938 Amths  Best Padiatics
DTaP [PEDLARE) 104041938 Smth: DEMD HOSPITAL ] Leflillll
i | 3

Figure 16-1: Sample Immunization Panel

e The Forecast field contains the vaccinations that the patient needs, as derived
from the ImmServe Forecasting System.

e The Contraindications field displays the patient’s contraindications, such as a
history of chicken pox or refusals for specific vaccines.

e The Vaccinations grid displays all vaccinations that have been entered into the
RPMS. The vaccinations can be sorted by clicking on a column heading. If no
Vaccination information is present in the RPMS for a patient, the grid will be
empty.

e This component can be configured so that particular user or class cannot add/ edit
the immunization record.

16.1 Web Reference Search

The Web Reference Search for the Immunization component depends on if any
records are present or not.

Condition 1: If there are records present, select one and click the V] putton (or select
the Web Reference option on the right-click menu) to go to the UpToDate Reference
Web site for the topic associated with the selected record. You can change to another
Web site by selecting from the Reference Site drop-down list (on the Web site).

Condition 2: If there are no records present, click the V] putton (or select the Web
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Reference option on the right-click menu) to display the Web Reference Search

dialog.
i
Reference Site: I UpToDate j
Search Tem: | Search

Figure 16-2: Web Reference Search Dialog

Select a Reference Site, if needed; the default is the UpToDate site. After entering a
term and clicking Search, you go to the selected Web site for the specified term. You
can change to another Web site by selecting from the Reference Site drop-down list
(on the Web site).

16.1.1 Functional Operations

Add (Vaccinations) Click the Add button in Vaccinations to
add an Immunization record (current,
historical, or refusal).

Edit (Vaccinations) Select an Immunization record and then
click the Edit button to display the Edit
Vaccination dialog. The application
automatically populates the Edit
Vaccination dialog with the data from the
selected Immunization record.

Delete (\VVaccinations) Select an Vaccination record and then
click the Delete button. The application
displays a confirmation dialog. Select
“Yes” to have the application remove the
selected record from the RPMS.

Add (Contraindications) Click the Add button for
Contraindications to enter a new
contraindication for the patient.

Delete (Contraindications) Click the Delete button for
Contraindications to delete a selected
patient contraindication.
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16.1.2

Add (Vaccinations)

Click the Add button in Vaccinations to
add an Immunization record (current,
historical, or refusal).

The right-click menu on the Vaccinations
panel:

Add Yaccination
Edit Yaccinakion
Delete Yaccination

Print OFficial Record
Prinkt Due Letter
Case Data

Display Visit Detail

WWeb References

The right-click menu on the
Contraindications panel:

Add Contraindication
Delete Contraindication

Business Rules

Rule

Meaning

Security Keys

In order to add, edit, or delete an
Immunization record you must be assigned
the PROVIDER key or the BIZ EDIT
PATIENTS key and cannot hold the BGOZ
VIEW ONLY Kkey.

CPT and ICD Codes Automatically Added and
Deleted

For each new vaccination record entered, the
CPT or ICD codes specified in the
Immunization file for that vaccine will be
respectively added to the VCPT and V POV
files if it does not already exist for the visit. In
addition, for non-nasal and non-oral
vaccinations the code 90471 will be added
for an initial immunization on a visit and
90472 for each subsequent one. Likewise,
90473 and 90474 will added for nasal and
oral vaccinations. If the vaccination is
subsequently deleted the codes discussed
above are removed.

Deleting Vaccinations

In order to delete a vaccination you must
either have entered it or be the primary
provider, in addition, the visit cannot have
been billed or exported.
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16.2 Vaccinations

The Vaccinations grid allows the provider to see immediately which vaccinations the
patient has received or refused.

Piint Record| Due Letier | Case Data | Yo I

Yaccine Visk Date | Agel@Visit | Location Reaction | Volume | Inj, Site | Lot

4Bz |DEMO HOSPITAL
HEFAADLT | 05/03/2006  48w: DEMO HOSPITAL 1 Left Dlhead M

Figure 16-3: Sample Vaccinations Panel

16.2.1 Adding a Vaccination Record

You add new vaccinations regardless of whether the patient is a child or adult, or is
included in the immunization registry or not.

e New vaccinations or refusals are those that are given for a visit. It is important to
note that the date and location of the vaccination correspond to the currently
selected encounter in the EHR.

e You can enter historical vaccination information where you specify the date and
location.

Make sure a visit is selected. Follow these steps:

1. Click Add (or select Add Vaccination on the right-click menu) to display the
Vaccine Selection dialog.

=, Vaccine Selection

 Search Critenia: -

| _)% Search Vake: | |§.wd-.| 0K I
i & Show Al Active Vaccines Cancel |

(" Show Only active Vaccines with a Lot Mumber
Select one of the following records:

Imiunization /| | Biand Name [a
BOTULINUM ANTITO=IMN Bobox

CHOLERA Genenc- niramuscula

CHVIG Cykolam

DT PEDIATRIC) Diphthesia and Tetanus Toxoidz

DTAP Tripedia

DT aP-Hep B-IPY Pedians:

HEBIG Hepatitiz B lrmmwre Globuin (H

HEP &, ADULT WAL TA aduk formulation

HEP A, PED/ADOL, 2 DOSE WAL TA pediatnicadolescent fios

HEPAHEPE T j

Figure 16-4: Selecting a Vaccine Dialog
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The selection list on the VVaccine Selection dialog is initially populated with all
active vaccines. This can be changed to “Show Only active Vaccines with a Lot
Number” by enabling that radio button.

You can filter the list by entering a search value. The search value can either be
the first few letters of an Immunization name, HL7-CVX code, or a Brand name.
A long description of the vaccine can be displayed by hovering the mouse over a
vaccine entry in the grid.

2. To select a vaccine, do one of the following: (a) double-click the vaccine entry in
the grid, (b) highlight the vaccine and click OK, or (c) highlight the vaccine and
press [Enter]. The Add Immunization dialog displays.

x

Vaccine [HEP 4, PED/ADOL, 2 DOSE _| o
Administered By |TETER SHIRLEY
Adrminiztered By I _I o
Let | =
Injection Site I j O Ll rehl
£~ Hiztarical
"olume I,E ﬂ P
EfLza
Wac. Info. Sheet [08/04/2004  w |

Figure 16-5: Sample Add Immunization Dialog

3. You can change the Vaccine field by clicking the = button to display the Vaccine
Selection dialog (where you can select another vaccine).

The following applies when the Current radio button is selected:

4. If acompound vaccine is selected, then a separate immunization record will be
added for each component. Such as in the above example, three separate
vaccination records are added for DTaP, Hep B and IPV.

Note: If you delete any one record (in the example), that deletes
all of them.

5. The Administered By field defaults to the current user. If needed, you can change
this by clicking the = button to display a lookup utility. See Section A.1.1 for
more information.

6. For common vaccines, the application automatically loads default values for the
Lot, Volume, and Vaccine Information Statement fields.
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7. The Vaccine Information Statement (VIS) date is required to give to a parent/
patient for each vaccine administered as evidence of Informed Consent. You can
change the date by clicking the = button and selecting from a calendar.

8. You can edit any of the fields, as needed.

9. If amanager of the Immunization package has specified that Lot Numbers are
required, then they will be there as long as there are active lots assigned to the
vaccine.

10. When the Add Vaccination dialog is complete, click OK to add the vaccination
record to the Vaccinations grid. (Otherwise, click Cancel.)

For each new vaccination record entered, the CPT or ICD codes specified in the
Immunization file for that vaccine will be respectively added to the V CPT and V
POV files if it does not already exist for the visit (unless it is configured not to
add the CPT code for the immunization). In addition, for non-nasal and non-oral
vaccinations the code 90471 will be added for an initial immunization on a visit
and 90472 for each subsequent one. Likewise, 90473 and 90474 will added for
nasal and oral vaccinations. If the vaccination is subsequently deleted the codes
dis- cussed above are removed.

16.2.2 Adding Historical Vaccinations

You enter historical immunization information on the Add Immunization dialog by
selecting the Historical radio button to display the Add Historical Immunization
dialog.

A second way to add historical vaccination record is NOT to have a visit selected and
click Add to select a vaccine and then display the Add Historical Immunization
dialog (with the Historical radio button selected).

ini. Add Historical Immunization x|
Waceine [HEP 4, PED/ADOL. 2 DOSE [-]] -
Documented By ITETEFLSHIFHLEY _I —
Ewent Datel _I
Location: I _I £ Currert
¥ Facility £ Other (+" Historical
" Refusal

Figure 16-6: Sample Add Historical Immunization Dialog

The Documented By field defaults to the current user (you can change this).
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The Event Date field must be a previous date that you can enter clicking the = button
and selecting from a calendar.

The Location field has a right-click menu to aid in editing the information.

If the location is an official IHS facility, enable the Facility radio button. You can
select the location from the Lookup Utility dialog by clicking the = button. If you
manually enter a facility name, it must be an official IHS facility; if not, when you
leave the field, the Lookup Utility dialog will display.

If your site has been configured with a default outside location, type OTHER in the
Location field. Then when you display the View Visit Detail pop-up, the default
outside location will display at the LOC. OF ENCOUNTER field.

If the location is not an official IHS facility, enable the Other radio button. Enter the
non-official location (for example, Dr. Ray Beck).

Click OK when the dialog is complete. This adds an historical vaccination record to
the Vaccinations grid.

16.2.3 Immunization Refusal
You enter the immunization refusal information on the Add Immunization dialog by
selecting the Refusal radio button to display the Add Immunization Refusal dialog.
x|
aceine [HEP A, PED/ADOL. 2 DOSE [-]] =
D ted By |TETER.SHIRLEY
Uocurmented By I _I —
Event Datel _I
" Currert
" Historical
f+ Refuzal
Figure 16-7: Sample Add Immunization Refusal Dialog
The Event Date must be a past date that you can enter clicking the = button and
selecting from a calendar.
Click OK when the dialog is complete. This adds an immunization refusal record to
the Vaccinations grid as well as adding a refusal record to the Personal Health panel.
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16.2.4 Editing a Vaccination

In order to edit an Immunization record you must be assigned the PROVIDER key or
the BIZ EDIT PATIENTS key and cannot hold the BGOZ VIEW ONLY key.

Make sure a visit is selected. Follow these steps to edit a vaccination:

1. Highlight an immunization record you want to edit.

2. Click Edit (or select Edit VVaccination on the right-click menu) to display the Edit
Vaccination dialog. The existing information about the selected record will
display.

[ & Edit Immunization x|

e b =
Administered By |USER.DEMO - |
Lat| =
Iniection Site. [Left &m 50 G| || 2
[
Vohume [5 = r
Vac Info Sheet [03/22/2007 |
Heachor: | j
Doze Ovemde: | :]

Figure 16-8: Edit Vaccination Dialog for Current Visit

3.
4.

See Section 16.2.1 for editing the fields in the top panel.

You use the Dose Over-ride field to force a dose valid (if given a day or so early
but won’t affect school) or invalid (due to expired vaccine, etc.)

This field affects the forecasting; it will ignore invalid doses and count forced
valid doses.

You can enter a reaction by selecting from the drop-down list for the Reaction
field.

When a entered reaction is ‘Anaphylaxis, Convulsions, Lethargy, or Fever >104’,
then a corresponding contraindication is automatically added.

Otherwise you are asked if it should be added as a contraindication for the patient.
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16.2.5

16.2.6

16.2.6.1

Save bo Contraindications?

Figure 16-9: Information Message when Saving Contraindication

Click Yes to save the reaction as a contraindication. (Otherwise, click No.) If you
answer yes, a contraindication of ‘Other Allergy’ is added.

6. When the Edit Vaccination dialog is complete, click OK to change the
information about the selected record. (Otherwise, click Cancel.)

Deleting a Vaccination
Follow these steps to delete a vaccination:
1. Highlight a vaccination record you want to delete.

2. Click Delete (or select Delete VVaccination on the right-click menu) to display the
“Remove Vaccination?” information message.

Remove Yaccination? |

:.’r) Are you sune you want bo delate the INFLUENZA vaccination?
ves  |[ me |

Figure 16-10: Sample Remove Vaccination Information Message

3. Click Yes to remove the vaccination from the Vaccinations panel. (Otherwise,
click No.)

If you delete the refusal immunization record on the Immunization component,
that action also removes it from the Personal Health panel. (Vise-versa is also
true.)

Buttons in the Vaccinations Panel

The following information provides information about the buttons on the
Vaccinations panel.

Print Record Button

Select a record and click the Print Record button to display and print the Print Record
pop-up. This pop-up shows the immunizations that the patient has received.
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~loix|
OFFICIAL TMMUNIZATION RECORD -
IHS Health Clinic
26187 Lands End Dr
South Ridng, VA 20152

29-Mar-2007
BOY DEHD Dace of Birch: 16-Apr-1333 (8 yrs)
3433 SHITH 5T Chact#: 45444

OELAHOMA CITY, 0K 32245

fur records show that BOY has received the following

inmuniZations:
Immunization Date Receiwved Location
DTaF [PEDIARIX]) 29-Jul-1998 Best Pediatrics
DTaF ([(PEDIARIX) D4-0ce-1998 Demo Hospital v
l] ¥
Forl g Pit. |  Ciose |

Size:
Figure 16-11: Example of Official Immunization Record

You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your
application is configured.

The pop-up has a right-click menu where you can copy selected text and paste it into
any free-text field within the EHR or into another application (like MS Word). See
Section A.2 for more information. Click Close to dismiss the pop-up.

16.2.6.2 Due Letter Button

Select a record and click the Due Letter button to display and print the due letter. This
letter is a reminder to make an appointment for the patient for the needed
immunizations. The Due Letter button must be configured in the Immunization
package in order to work.
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(O ia;
IHS Health Clinic I
26187 Lands End
Souch Riding, VA 20152

Z93=-Har=-Z007

Date of Birth: 16-Apr-1998 (& yra)
Chart#: 45444

Parent/GFuardian of

BOY DEMO

3433 SMITH ST

OELAHOMA CITY, OK 32245

Dear Parent or Guardian:

Your child, BOY, iz due for immunizations. According to our
records, the following immunizations have already been received:

Impunization Dace Received Location
DTaPF [(PEDIARIX) 29=Jul=1998 Be=st Pediatrics
DTaP [PEDIARIX) 04-0ce-1998 Dems Hospital
Kl o

Figure 16-12: Example of Due Letter

You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your
application is configured.

The pop-up has a right-click menu where you can copy selected text and paste it into
any free-text field within the EHR or into another application (like MS Word). See
Section A.2 for more information.

Click Close to dismiss the pop-up.

16.2.6.3 Case Data Button
You use the Case Data button to view/edit the Immunization Register data for the
patient. The user must have the BIZ EDIT PATIENTS key turned off in order to use
this button.
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Because the Immunization Register is a very actively managed register and reports
only those patients that have an ACTIVE status, the panel is used to case manage the
immunization register.

Click the Case Data button to display the Edit Case Data dialog.

%
Case Manager | [-] oK
oot [ Cancel
Other Info |

Begister (% Active ( Inactive

|
Eurecaallr!hfpmum| j
Mother's HB=AG Status | |

Figure 16-13: Edit Case Data Dialog

Active/lnactive (radio buttons): This indicates the status of the patient in the
immunization register. All children from birth to 36 months that live in the GPRA
communities are automatically ACTIVE. On review of children, some are changed to
INACTIVE is they fit the MOGE criteria (Moved or Going Elsewhere).

When you choose the change to INACTIVE status, you need to justify or explain
why. In the Moved To/Elsewhere field, you indicate where the patient went, such as
El Rio Clinic, for example. The Inactive Date is very important because the child will
be included in all reports up to that inactive date. Because children and their parents
don’t report that they have move away (they just stop coming to the clinic), this
function give those producing GPRA reports a way to have a more accurate
denominator to track and do the (GPRA) reports.

Inactive Date [05/05/2006  w |  Inactive eason [JHEEER

koved Elzewhers
toved Tod/TH Elzewhere I o

Deceased

Forecast Influ/Preumo I Previously Inactivated
Nex_fe_r Activated
Mnather's HR =45 Stahis I [neligible, nan-Ben

Figure 16-14: Sample Inactive Group Box

If you include the name in the Parent/Guardian field, that information will be
included in the reminder letters.
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The Other Info field is where the case manager can enter anything that might be
valuable.

You can populate the remaining field by selecting from the drop-down lists. Click OK
to update the immunization register with the entered data.

16.2.7 Display Visit Detail

The Vaccinations panel has the Display Visit Detail option on the right-click menu.
User this option to display the Visit Detail for a selected record. See Section A.3 for
more information.

16.3 Contraindications

If the patient has had a contraindication to an immunization, you can record it with
the corresponding reason being specified. In addition, you can add a refusal (parent or
patient) to the contraindication. Any contraindications entered for the patient will be
displayed in the Contraindications panel, and you will be alerted if the associated
vaccine is subsequently selected.

&dd | Delete
‘I"-.-".&HIEELL.-‘-‘-. Hx of Chicken Pox  26-k ar-2007

’7 Contraindications

Figure 16-15: Sample Contraindications Panel

16.3.1 Adding Contraindications
Follow these steps to add a contraindication for the current patient.

1. Click the Add button on the Contraindication Panel (or select Add
Contraindication on the right-click menu) to display the Enter Patient
Contraindication dialog.
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i, Enter Patient Contraindication

Vaccine: [-] Add

Contraindication Reaszon -
LCancel

Carrier

Coreeulzion

Egg Allergy

Fevers104

Hu Of Chicken Pox

Irnrnune

Immune Deficiency

Irmrune Deficient Houzehold
Lethargy/hwpaotonic E pizode
M eomycin Allergy

Other Allergy

Farent Refusal j

Figure 16-16: Adding a Contraindication Dialog

2. Click the = button at the end of the Vaccine field to display the Vaccine Selection
dialog. Here you select a vaccine. See Section16.2.1 for more information about
selecting a vaccine. The selected vaccine will display in the Vaccine field of the
Enter Patient Contraindication dialog.

If you add an Immunization for which the patient has a related contraindication,
the application displays an alert and asks if you want to continue.

%
9 The patient has the Following contrandcations
""'r‘) for HEIG of :
== IEnmLne
Do you wish to continue?
Yes

Figure 16-17: Contraindication Alert

If you click Yes, you can continue on the Enter Patient Contraindication dialog
(otherwise, click No).

3. Highlight the Contraindication Reason. You might have to use the scroll bars to
find the correct reason.

4. When the Enter Patient Contraindication dialog is complete, click Add to add the
contraindication record to the Contraindication panel. (Otherwise, click Cancel.)

The current date is recorded on the Contraindication record.
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16.3.2 Deleting Contraindications
Follow these steps:
1. Select a Contraindications record you want to delete.

2. Click Delete (or select Delete Contraindication on the right-click menu) to display
the “Remove Contraindication?” information message.

Remove Contraindication?

Figure 16-18: Remove Contraindication Information Message

Click Yes to remove the selected record. (Otherwise, click No.)
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17.0 Lab Orders

17.1

17.2

The Lab Orders component shows a list of the current patient’s labs results. You can
sort any column by clicking on its heading.

Lab hiders

POTASSIUM BLOCOD FL.. COMPLETE
LURIMALYSIS [DIPSTICE ... COMPLETE

Figure 17-1: Sample Lab Orders Panel

The two parameters that affect the number of days back that outpatient and inpatient
lab results will be retrieved are:

ORQQLR DATE RANGE OUTPT
ORQQLR DATE RANGE INPT

The package settings are 30 days for outpatient and 2 days for inpatient.

Refresh

You can select Refresh from the right-click menu to re-display the patient’s
information in this component so that recent changes will be reflected.

Lab Order Detall

When configured as a pop-up, the Lab Order Detail displays when a table entry is
selected:
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£ Lab Order Detail
GLUCOSE BLOOD

Test Name

Collection time:

SERTM 3P LE #l50562

Mar 05, Z005@05:01:04

Fesult

GLUCO3E g

]
Font I - l
Size: 3

Tnits

Figure 17-2: Sample Lab Orders Detail Pop-up

You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your

application is configured.

The detail pop-up has a right-click menu where you can copy selected text and paste
it into any free-text field within the EHR or into another application (like MS Word).

See Section A.2 for more information.

Click Close to dismiss the pop-up.
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18.0 Labs Window

The Labs window displays the lab test results for the current patient.

L
L Al Labss shory Footnite - Miget Hlatond

L lntra =T I

Al Tiesh By Date 3 ¥
Calactad Tasti By | « <
‘Wioehthes!

Woat Miecesd Lk fleruks

s terd
My 22, FOOG 1609

Giraph
Harobaokags
Eraivanc Patholog
ks B

Ll Shatuy

Speciman: BLOOD; Aocession: CH OEIT 24 Frovider: NAGIR, FART G
ALC Eval: """ WOTE NIW RIFERERCE BANCER AB OF Lilswm ==+

ALC Trali  EEFERENCE BANGER 50 WOT AFFLY FOB INDIVIDUALE WITH VARTANT
ALC Twal NENCCLODIME OTHER THAN F, §, AND C. ALTEGMEATYE RMITHODE FOR
ALC Twal ASSISSTHG CLYCERIC CONTEROL IN THESE INDIVISOALS HAY BX

ALC Eval AFFROFRIATE

EEY. "1™ = ibnoemal Low. “W™ = iibrnoeval Hgh. ™ = Cetical Vake

Figure 18-1: Sample Lab Test Results Window

18.1 Viewing Lab Results

Follow these steps to view lab results:

1. Select the Labs window.

2. Inthe Lab Results box, click the type of results you want to see.

Note: The plus sign (+) by a lab test means it has a schedule.

3. Some of the results will need you to determine ones you want to see. In this case,
the Select Lab Test dialog will display; select the tests that you want to view.

4. Also, you might need to choose a date range (such as, Today, One Week, Two
Weeks, One Month, Six Months, One Year, Two Years, or All Results). In

addition, you can define a date range.

5. To define a date range, select Date Range in the Date Range panel to display the

Date Range dialog.
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Erter & dabe range -

Begn Dale End Date

|| = | =]
0K | Cocel |

Figure 18-2: Date Range Dialog

Type the dates in the date fields (you can use the t-2 format, if needed) or click
the = button to select from a calendar.

6. If there is a dialog box, click OK to have the selected test results display on the
Labs window.

7. You can print the lab test results by selecting File > Print. See Section 18.8 for
more information.

8. Please note that in non-table form lab results, you can freeze and unfreeze text
like you can do when viewing reports.

18.1.1 Most Recent

The Most Recent lab result view shows you the lab tests in reverse chronological
order. You can then step through them one at a time using the forward and backward
buttons or go to the first or last lab result using the buttons with the double arrows.

i

Lab ety Latroraboey Hesulls - Most Aecent

Clmiatng Dl Prenvtuss Colectsd Hewt H I

AN Tesis B Date e { . » + I

& et T asts B Sep 29, 2003 11:52 * Mozt Recent Lab Resull

Wiorkheet

Gragh Tei B [Fiag Jucss [t Flange

Mz roshicdogy 4002 H gl To-110

Anstomic Pathaloge [IREA NITROGEN B gL 7.2

Emi‘: CREATININE na moid 7:12
SO0IUM 15 L renclL 140- 148
FOTASSILM 47 meeliL 36.-52
CHLORIDE 100 mamclL 100 - 108
coz .| menotL -3
CALCIUM a0 mgd'dl BE-105
Zpacinan: PLASMA) Aecasdsicon: CHEHR 0323 32 Previder: JEFFERSDH, TREIBAL
KE'Y: "L" = Abraumal Low, "H'™ = Abmomnal High, ™" = Crilical Value

Figure 18-3: Sample Most Recent Lab Results
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18.1.2 Cumulative
The Cumulative report is the most comprehensive lab report. It displays all of the
patient’s lab results for the selected time period. When selecting a large data range,
this report can take some time to display. The results are organized into sections. You
can automatically scroll to that section by selecting it from the Headings scroll list.
Ele
Lab Ragls Labouatery Flesulls - Cumudative - AN Results
Mozt Hecerd --=- CHEM I ---- -
-2-:1::;;&;" I:;I"‘E?‘r' PLASELR 03723 oerfLE DESDE 0d S 28 04516 Bafarancse =]
Wotkihoot lifer  dnde Gk Gnas dsa¥ e fasews
e ko [L0C0SE 402 B 278 24D H 193 425 mgial 70-10
Ellooed Blank UREA N 2 9 9 2 1z Bg/fdL =22
Lk Statis CREAT 0.9 n.s 0.9 0.9 1.0 mgfdl . 7-1.2
HA 135 L 134 L 133 L 140 129 L mmolfL 140-142
124 4.7 4.0 4.0 4.0 3.9 mmnlfL 3.6=5.2
Hw CL 100 5% L 53 L 104 33 L mmolfL lo0=102
al jcoz F3-] 8 5 27 25 mmolfL 21=32
Herial bty Ch 2.0 8.8 L .4 9.5 2.3 mgfdl  8.8-10.5
e Dipshek P04 mgfdl Z.4=4.9
L Micro Exa MG LB L mg/dL 1.8=2.4
Giowg 2 T.PROT 7.2 7.3 7.9 gm/dl  6.4-8.2
Cosguation | LxrBumin 2.2 L 2.3 1L 3.4 gfdl  3.4=5
LE PHO L1E 117 £ ] EQ=138
mF:L :51 ;+ z8 131 u::t 15-37
Tl:-dt.'m t:; £7 £2 i UiL A0=65
?ﬁﬁﬁ: LOH 1 UL 2E=70
Diree Morth TR UsL LA=232
Six Mionths CFIME 1.3 ngfal =5
res Yaas TROP. I 0,00 WG/HL  0=.09
Tuovear  [IrocLoR 3 ST e AR =
KEY: "L" = Abrosmal Low, "H" = Abnomal High, ™' = Critical Valse
Figure 18-4: Sample Cumulative Lab Results
18.1.3 All Tests by Date
The All Tests By Date report displays all lab results (except anatomic pathology and
blood bank) for a selected time period. The data is displayed in the order of the time
of collection.
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18.1.4

[
Lab Fesults Labsodaboop Results - 08 Tests B Date - Al Rendts
Must Recent E
Custudstrve Provider : JEFFERSON,TRIBAL —
Specimen: PLASHA, CHEH 053253 32

Selected Tesls BY 092903 1152
‘E-'ukshed Test nams Fesult wnits Bef. rangs
H':‘h CLUCOSE 402 H mgrdl 0 - 110
w:mh" EF‘EIH"-:‘-H UREA NITROGEN 8 gL 7 - 22
Blood Blank CREATININE 0.8 nyrdl T o= 1.2
Lk Slabus 200TOM 135 L mmsl/L 140 - 148

POTASSIUN 4.7 uuol/L 3.6 - 5.2

CHLORIDE Lon suol/L 100 - 108

coz 28 smol/L 2L - 32

CALCIUM 5.0 ny/dl 8.8 - 10.5

L e B G e e -
Prowider : JEFFERZON, TRIBAL
Specimen: URINE. UA 0925 &
09/25/02 11:82

Diske Range Test FaEe Result units Rt FRAgE
ritosindsick o S APPEARANCE CLEAR
Diate Range. URINE COLOR TELLOW
Em SPECIFEC GRAVITY L0106 1,001 = 1.03
Tx';’:,’gts UROBILINOGEN 0.2 mg/dL WORM - 1
(e Mot URINE BLOGD REGATIVE HEG = TRACE
Sie Mot URINE BILIRUBIN HEGATIVE HEG
e URINE KETONES HEGATIVE e
T Vi URINE GLUCOSE 34 e

PROTEIN HEGATIVE HEG = ]

URINE FH 6.0 UHITS 4 = ] )

Figure 18-5: Sample All Tests By Date Lab Results

Selected Tests by Date

The Selected Tests By Date report is useful when you only want to review only
specific tests. Microbiology results can also be selected. This selection displays the

Select Lab Test dialog.

€. Select Lab Tests HEE
Laboratosy Tests
w— [TI Tests bo be displayed
Prostatic Specihic Anbigen & Prmaclone
Probem _j Procanamads
Protern C Resistance, Actreat
Proben C, Antigenic
Protean Electio [Ur]
Probein Elechophonesis Remaye A0
Frotein Level, Urine
Protein 5 Evaluation Remave [Inel

Protesn, L [Conc]

Probesn, Total
Protevus 0x13
Protevus Ox2 Li

| 5 FOSTR p

Figure 18-6: Sample Select Lab Tests Dialog for Selected Tests by Date

ok |  Cancel |

The “Remove All” and “Remove One” buttons on the Select Lab Tests dialog apply
to the items in the “Test to be displayed” field.
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18.1.5

18.1.6

After selecting the tests, the report displays on the Labs window for the selected time
period. You can select more tests by clicking Other Tests (to display the Select Lab
Tests dialog).

i
Lab Rl Laboisbory Haply - Soslevciend Testt 8 [habe - T Ve
Vo Ao
Liarradafren Frovidar : BTROE, BONIRT &
Al T it B Dt Specimen: FhRAIGA CHER OULE 39
| Stocied Tt B | 0O/L0/03 L6236
._I"ﬁ" - Tart mams F=rult unite Pat TAng
;-:':"l;lvhw FROTEIN, TOTAL 7.3 g il " a2
o P B wel te- 8
Sicee] Bk ALEALENT FEOZFHATASE 134 e 138
Lab Sl LT 5T L a P
AT ] Wk ]
SILTECWIN, TOTAL 0§ wg il
ida DYEDE, BONIRT &
dperinen: FLAFRL cilER oubE Ei
O80E/D3 LL; D3
m Tait mams Bmrul® umits B rangs
FROTEIN, TORAL 7.3 L &4 - 0.2
LLNUMIN 1.3 L gl na i
Diate Rarge
,_.'__._._ ALFALINT PEIZEFHATAZR 117 UL i3 - 1w
Vaie Hange nr 53 Uik 1 K
1y ART i L T
fires Wissth ST — al
woents | il AN, o ML A A
Tres belarity
i U gl = ]
=attrhe Frovider ; FERMER, POLTNE X
Sperknan; ¥ BT CHER G458 30
0 Flead

KLY L™ = i L, "1 = Abrgomaad igh, = = Cafical Vi

Figure 18-7: Sample Selected Tests By Date Lab Results

Worksheet

The Worksheet is similar to the Selected Test by Date report. It does not display
microbiology results, but it has many features for viewing lab results. It is very useful
for displaying particular types of patterns of results.

Selecting Tests for Worksheet

Tests can be selected individually or by test groups. Any number of tests can be
displayed. When selecting a panel test, such as CBC, the panel will be expanded to
show the individual tests. Tests can be restricted to only display results for a specific
specimen type. For example, displaying glucose results only on CSF can be
accomplished by selecting the specimen CSF and then selecting the test Glucose.

To add a lab test, select it and then click Add to have it appear in the Tests to be
displayed field. You can remove a test in the Tests to be displayed field by selecting it
and clicking Remove.

The Remove All button removes all of the test in the Tests to be displayed field.
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£, select Lab Tests

Persong with defired T et Group: Drehires Test Groups

T Giotns IDu:u:tu:lr.T st = Hew I
110-HCG, HGE, HCT. Fe, H.Pulor pe

3] Imipra, lrdluen, RBsveull, Mona —I
Laboratony Tests

IHW Add I Tests to be desplayed

Lytes Plhaz - Cog

Lytess J Tocreate a New Chioride

M. Prieu &b Panel Teut G'm fire HCT

Maciocytoss selection o 7 tests,

Maceophages Sadhum

Magnesium Polassmm

Matemal Serum Alpha-Fetopr Remave 21

Matemal Serum Scieen 3 —I

MB/CPK _| RemoveOne

MBCE

MCH -

e

et bests for

Mebaral cepia

Mebaoin ;I

S pecimen

[orw = ok | Concel |

Figure 18-8: Selecting Lab Tests for Test Group

18.1.7 Establishing Test Groups

Test groups allow you to combine tests in any manner. For example, a test group
could combine CBC, BUN, Creatinine, and Platelet count. You can save those test
groups for later use. You can also select test groups that other users have created. You
cannot exchange or delete other’s test groups, only your own. Test groups are limited
to seven tests, but you can have an unlimited number of test groups.

To define your own test groups, select those tests you want and click New. If more
than seven tests are selected, the New button will be disabled. The selected tests
appear in the Test Groups field.

If you want to delete a test group, select it, and click Delete.

If you want to replace an existing test group with other tests, select the test group,
make any changes to the tests to be displayed, and click Replace.
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S
' Pessons with defined Test Groups Define Test Groups |
Doctorn Test =
Test Groups [DactorTe | N

1] J-HCG. HGE, HCT. Fe. H.Puls
3| Imipra, Influen, Havcul, Mono
4] Co2, CL. HCT, MCY, Na_ K

5 Pedgh, 1Mhist, 170hpro

I

Labosatory Tesls
I Add ! Tests lo be dizplayed
Pediatne THR Glucose - Irnipramrines

Pediatic ZHR Ghicose }ﬂ cieate a New Influenza Vil Culure
Pediatic 30Min Glcose et EW;“‘- ASY Culture
Pediatic Fasting Gheose selechion to 7 lests. [y

#CKMB

1HR GTT

1-Metrglhaztidns Remmove All

1/2HR.GTT

17 Hydiowyprogesterone Remove One

17 Ohp oot

17-Alpha Hydrosypeogestenor -

17-Hypdiospprogesterone 'ﬁ'"m%f

17-0h bl

17-0hp e

170h play.

170k Progestenone ﬂ

Specimen

[y 3] 0K Cancel |

Figure 18-9: Establishing a New Test Group

Note: These test groups are the same as those you might have
already created using the Lab package. The seven-test
restriction is a limitation of the Lab package.

Labs Window

18.1.8 Displaying Lab Tests for Worksheet

After you click OK on the Select Lab Tests dialog, the Worksheet lab tests display in

table format. Comments are footnoted with a ** and show in the panel below the

table.

The Worksheet display has the following features:

e You can select other tests by clicking the “Other Tests” button (to display the
Select Lab Tests dialog).

e You can display the test results vertically or horizontally by enabling the
appropriate radio button in the Table Format panel.

e You can filter the results to only show abnormal values by checking the
“Abnormal Results Only” checkbox. This will quickly show tests that have results
beyond their reference values.

e You can select the format of the display by enabling the appropriate radio but- ton
in the Other Formats panel.
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Fi=

Lab Results Laboratony Resuls - Workshest - Two Vo

Mol Figcsnt T ables Froomat ~Dthar Foimats

Cummaative & Honzonlal ™ Verical % Comment  Gi

M TestzBYDate | I : e
Seiscted Tatt:BY [~ Abnommal Feaubs Onlp E r r
DBraoh [Date/Tme  |Specemen |WEL RELC [HGE [HETAVEN [MDY [mcH [MCHE
Micictaclogy 01,0204 13 28 Blood asL 141 &5 1] HH T4H

natoeric Pathologr §11,13/03 13 27| Bloed

Bicod Bark 11411703 12 13| Blocd =

Lab Stahis
11060 0700 Blood canc [ canc cang canc cang cane
| D8/2200 O 55 55 459 145 45 % I5H B
08/ /03 16:57| Blood

|08/ /03 1% 24 Lirine
DEA A0 05 07| Ui

< ¥

[Diahe Hangs

Dste Farge
Today

O '/ ek,

Twvo Weeks

One Month

S Months How LI, Z0038L2:13 " Comments: L)
COree o DERO

GLUCOSE reported incorrectly as LLIO by [EL083). [

A Fesully

Figure 18-10: Sample Worksheet Lab Results

18.2 Graphing Lab Results

You can choose to view lab test results as a graph. Each occurrence of a test is a point
on the graph. EHR draws lines between the points to form a visual representation that
can help you see trends. The results are shown in blue. Dotted red lines show the high
and low reference values for the test.

You can use the following features by clicking the checkbox when viewing the graph:

Zoom lets you enlarge a part of the graph by clicking and dragging from above and to
the left of the area to below and to the right of it.

3D makes the graph into a simple three-dimensional representation.
Values places the numerical results next to each point on the graph.

The figure below shows an example of the graph feature being used. Comments are
footnoted with a ** and show in the panel below the graph.
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Mzt Recent

Cummudative [~ Zoom 3D T Yakes
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Blood B ank

Lt Siashus

[+ Gascose (Pazme) — Ret Low 70 — Ref Hgh 110 |

mghdl

E B8 88 8

Other Teats 1
DueRage 1nngar 11988 1nneas 1 2000 112001 1112002 112003

Version 1.1
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T May 02, 1996Q12:59% ** Commants:

Oine whesk :
T Wosks CALLED ER BN WITH GLUCOSE RESULTS:

Oine Month
Siox Mot
O it

Two Tears

Figure 18-11: Sample Graph Lab Results

18.3  Test Description
You can view a description of a selected lab test.
Select File > Test Information to display Lab Test Description pop-up.
1ol x|
[ "RAST, LATEX [retied) =]
= D4 _*J Defaikt wgency: ROUTIME
* (DR Highest uegency sllowed: ROUTINE
 Frs TomoRtoen _||Callection sample: BLOOD 10mL REDtap
i . Minimum vobame [in misp 10
% Free Testosterone [Retued) M oS e
%Ri A ! '
: Site/Specimean: SERLIM
Chamzyme 2
“Chemzyme (Retired] I 7%
“Ctomegalovinus Cult Shel
*Citomegalovinug Cul Shel [Retie
"HCV-Fna By PCR
"HCV-Fna By PCR
M arusal Dilf
*Pddandatoay Dilf
*Pddaruial Dilf [PCC Lab
“Rast, Latex [Retied)
=y = =
_ e |
Figure 18-12: Sample Lab Test Description
You can highlight the name of the lab test in the field. Otherwise, enter a few
characters in the field and the list will scroll to the first name containing those
characters; highlight the test name.
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The right-hand panel will display a description of the highlighted test. You can select
text in this panel and paste it into another free-form field or into another application
(like MS Word). See Section A.2 for more information. Click Close to dismiss the

pop-up

18.4  Microbiology

Microbiology shows you the results from microbiology for the selected time period.

LLab Regults Labaor Rl - Macrob = Al Regults
Mozt Recerd -=== MICDOBIOLOGY ---- -
Clrnidatres hecaggion: HI 02 4438 Received: Oce 27, 2002 00:16
v
AN Tects BY Diste [y ) geedion sanple: SWAB/THROAT Collection dace: Oez 27, 2002 00:16
i:hﬂEdTesr:B"r’ Zice/Ipecinen: DHARYNX
G':'*'M provider: LIPPERT,DAVID F
= Commant of speciman: ~ANTIBEIOTIC=NONE
Anatomec Patholog
Ellond Bank,
Ly 5 babiss Test(s) ordered: THROAT CULTURE complaced: Ose 23, ZO00Z
* BACTERIOLOCY FINAL PEPORT =» Oee 29, 2002 TECH CODE: 1830
Bacceriology PRasark(s):
N0 CROUP A BETA STREP ISOLATED
N AR EEEEE SN EEEEEEEEEEEEEEEEEEEEEE
---- MICROBIOLOGY ----
hecession: MI 01 1870 Received: Apr 13, 2001 Z1:20
Collection sample: SWAE/THROAT Colleccion dace: Apr 13, 2001 Z1:19
Sive/Spacimen: PHARYHX
Provider: FENNER,JOLENE E a
Date Range =
— [Commant on spaciman: ~H0 TREATHENT
Crabe Fangs
Today
Qe Week
Test(s) ordered: THROAT CULTURE compleced: Apr 16, 2001 10:21
T Weeks
Oires Morith
S Morths * BACTERIOLOGY FINAL PEPORT =» hpr 16, 2001 TECH CODE: 429
O Year Baccariology Remark(s):
T Yoars 0 BETA STREP RECOVERED
RN EEEE N EEEEEE N EEEEEEEEEEEEEE I EEEEEEEESEEEEEEESEEEEE
m=== HICROBIOLOGY ==== -

Figure 18-13: Sample Microbiology Lab Results

18.5 Anatomic Pathology

Anatomic Pathology shows you the results in this section for the specified time
period. The results are organized into sections. You can automatically scroll to that
section by selecting it from the Headings panel.
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Figure 18-14: Sample Anatomic Pathology Lab Results

18.6 Blood Bank

Blood Bank shows any blood that was requested. It also shows the results of any
screening and if the patient has any blood products in the blood bank.

Ee
LabResds  LaborstonResuds -Blood Bark

Mol Recent -==- BLOOD BAME ----
Canindateve

A0 Tests B Dsbe  |g100n AED FH  ABSCEN DAT
Sednched Teste B W e e

\Wodkshael & 07/02/2002 L0:20 o FOE

s
Graph ki i G
Mics . ABM BAND §YYE SEES: 2 UNITS CROSSED & READY

Marustionic .

Lab Statuz

Figure 18-15: Sample Blood Bank Lab Results

18.7 Lab Status

As the name implies, you can use this option to check on the status of labs that have
been ordered for the selected patient. The orders are grouped by date and show the
order number, the type of lab ordered, the provider, the urgency, and the status.
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IHR CTT
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BLOGD

CEC ONLY (M0 DIFF)
ROUTIRE

Lab Order # 163371

TRINE

TRINALYSIZS (DIPSTICK ONLY}
ROUTINE

Lab Order # 1639371

ELOOD  PLASMA
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Lab Order # 165300

ELOOD

CEC ONLY (N0 DIFF)

ROUTINE Tesc Complacs

T v vt

Figure 18-16: Sample Lab Status Lab Results

18.8

Lak Ordaz # 165300

Printing the Lab Results

Stacur

Test Complete

Test Complacse

Test Complete

Status

Accassion
Frovider: DOCTOR,TEST

POUTINE Raguascad [(SEND PATIENT) for: 0853172004

kecarrion
Frovider: JEFFERSON, TRIBAL

0329,/2002 12:20 HEM 092% 31
Provider: JEFFERSON,  TRIBAL

D9/2972003 L2222 UA 0929 &
Peevider: JEFFERSON,TRIBAL

R THSI003 LZ:16 CHEM 0929 32

Accasslon
Provider: EVRON, ROBERT &

DESLEFZO0Z L8:05 HEM 0BlE 36
Peevider: EYRON,ROBERT &

You can print the selected lab results by selecting the Print option on the File menu to

display the Printer Selection dialog. See Section A.4 for more information.

When the Printer Selection dialog is complete, click OK. (Otherwise click Cancel).
The contents of the selected lab test results will output to the specified printer.
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19.0 Medications Panel
The Medications component shows the prescriptions ordered for the current patient.
Medications
kd edication | Statuz | |zzue Date * |4
SIMVASTATIM ... EXPIRED 18-Mar-2004
GLIFIZIDE TAE  PENDING
TOBRAMYCING... PENDING |
AMORICILLIN P... PENDING
ACETAMINOPH... PENDING
SIMVASTATIN .. PENDING |
Statu |npatient/Outpatien
v Al  Achive | & &l O Ouw  n
Figure 19-1: Sample Medications Panel
You can sort any column by clicking on its heading. In addition, you can select the
status and type of medications (inpatient or outpatient) displayed on this panel.
19.1 Refresh
You can select Refresh from the right-click menu to re-display the patient’s
information in this component so that recent changes will be reflected.
19.2 Medication Detall
When configured as a pop-up, the Medication Detail displays when a table entry is
selected:
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_1ol
SIMVASTATIN Z0MG TAR®® =
Prescription #: 145

Prescriber: T3EER ,DEMO

Sig: TAFE ONE TABLET MOUTH QPFM

Davys Supply: an

Juantity: a0

Last Filled: s/8/06

Fefills Femaining: 11

Filled: 5/8/06 (Window)

Pharmacist: HAGER  MARY &

Atart Date: LALS06

Stop Date: Lies07

Status: ACTIVE -

Order #103 =
K1 _>I_I
Eﬂl I 9;5] Frint... | Cloze |

Figure 19-2: Sample Medication Detail Pop-up

You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your
application is configured.

The detail pop-up has a right-click menu where you can copy selected text and paste
it into any free-text field within the EHR or into another application (like MS Word).
See Section A.2 for more information.

Click Close to dismiss the pop-up.
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20.0 Medications Window

The Medications window lists the outpatient and inpatient medications that have been
ordered for the current patient.

Fila Weew Achon

b &= = ¥ +
Actrve Dy Cheorec Dy 180 days Prri F Hew
Ackon II:M:I:I Dufpstisnt Medcstons I Shabuy I Issued I Lt Filed i Enpaes | | Rl Provick
ATEWDLOL MG TAB™ Dty 45 or 30 dagn ; ;
¥ i TAKE ONEHALF TABLET MOLITH EVERF Dk THE Ackve | Z246e-2006 | Z-Mor 006 | 20Auy2006 157 | RAGERMARYO
GLYBURIDE GG TAR™ Ony 30 bot 30 deges
¥ LT e o e meoutrpL A ZMal00E 2206 DMypA0 3 155 MAGERMARY G
HYDROCHLORDTHAADE 561G TAR™ O 3 iar 30 daps
( Say TAKE DME HALF TRBELET MOUTH EVERY MORHING v S M- DG J0-May- 200G HMa-T0T 1 158 HAGER MARY
THE BLO00 FRESSURE
WE TRORMIN S00MG TAD™ Diy: 160 ot 90 daye
¥ S TAKE ONE TABLET MOUTH TWICE A DAY THC Aok 2006 DHGE DMe20T 3 15 HAGERMARY G
ASPARIN FIMG TAB™ Oty 30 for 30 deye ? . a
N T e e i Aoive | Z2MM005 DMK MmN 3 159 | HAGERMARY G
LUSEIVTANS S 01 e S b S chope Aotve DMy ZHyE D06 0 155  MAGERMARY G

Sig: TAKE DHE TABLET MOUTH EVERY Dy’ THC HIGH

Acion | ingabert Meck: shorit | o | SicoDae

Figure 20-1: Sample Medications Window

The following are features of the Medications window:
e You can use the icons at the top of the window to perform various functions.

e You can determine the columns that display by right-clicking on a column
heading and selecting the options.

e You can take action on existing medications by using the options on the Action
menu or by using the options on the right-click menu.

e You can view the medication order details or the administration history about the
selected medication by using the options on the View menu.

e The order of the columns (for outpatient) can be configured in the RPMS.

20.1 Icons on the Medications Window
The Medication window allows you to display and use the list of medications for the
current patient in several ways: (1) Restrict Medication Activity, (2) Active Only, (3)
Chronic Only, (4) Print Medication List, and (5) New. The following table gives the
features of these buttons.
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Button

Activity

180 days

Click the Restrict Medication Activity button to display the Restrict
Medication Activity Dialog.

Restrick Medication Activity

Show only medications active within the last

k. Cancel

Figure 20-2: Restrict Medication Activity Dialog

You can change the number in the free text field, if needed. After you
click OK, the Medications window will show only medications that
were active with the last specified days (for the current patient).

The default time can be configured in the RPMS.

Active Orly

Click the Active Only button to display the medications for the current
patient that have a status of ‘active’ in the Pharmacy package. These
are the medications that the patient is actively taking.
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Button Activity
3 | | Click the Print button (or select > Print) to display the Print
Pt ‘ Medication List Dialog.
x|
Ciaps to Betrieve: I 180
[+ Active Only [~ Chranic Only
List Detail
’7ﬁ' Brief i Detailed
Frirt. .. Cancel
Figure 20-3: Print Medication List Dialog
You can change the various settings, as needed.
After you click Print, the Print Setup dialog displays, where you select
the printer and other settings, click OKK on this dialog to output the
information to the selected printer. The output contains any adverse
reactions for the patient and the following:
e Brief outputs the information in the Medication, Prescriber,
Status, and Refills Left columns (not just the ones in the current
view)
o Detail outputs the information in all of the columns (not just the
ones in the current view)
+ Click the New button to display the Medication selection dialog. (This
Mew... is the same as selecting the New Medication option on the Action
menu). After making a selection, the Medication Order dialog
displays. See Section for more information.
v Click the Chronic Only button to change the display to show only
Cheoric Orly

chronic medications for the current patient (applies to Outpatient meds
only).

20.2  Column Heading Right-Click Menu
You can determine the columns that display for Outpatient Medications by right-
clicking on any column heading. This feature assists those with smaller monitors to
view only the needed information.
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v Issued

v Last Filled

v Expires

v Refills Remaining
W R ¥

v Provider

Shawa all

Hide All

Restore Defaults
Save Setkings

Figure 20-4: Column Heading Right-Click Menu

The top options on the right-click menu lists the columns heading names that you can
check or uncheck. Only the checked options will display (along with the minimum
Outpatient Medications data).

Show All: If you currently have a special display and want to display all of the
columns, highlight this option.

Hide All: If you want to display only the minimum Outpatient Medications data,
highlight this option. Only the Action, Chronic, Outpatient Medications, and Status
columns display.

Restore Defaults: This returns you to the default view of the Outpatient Medication
(established when Save Settings was selected).

Save Settings: This saves the current view of the Outpatient Medications as the
default. Each time you access the Medications window, this (saved) view will be the
default view.

20.3 Action Menu
The Action menu contains options allow you to take action on existing medications or
to order a new medication.
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20.3.1

Achon

Changs...

Copy bo New Order...

Discontinue | Cancel...
Process...

Transfer to Inpatient...
Refil...

Remew, ..

Chronic Medication b
Figure 20-5: Action Menu Options

New Medication lets you order a new medication. See Section 20.4 for more
information.

Change lets you change something pertaining to an already prescribed medication.
See Section 20.7.1 for more information.

Copy to New Order lets you copy the selected medication to a new order.
Discontinue/Cancel lets you discontinue or cancel a selected medication. Hold lets
you place the selected medication on hold.

Process lets you (the user) process the selected med orders.

Transfer to Inpatient lets you transfer a selected outpatient medication to inpatient.
Transfer to Outpatient lets you transfer a selected inpatient medication to outpatient.
Refill lets you refill the selected medication.

Renew lets you renew the selected medication.

Chronic Medication lets you mark selected medications as chronic or as not chronic.

Copy to New Order
You might use this feature to create a new medication order from an expired one.

Make sure a visit is selected for the current patient. Follow these steps to copy an
order to a new order.

1. Select the medication you want to copy to a new order.

2. Select Action > Copy to New Order (or select the Copy to New Order option on
the right-click menu) to display the Copy Medication Order dialog.
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& Copy Medication Order =10] %]

Diamo, Toddler is cutrently at CHART REVIE'W
Mo lreating specially iz avaldable.

" Release copied orders mmediately
(" Delay releaze of coped orders until Cancel I

Figure 20-6: Copy Medication Order Dialog

3. Enable the Release copied orders immediately radio button to create the same
order over again.

The Delay release of copied orders requires that there has been the setup for
delayed orders. You use the Delay option if the patient is being transferred and
you have all of the orders set to auto-dc on the transfer. This option will not be
discussed in this topic.

4. Click OK to display the New Order dialog.

Hedicarion: ACETAMINOPHEN TAE 3ZSHG ol
Instructions: S75MG ODRAL Q4H
Pacient Instructions: WF/H
Srart: O
Days Supply: 30
Juantity: 5S40
RBefill=: 5
Pick Up: WINDOW

Bwsawirae: BATTT TR

L

Edt |  Cancel

Figure 20-7: Sample New Order Dialog

If you click Edit, you get the Medication Order dialog for the particular
medication. See Section 20.5 or Section 20.6 for completing the dialog.

If you click Accept, a new order is created using the medication information
displayed on the New Order dialog. (Otherwise, click Cancel.)

5. The specified medication will have “New” in the Action column. You can sign
the order now or later.
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20.3.2 Discontinue/Cancel

When an order is discontinued, the application changes the order’s Stop Date/Time to
the date/time the action is taken. Pending and Non-verified orders are deleted when
the medication order is discontinued and will no longer appear on the patient’s
profile. An entry is placed in the order’s Activity Log recording who discontinued the
order and when the action was taken.

Make sure a visit is selected for the current patient. Follow these steps to discontinue
an order:

1. Select the medication order(s) you want to discontinue.

2. Select Action > Discontinue/Cancel (or select the Discontinue/Cancel option on
the right-click menu) to display the Discontinue/Cancel Orders dialog.

£ Discontinue / Cancel Orders

The following crders will be descontinued -

SIMVASTATIN TAB 20MG
TAKE OME TABLET BY MOUTH EVERY D&Y TAKE WITH SUPFER
Luantty: 30 Refills: 3

Reason for Discontinue [select one)
Duphcate Qoder

Requesting Pheisician Cancebsd

Dbzolete Onder
Eritesed in etrot I [1]4 I Cancel I

Figure 20-8: Sample Discontinue/Cancel Orders Dialog

3. Select the appropriate reason to discontinue from the Reason to Discontinue field
and click OK. (Otherwise, click Cancel.)

4. The specified medication will have “DC” in the Action column.

20.3.3 Hold

Only active orders can be placed on hold. Orders placed on hold will continue to
show under the ACTIVE heading on the profiles until it is removed from hold. An
entry is placed in the order’s Activity Log recording the person who placed/removed
the order from hold and when the action was taken.

Make sure a visit is selected for the current patient. Follow these steps to place a
medication on hold:
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1. Select the medication order you want to be placed on hold.

2. Select Action > Hold to display the Hold Order dialog.

(@oldorder =10 x|

The following order wall be placed on hold:

‘GLYBURIDE SMG TAB™
TAKE 5G MOUTH EVERY DAY TO HELP COMTROL BLOOD SUGARS
Quantity: 30 Reflls: 3

Enter a reason for the hold:

[

Figure 20-9: Sample Hold Order Dialog

3.
4.

Enter a reason in the free text field.
Click OK.

The word “Hold” will appear in the Order column for the selected order and the
Status = Unreleased.

You must the hold order now or later. After signing, the Status = Hold.

Once the medication is on Hold, you can remove it from hold by selecting the
medication and selecting Action > Release Hold to display the Release Order
from Hold dialog.

20.3.4 Process

The Process __Fee==-| hutton allows you to select more than one medication order to
process. The process allows you to change, refill, renew, etc. each medication in turn.
Otherwise, you can choose the medication order individually and select the
appropriate process (change, refill, etc.)

Select one or more medications and then select Action > Process or click the Process
button to display the Medication Order dialog.
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x|
[EMINDCAPROIC ACID TAB Aiction
i i Mone
| Dosage . Comple N
| |
| e _;
§| v [OReL | c
| - - i r
s
. =l
— <. - - DT
| 3
] ol o | & cinic £ 44t € Window, |[FauTie =]
= ot Detals..
EMINOCAPROIC ACID TAB SOUMG - :
TAKE OME TABLET MOUTH TWICE A DAY =l Skip |
Guanbty: B0 Rehlls: 0 Chiorec Med: MO
= ADR's it |

Figure 20-10: Medication Order Showing Process Actions

The active radio buttons on the dialog determine what action you can take on the
displayed medication.

The Action you select determines the label on the button on the button above the Quit
button in the lower right corner of the dialog.

Radio Button Button Label Action of the Button
None Skip Skips to the next medication
Change Change Changes the medication
Renew Renew Renews the med order
Refill Refill Orders a refill for the med
Hold Hold Puts the med order on hold
D/C D/C Cancels the med order

Click the ADRs button to display to show the Patient Postings information about the
current patient. See Section 20.4.1 for more information.

If you click the Details button, the system displays the Medication Details pop-up.
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& Medication Details =19] x|

BMTNOCAPROIC ACID TABR SOOMG
TAEE ONE TABLET HOUTH TWICE A DAY
Quantity: 60 Refills: 0 *UNSIGHED®

Activity:
0370972006 09:49 New Order entered by USER,DEMO
Order Text: AMINOCAFROIC ACID TAE SOOHG

TAFE ONE TAELET MOUTH TWICE A DAY
Ouancity: &0 Refills: 0

Hature of Order: ELECTRONICALLY ENTERED

Ordered by: USER,DEHMD

Figmarture: NOT SIGHNED

Current Data:
Treating Specialty:
Ordering Location: DIAEETES
Jrtart Date/Time:
Jtop Date/Time:
Current Status: UNRELEASED
Order=s that have not been released to the zervice for action.
Order #103

Order:

Medication: AMINOCAFROIC ACID TAB S500MG
Instructions: S00MG ORAL BID

Sig:

TAFE ONE TABLET HOUTH TWICE A DAY
Patient Instructions:

Days Supply: 30

Juantity: &0 st |
il »
Fonk :

Sige: |2 Pt | Cose |

Figure 20-11: Sample Medication Details

20.3.5 Renew
Only active orders or those that have been expired in a certain number of days can be
renewed. The “maximum number of days following the expiration” can be configured
for your site. You must have Outpatient Pharmacy 7.0 loaded in order to renew a
medication order.
After a renewed order is accepted, the Start Date/Time for the renewed order becomes
the Stop Date/Time of the original order.
Once an order has been renewed, it cannot be renewed again or edited.
Make sure a visit is selected for the current patient. Follow these steps to renew a
medication order:
1. Select the medication you want to renew.
2. Select Action > Renew (or select the Renew option on the right-click menu) to
display the Renew Order dialog.
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o

The following order will be renewed:

ASPIRIM TABEC 21MG
TAKE OME TABLET MOUTH EVERY DAY
Cuantit: 90 Refillz: 3 [pick up at wWindow]

Ehange.. I k. I Cancel

Figure 20-12: Sample Renew Order Dialog

3. If you need to change the Refill/Pick Up information, click inside the green box
and the button changes:

=10 ]
The lollowing order will be renewed:
SIMVASTATIN TAB 20MG

Ok Cancel |

Figure 20-13: Sample Renew Order Dialog with Changed Button Label

Click the Change Refill/Pick Up button to display the Change Refills dialog.

_ioix
[SIMVASTATIN TAE 20MG
TAKE ONE TABLET MOUTH GPM

Quanitity: 30 Rehllz: 17 [pick up at Window)

Fefills Pick Up
fi1 [at wirdowe -

[ oK ] _Concel |

Figure 20-14: Change Refills Dialog

You can manually change the number of refills and change the Pick Up
information by selecting from the drop-down list.

When the Change Refills dialog is complete, click OK. You return to the Renew
Order dialog. (Otherwise, click Cancel.)

4. Click OK on the Renew Order dialog. (Otherwise, click Cancel.)

5. The specified medication will have Status = Unreleased and Action = Renew.
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6. After signing the order, this changes the order to have Status = Pending.

20.3.6 Transfer to Inpatient

This action will transfer a selected outpatient medication to an inpatient medication
for a patient with the status of Outpatient. The EHR will tell you if the medication
cannot be changed to an inpatient medication. Follow these steps:

1. Select the outpatient medication you want to transfer (you can select more than
one, if needed).

2. Select Action > Transfer to Inpatient (or select Transfer to Inpatient option on the
right-click menu). The application checks the status of the patient.

3. The Transfer Medication Order displays.
@ 1ransier Medicationorder ol

[remo Fathes iz cusrently ot DIABETES
Mo reabing speciaky iz avadabla.

% Delay releasze of ranzfemed orders unti Cancel |
Admit To lcu
Admit Towad

Figure 20-15: Transfer Medication Order Dialog
Select one of the options in the lower field, such as Admit to Ward.

4. Click OK to display the Admit Patient dialog.
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& admit Patient (Delayed Admit To Ward) x|
Event [ADMIT TOWARD =l
Treating Specialy: | =
Attendig | =
Frimaty: | =
Instructions: |
ADMIT TO WARD =] |Accept Dider|

Figure 20-16: Admit Patient Dialog

Complete the fields on this dialog by selecting from the drop-down lists. The

Attending field is the only required field. The Instructions field is a free-text field.

5. Click Accept Order to display the Medication Order.

& Medication Order (Delayed Admit To Ward) ﬁl
jASFHRIN TABEC Change |
Dosage . Complex -
Dozage Floute Scheduls —
Eivo [oRAL DALY I PRN
EID -
162805 i
oG i MO AWE-FR
MOW
B50MG ( |‘|'|u'.w-| ll
Comments:
‘ =
ROUTIME -|
ADR's |
ASFIRIN TABEC =]
BIMG PO DAILY
=l _Cocel |

Figure 20-17: Sample Outpatient Medication Order
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20.3.7

20.3.8

6. Complete the medication order and click Accept Order. See Section 20.5 for more
information about completing the dialog.

7. The selected medication will appear in the Inpatient Medications panel with New
in the Action column.

8. After you sign the order, the Status becomes Pending.

Transfer to Outpatient

This action will transfer a selected inpatient medication to an outpatient medication
for a patient with the status of Inpatient. Follow these steps:

1. Select the medication from the Inpatient Medications panel that you want to
transfer to outpatient (you can select more than one, if needed).

2. Select Action > Transfer to Outpatient (or select the Transfer to Outpatient option
on the right-click menu). The application checks the status of the patient.

3. The Transfer Medication Orders dialog displays.

€ Transfer Medication Drder

Drema, Cynthia i currently at LAME DEER
Ho heating specially is availabls.

* Felease tansiened orders immediatel KO ) S
" Delay release of transfered onders untl Cancel I

Figure 20-18: Transfer Medication Orders Dialog

4. Click OK. The Medication Order displays.

5. Complete the Medication Order and click Accept Order. See Section 20.6 for
more information about completing the dialog.

6. The selected medication order will appear in the Outpatient Medications panel
with New in the Action column.

7. After you sign the order, the Status becomes Pending.

Refill

You can refill only outpatient medications that are active and have refills available
(and NOT a med that has been renewed). Make sure a visit is selected for the current
patient. Follow these steps:

1. Select the medication you want to refill.
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2. Select Action > Refill (or select the Refill option on the right-click menu) to
display the Refill Order dialog.

& Refill Order _ O] x|

Request refills for the following order:

HYDROCHLOROTHIAZIDE TAR 25MG
TaKE OME-HALF TABLET MOUTH EVERY MORMING THC BLOOD PRESSURE
CQuantity: 30 Refillz: 11

Pick Lp
(F Cliic ¢ Mail ¢ Window oK. I Cancel

Figure 20-19: Sample Refill Order Dialog

3. Enable the appropriate radio button in the Pick Up panel.
4. Click OK to have the medication refilled. (Otherwise click Cancel.)

5. The selected medication will have “Refill” in the Action column.

20.4 New Medication
Make sure a visit is selected.
Select Action > New Medication (or select the New Medication option on the right-
click menu or click the New button) to display the Medication Order dialog where
you select a medication. The medication order can be for inpatient medications or
outpatient medications; this is determined by the visit selected.
See Section 20.5 or Section 20.6 for more information.

20.4.1 ADRs Button
The ADRs button appears on many of the medication order dialogs. Click the ADRs
button to show the Patient Postings information about the current patient (allergies as
well as Crisis Notes, etc.). See Section 24.0 for more information.

20.4.2 Display Restrictions/Guidelines
Various medication order dialogs might have the Display Restrictions/Guidelines link
on them. Click this link to view the Restrictions/Guidelines pop-up.
Notice that you can print the text of the pop-up by click Print. Click Close to dismiss
the pop-up.
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€ Restrictions/Guidelines

The Crow Service Unit P4T commiccee has selected Lovastacin as

our first line drug. Patients need te be on a dose for 4-6 weeks to
datermine effect. After failure with Lovastatin the next drug to try is
Simvastatin, Atorvastatin is be used only after treatment failures or
documented side effects with Lovastatin and Simvastatin.

The following chart provides selected HMCG Coh reductase inhibitors and
the adult dosage range for primary therapeutic indications:

CEMERIC BRAND

DRIUG HAME NAHE (U3} DOSAGE RANGE* (mg)

sEsEEEsEEEEEEEE T ——————

Arorvastatin Lipiter 1o o 80 mg PO QD

Flusrastatin Lescal 20 ca 80 mg PO QD

Fluwastacin XL Lescal 80 mg PO QD

Lowastatin Hevacor 20 ca 30 myg PO QD

Pravastatin Pravachol 10 co 40 mwmg PO QD

Simvastatin Zocox 10 ce 40 wg PO QD

STATIN DOSE EQUIVENCY TAELE

Potancy Rating Expressed in NG's

Ceneric Name Erand Name 1 2 3 4

At orvastatin Lipitor 10 20 40
Fluvastatin Lescol Z0 40 a0

Lovastatin Hevacor 10 Z0 40 20
Pravastatin Pravachol pi] 20 40
|Simvastatin Zocor ] 10 Z0 40 8o

Figure 20-20: Sample Restrictions Guidelines Pop-up

20.5 Outpatient Medication Orders

These instructions include ordering a simple and complex dose outpatient medication
(NOT using a quick order). Follow these steps:
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E3|
I
[ [Mo auack orders avalable)
ABACAVIR TAB  NF il
ABILIFY  <ARIPIPRAZOLE TAB 5

ACCOLATE  <ZAFIRLUKAST TAB »

ACCUTANE  «<ISOTRETIMOIN CAPORAL > HF
ACETAMIMOPHEN DROPS SOLN.ORAL
ACETAMINOPHEN ELIXER ELI<IR
ACETAMIMOPHEN SUPPRTL

ACETAMIMOPHEN TAB

ACETAMIMOPHEN TAB CHEWABLE
ACETAMIMOPHEN/BUTALBITALACAFFEIME CAFORAL  MF
ACETAMINOPHEN/CODEINE ELEXIR
ACETAMINOPHEN/HYDROCODONE TAB

ACFTIC &CINASALIFYLIC &Cin Lo in TOP

| l]u'tl

Figure 20-21: Sample Medication Order for Selecting an Outpatient Drug

1. Find the appropriate item by scrolling the medication list. Otherwise, type enough
letters of the medication’s name in the top field to have the EHR search for the
name. Be careful to choose the correct item because some lists can have similarly
named items associated with the desired medication or medication quick order.

2. The EHR application searches the quick orders first and then the medication list.
Select the quick order or medication name and click OK.

Note: If the selected medication is a controlled substance that
requires the signature of a provider with a DEA number,
the DEA# Required warning message displays. Before an
order for a controlled substance can be entered, the
provider selected for the encounter must be able to sign the
order. You might need to exit the Medication Order dialog,
change the provider, and then reenter the Medication Order
dialog.

DEA# Required i x|

i i Provider must have a DEA® to order this medication

E==

Figure 20-22: DEA# Required Warning Message
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20.5.1 Simple Dose for Outpatient Medication Order
The following is for ordering a simple dose, outpatient medication:

1.

If needed, you can change the type of medication by clicking Change.

2. Highlight the dosage. (The associated cost is displayed to the right of the dosage.)

xq
[ALENDRONATE TAB Change
| Dosage . Complex
{Dozage Routs Schadula |
| |ORAL |IWEEK ™ FAN|
[ToMG T BID '
201G : Dhally EI
70MG ; MO-WE-FR |
I R =l
Comrmisnks:
=
4|
Day: Supply.  Duantity Refils Pick Up | Pricrity
o o =0 ]| & Ciie © Mal C Window |[ROUTINE »]
I~ Chaonic Med ' '

[v TAKE WITH FULL GLASS OF WATER-DO NOT LAY DO

ADR's 1

ALENDROMATE TAB =]

TAKE MOUTH QWEEK TAKE WITH FULL GLASS OF WATER-DO NOT LAY

DOWN FOR 30 MIN W

Quantty: 0 Refillz: 0 Chiones Med MO J - |
- um

Figure 20-23: Sample Outpatient Medication Order Dialog (Simple Dose)

3.
4.

Select a route from the Route field.

Choose a schedule from the Schedule scroll list. (Select PRN, if desired.).

The application completes the Days Supply field and calculates the quantity field
based on the formula: days supply x schedule = quantity. If necessary, highlight

and change the numbers in these fields.

Note: If you change a number, the application will attempt to
recalculate the other field. If you check PRN, be sure that
the Quantity field is correct before accepting the order.

Enter the number of refills.

Select the location where the patient should pick up the medication from the Pick

Up field.
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10.

11.

12.
13.

You can change the Priority by selecting from the drop-down list. The following
are the only two options you should select:

Done: when given in the clinic
Routine: the default

Add comments in the Comments field (if desired). This field has a right-click
menu to aid in editing the text. See Section A.2 for more information.

Under certain circumstances, a checkbox might appear under the Days Supply
field. If the medication is service-connected, make sure the box is checked.

Check the Chronic Med checkbox if you want the medication order to be flagged
as Chronic (after signing the order).

Click Accept Order.

If you are finished ordering outpatient medications, click Quit.

Note: The order must be signed before it can be forwarded to the
Pharmacy service. You can either sign the order now or
wait until later.

20.5.2 Complex Dose for Outpatient Medication Order
The following is for ordering a complex dose, outpatient medication:

1.

Click the Complex tab.

Note: Once you begin a complex medication order, you must
remain on the Complex tab until you finish the order. If you
switch tabs, all complex dosages will be erased, and you
will be forced to start the order again.
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& Medication Order = x|
[AEETYLEHDUNE CHLORIDE SOLN,OPH Change
Dosage | Complex
| ; :
Dosage | Rowe | Schedde | Duration [thenvand
I {1 DROP 1%
L12 DROPS 1%
= : |
| =l
o |
Daps Supply  Ouantily Refl:  PickUp  Phom
| j| j‘[n jiﬁmrmurwm_ﬁuunm'
[~ Chionic Med
ADR's
ACETYLCHOLINE CHLORIDE SOLN,OPH 3
Rehlle: 0 Chaoric Med: NO -
Accept Order
z  aw |

Figure 20-24: Sample Outpatient Medication Order (Complex Dose)

If needed, you can change the type of medication by clicking Change.
Click the Dosage field and select the appropriate dosage.

Click the Route field and enter a route.

Enter a schedule in the Schedule field. (Select PRN if desired.).

o g M WD

Enter a duration in the Duration field. If you want to change the time units of
measure (for example from Day to Week), select the units of measure first, then
enter the duration number.

As you complete one row of instructions, those instructions appear in the lower,
left panel of the Medication Order dialog.

7. Select the appropriate modifier: And, Then Except. Leave this cell blank for the
final dose.

8. Repeat steps 3-7 until you have completed the complex dose. This process will
add rows to the complex dosage instructions.

9. The application will display a default value in the Days Supply and Quantity
fields. The gquantity is calculated based on the formula: Days Supply x Schedule =
Quantity. If necessary, you can change the value in these fields.
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Note: If you change a number, EHR will attempt to recalculate
the other fields.

10.
11.

12.

13.

14.

15.

16.
17.

Enter the number of refills in the Refills field.

Select the location where the patient should pick up the medication from the Pick
Up field.

Add comments if necessary. This field has a right-click menu to aid in editing the
text. See Section A.2 for more information.

Under certain circumstances, a checkbox might appear under the Days Supply
field. If the medication is service-connected, make sure the box is checked.

You can change the Priority by selecting from the drop-down list. The following
are the only two options you should select:

Done: when given in the clinic
Routine: the default

Check the Chronic Med checkbox if you want the medication order to be flagged
as Chronic (after signing the order).

Click Accept Order.

If you are finished ordering outpatient medications, click Quit.

Note: The order must be signed before it is sent. You can either
sign the order now or wait until later.

20.6 Inpatient Medication Orders

These instructions include ordering a simple dose and ordering a complex dose for
inpatient medication (NOT using a quick order). Follow these steps:

1.

2.

Find the appropriate item by scrolling if necessary. Otherwise, type enough letters
of the medication’s name in the top field to have the EHR search for the name. Be
careful to choose the correct item as some lists can have similarly named items
associated with the desired medication or medication quick order.

The EHR application searches the quick orders first and then the medication list.
Click the quick order or medication name and click OK.
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x|
] [No quack. orders svalable]
ACETAZOLAMIDE INJ =
ACYCLOVIR K

ADRIAMYCIN - <DOXORUEBICIM IMJ S0LM »
ALDOMET ESTER  «METHYLDOPATE INJ »
ALPROSTADIL M)

ALTEPLASE  <ALTEPLASE IMJSOLM »  MF
ALTEPLASE IMJ.S0LN ~ MF

AMICAR  <AMIMNOCAPROIC ACID INJSOLM »
AMIKACIM INJSOLH  NF

AMIEIN  <AMIKACIM INJLSOLN = MF
AMIND ACIDS/DEXTROSE N
AMINOCAPROIC ACID INJSOLN
AMINOPHYLLINE N SOLM

AMIODARDNE M)

AMPHOTERICIN B IMJ

AMPICILLIN INJ

AMPICILLIN/SULBACTAM IMJ

AMICEF  «PFFAFI M KL 5

=
=

-
L

Figure 20-25: Sample Medication Order for Selecting an Inpatient Medication

Note: EHR uses a look up from Pharmacy to check if the selected
medication is a controlled substance that will require the
signature of a provider with a DEA number. A warning
message will appear to the provider “Provider must have
DEA# to order this medication” as shown below. Before an
order for a controlled substance can be entered, the
provider selected for the encounter must be able to sign the
order. You might need to exit the dialog, change the
provider, and then reenter the dialog.

DEA# Required x|

i j Provider must have a DEA# Lo order this medication

=5

Figure 20-26: DEA# Required Warning Message

20.6.1 Simple Dose for Inpatient Medication Order
The following is for ordering a simple dose, inpatient medication:
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1. Make sure you are on the Dosage tab. Select the desired dosage from the Dosage

field.
E3
[EMFICILLIN M) __ Change |

| Dozage ! Ifurnpleu

|Diozage . Route 5chadula |
| [INTRAMUSCULAR | ™ PAN|
TGHATVIAL = EID EI:
1GMTVIAL INTRAVENOUS DAILY
2GMTVIAL NASAL MO WE-FR |
5 TAM s M |
: agy{ﬂn = _ UBCUTAMEDLU ___n?;ﬂ =l
Comments.
i |
[~ Give Additional Dose Now
ROUTINE =
ADR's
AMPICILLIM 1M =]
L Accept Drder

z_ om |

Figure 20-27: Sample Inpatient Medication Order (Simple Dose)
2. Select values for the Route and Schedule fields and check PRN if appropriate.

3. Add comments, if desired. This field has a right-click menu to aid in editing the
text. See SectionA.2 for more information.

>

The application displays when the first dose of the medication is expected to be
given. If you want to give the first dose now, check the Give First Dose Now
checkbox.

Make sure that you are careful about using Give First Dose Now. When you click
the checkbox, a new order is created and sent to Inpatient Medications. Check to
make sure the Now order and the original schedule you entered do not
overmedicate the patient. If a provider selects Give First Dose Now with a simple
dose, the application displays the following warning message. (Click OK to
dismiss the warning message.)
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Give First Dose Now E %]

. First Dosa Now is in addition bo those isted in the bable,
JH) Please adjust the duration of the first row, f necessary,

[Eo]

Figure 20-28: Give First Dose Now Warning Message

5. You can change the priority by selecting from the Priority drop-down list. The
following are the only two options you should select:

Done: when given in the clinic
Routine: the default

6. Click Accept Order.

Note: If you do not complete the mandatory items or if the
information is incorrect, the application sends a message
that tells you that the information is incorrect and shows
you the correct type of response.

7. When finished ordering inpatient medication order, click Quit.

Note: The order must be signed before it is sent to pharmacy. You
can either sign the order now or wait until later.

20.6.2 Complex Dose for Inpatient Medication Order
The following is for ordering a complex dose, inpatient medication.

1. Click the Complex (Dose) tab.

Note: Once you begin a complex order, you must remain on the
Complex tab until you finish that order. Do not attempt to
start from or switch back to the Dosage tab. If you do, all
complex dosages will be erased and you will be forced to
start again

2. If needed, you can change the type of medication by clicking Change.
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x
[PHYTOMADIONE INJ Change
| Dosage | Complex :
Dosage | Rowe | Schedde | Duation [then/and|
|
| | 1MGASML
H 2HG ML
10MG/TML
= 20MG/2ML ,
Commernts:
=l
=
[T Give Addiional Dose Now iy
ROUTINE =)
4DRs |
PHYTOMADIONE 1M -]
Accept Order
 ow |

Figure 20-29: Sample Inpatient Medication Order (Complex Dose)

3. Click the Dosage cell and select the appropriate dosage.
4. Click the Route cell and enter the route.
5. Click the Schedule cell and enter how often the medication should be taken
(select PRN if desired).
6. Click the Duration cell and enter a number and select units (days is the default) a
patient should use the specified dose.
7. Add the appropriate modifier: And, Then, Except (Except is only for Outpatient
Meds). Leave the cell blank for the final dose.
8. Repeat steps 3-7 until you have completed the complex dose. This process will
add rows to the complex dosage instructions.
9. Add comments, if desired. This field has a right-click menu to aid in editing the
text. See Section A.2 for more information.
10. The application displays when the first dose of the medication is expected to be
given. If you want to give the first dose now, check Give First Dose Now.
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Make sure that you are careful about using Give First Dose Now. When you click the
checkbox, a new order is created and sent to Inpatient Medications. Check to make
sure the Now order and the original schedule you entered do not overmedicate the
patient. If a provider selects Give First Dose Now with a simple dose, the application
displays the following warning message. (Click OK to dismiss the warning message.)

Give First Dose Now x|

= First Dosa Mow is in addition to those fisted in the table.
JHJ Plaase adjust the duration of the first row, f necessary.

S

Figure 20-30: Give First Dose Now Warning Message

11. Select a priority from the Priority drop-down list. The following are the only two
options you should select:

Done: when given in the clinic
Routine: the default

12. Click Accept Order.

Note: If you do not complete the mandatory items or if the
information is incorrect, the application sends a message
telling you that the information is incorrect and shows you
the correct type of response.

13. When finished ordering inpatient medication orders, click Quit.

Note: The order must be signed before it is sent to pharmacy. You
can either sign the order now or wait until later.

20.7  View Menu Options
The following are the two options on the View menu.
Change: This function changes the medication order (but not the medication).
Chronic Medication: This function marks selected medications as chronic or not
chronic.
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20.7.1 Change

You can change the dosage, route, schedule, etc. of an existing medication order. This
option does not allow you to change the medication itself (the Change button will not

be active).

Follow these steps to change a medication order:

1. Select the medication you want to change (cannot be a cancelled order).

2. Select Change on the right-click menu to display the Medication Order dialog.

x4
[SIHETHII.'.E]NE TAE CHEWABLE Change
Dosage Emnpha
Dozage Floute Edud.ia
[1e0MG [DRAL [~ PAMN
|{ B08AG -
I ———— aHe B
[u] |
—_— ET.ET ﬂ|
Comments.
=
DaysSupcl Oy (TAB) Refls - Pick Up - Priciity
= =l 2 & Cini
{30 = 20 = <} @ Cine © Mal © Window | [ROUTINE »
[~ Chionic Med
[+ -#aY USE AT BEDTIME IF HEEDED
ADR's
SIMETHICOME TAB.CHEWABLE 80MG ﬂ
CHEW TWw0 TABLETS MOUTH FOUR TIMES A DAY -M&Y USE AT BEDTIME IF Drder
NEEDED Hocept
Quantty: 240 Reflls: 1 Chiordc Med: MO _I : I
- ﬂ'-ﬂ

Figure 20-31: Sample Medication Order to Change

3. Complete the changes as appropriate on the Medication Order dialog. See either
Section 20.5 or Section 20.6 for more information about completing the dialog.

4. Click Accept Order to change the medication order. (Otherwise, click Cancel.)

5. You can sign the changed order now or later.

20.7.2 Chronic Medication

The Chronic Medication feature, an option on the right-click menu, marks selected

medications as chronic or as not chronic.
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Chronic medications apply to outpatient medications only; they have a + mark in the
Chronic column. Once the medications are marked as chronic, you can sort the list by
clicking on the Chronic column heading until all of the chronic medications are listed
at the top.

Follow these steps to use the Chronic Medication features:

1.

To select all chronic medications, select Chronic Medication > Select All on the
right-click menu.

To mark (outpatient) medications as chronic, select the medications. Use the Shift
or Ctrl key in combination with the left mouse button to select the medications.

Hold down the Ctrl key to select medications that are not adjacent (on the list).
Hold down the Shift key and click the first and last medications to select a range
of medications.

Select Chronic Medication > Yes on the right-click menu. The selected
medications will have a red check mark in the Chronic column.

To mark medications as not chronic, select the chronic medications you want to
use. Use the Shift or Ctrl key in combination with the left mouse button to select
the medications.

Hold down the Ctrl key to select medications that are not adjacent (on the list).
Hold down the Shift key and click the first and last medications to select a range
of medications.

Select Chronic Medication > No on the right-click menu. The selected
medications will have no red check mark in the Chronic column.

20.8 View Menu

The View menu has options to view either the medication order details or the
administration history of the medication order.

20.8.1 Detalls
This function display the details of a selected medication. Follow these steps to view
the details:
1. Select a medication.
2. Select Action > Details (or select the Details option from the right-click menu) to
display the Medication Details pop-up.
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EIMVASTATIN LOMG Quantity: 30 Refills:
LOWER CHOLESTEROL
<Reneved by Fharmacy>

x|

Activity:

05182002 NHew Order (Fenewal) sntered by SCHEY BLAINE (PHARMACIST)
Order Text: SIMVASTATIN 10MG Quantity: 30 Refills: § TAKE 1 TABLET

BY MOUTH EVERY EVENING TO0 LOWER CHOLESTEROL

Hature of Order: WRITTEN
Ordered by: ETRON ROBERT © [FHYSICIAN)
Flignature: 0N CHART WITH WRITTEN OPDERE

03 LE/ 2004 10:34 Disconcirnasd by FISHER, ALBERT ANTHONY
Reason for DC: Ranewad by Pharmacy

Current Daca:

Treating Specialey:

Ordering Locanion: EYRON, R-DH

Srart Dace,/Tima: 03,1872003

Zrop Dace/Tims: 031872003

Current SCatus! DISCONTINUED

Orders that have been stopped prior £o expiration of completion.
Drdar EEE4343

Order:
pdication; SIMVASTATIN TAB
ChasrE A6y a0
Refille: 5
CommentE:

TAKE L TABLET BY HOUTH EVERY EVENING TO LOWER CHOLESTERODL

Dispense Druags lundtsSdosed: SIMVASTATIN LONMG ()

Lozt Filled: D/1070D

|Refills Remaining: 5

Filled: 2718703 (Window) released 9/18/03
PENEWED FPROM X 2 8057592

Frescriptiond: BOETERAA

Fharmscist: SCHEY ,BLAINE

Hedication Adeiniscracion Hiscory

FATIENT: ®LITTLEWOLF ,PECCY LYNN

EDICATION: SIAVASTATIN
.
4] | +

Figure 20-32: Sample Medication Details Pop-up

Please note that the label for the Medication Details pop-up will contain “Outpatient
if you selected an outpatient medication. Likewise, it will contain “Inpatient” if you
selected an inpatient medication.

3. You can print the information on this pop-up by clicking Print.

4. Click Close to dismiss the pop-up.

20.8.2 Administrative History

This function display the administrative history of a selected medication (does not
apply to IV Fluids).

Follow these steps to view the administrative history:

1. Select a medication.
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2. Select View > Administrative History (or select the Administrative History option
on the right-click menu) to display the Administrative History pop-up.

f__ Oubpatient Medication Administration History

i
Medication Administration History
FATIENT: *LITTLEWOLF, PEGCY LYNN
HEFICATION: SIMVASTATIN
Locaticn ¥t Sch Administraticn Date Aduin By Injection Site
Hedication & Dosage
[ T |

Figure 20-33: Sample Administrative History Pop-up

Please note that the label for the Administration History pop-up will contain
“QOutpatient” if you selected an outpatient medication. Likewise, it will contain
“Inpatient” if you selected an inpatient medication.

3. You can print the information on this pop-up by clicking Print.

4. Click Close to dismiss the pop-up.
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21.0 Notifications
Notifications are messages that provide information or prompt you to act on a clinical
event. Clinical events, such as critical lab values or a change in orders, trigger a
notification to be sent to all recipients identified by the triggering package (lab, for
example).
Hotifications for All Patients
[ 5 | Patient | Motification | — Legerd
3 PATIENT DEMO (355 tibromal labs - [GLUCOSE] 1 Priceity
a DEMOFEMALE & [21334) Wishl it missng & pupose of vist @ Low
@ ' DEMOFATHER [5485) Tiy Ot 3 Medum
| DEMOMOTHER R [3423) Abnoimnal labs - [LIPID PROFILE DEMO] @ High
1 DEMOMOTHER A [3423) Imaging Results: CHEST 2 VIEWS PALLAT e
1/ Indo Qe
Process
LIS
» el
i/ Info Onky
¥ Show &l
Figure 21-1: Sample Notifications Window
Each patient’s name (in the list) has an identifying number (patient’s Health Record
Number).
You can display (as a tooltip) detailed information about a notification by hovering
the cursor over the particular notification.
L3 W'\ FISHER.ADAM LYMN  [33644)
3 w1 FISHER.ADAM LYMN  [33644)
3 Patient: FISHER,ADAM LYNM (33644)
[ Subject: Abnarmal lab: WEBC 13 04/01 10:35
= Sender: LOZIER, DOMMA
Delivered: 01-Apr-2005 10:51
@ Priority: Medium
= Tvpe: Info Only
-
Figure 21-2: Sample Tooltip for a Notification
The Notifications component can be configured so that the Legend appears on the left
or right OR not appear at all.
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21.1  Show All Checkbox

When the “Show All” checkbox is checked, then you are viewing the notifications for
all patients.

When the “Show All” checkbox is not checked, then you are viewing the notifications
for the current patient.

21.2 Information-Only Notifications

When a notification has a ¥ checkmark in the second column, the notification is
classified as an information-only notification. You can process all of the information-
only notifications by clicking the Info Only button or by selecting Process Info on the
right-click menu. You can delete this type of notification by selecting one and
clicking Delete; see Deleting a Notification (next section) for more information.

21.2.1 Deleting an Information-Only Notification
You can delete a selected Info Only notification by following these steps:

1. Select an Info Only notification.
2. Click Delete to display the Confirm information message.

x

DEMO,BOY (45444
\.__*(/ Here is a scheduled message

Are wou sure you wank to delete?

Yes Mo Zancel Al

Figure 21-3: Confirm Information Message

3. You can do any of the following:

Click Yes to delete the selected notification.
Click No to not delete the selected notification.
Click Cancel to leave the Confirm dialog.

Click All to delete all of the Info Only notifications.
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21.2.2 Using the Info Only Button

If you click the Info Only button (or select Process Info on the right-click menu), you
move to the first information-only notification. You can process all the information-
only alerts by clicking this button.

The Processing Notifications buttons appear on the Notifications window (see Section
21.4.1 for more information).

The following dialog displays (after clicking the Info Only button):

@ DEMOFATHER  (5465) x|
Subject: Notice

From: USER.DEMO

On: 13-Mar-2007 14:43

[Hee iz & natice from uses demo =f

Select an action for this informalion-only alert:

Delele Skip Cancel Delete A1 Skip Al |

Figure 21-4: Action for Information-Only Notification

The name of the patient and the patient’s Health Record Number displays in the
heading part of the dialog. The patient name might not be there; in this case, it is
substituted with the Information-Only Alert label.

The Subject, From, and On information comes from the information-only alert itself.
You can do one of the following things on this dialog:

Delete: Removes the current information-only alert from the Notifications window.
Skip: Moves to the next information-only alert and displays information about it.
Cancel: Cancels the dialog.

Delete All: Removes all of the information-only alerts from the Notifications
window.

Skip All: Stops the processing of the information-only alerts.

User Manual Notifications
October 2007

173



Electronic Health Record (RPMS-EHR) Version 1.1

21.2.3 Scheduling a Naotification

You can schedule a notification to appear on the Notifications window. This process
schedules a notification for delivery to the specified recipients at a future date and
time. The information you input will appear as an information-only notification for
the recipients at the specified delivery time.

Make sure to select a patient. Follow these steps to schedule a notification:

1. Select Schedule on the right-click menu to display the Notification Scheduling

dialog.
(=] FY
Scheduled Notihcstions
v | Schedule | Patient | Message |

@  0E-Ape-2007 08:25 BRADLEY LADOM... HFead iesuls

Figure 21-5: Notification Scheduling Dialog

This dialog lists all of the scheduled notifications. The first column shows the
priority, Schedule shows the date and time, Patient shows the patient the scheduled
notification is associated with (it might be blank), and Message shows the message
for the scheduled notification.

The buttons on this dialog have the following functionality: Add: adds a new
scheduled notification.

Delete: removes a scheduled notification.

Modify: changes a selected scheduled notification. Refresh: updates the dialog with
the most recent changes.

Close: dismisses the Notification Scheduling dialog.
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21.2.3.1 Add

To Add a new scheduled naotification, click Add to display the Schedule a
Notification (for the selected patient) dialog.

: x|

¥ Aspociste with Bradisy Ladonng Kaye
D efrver orc Prianky:
I s [@Low =
Subject
J
Recipients:
{TETER SHIRLEY |
Message:

B

=

Cancel |

Figure 21-6: Sample Schedule a Notification Dialog

1. If you remove the check from the “Associate with” field, this causes the
scheduled notification to have the Patient cell on the Notification Scheduling
dialog to be blank. In addition, the Patient cell on the Notifications component
will be blank (when the scheduled notification displays).

2. You can enter a date and time in the “Deliver on” field or click the :I button to
select a date and time. Please note that date and time are required.

If you select a date and time that is not in the future, the Error alert displays. Click
OK on the alert and select a future date and time.

Eror x|
@ Delivery date must be on or after todasy,

Figure 21-7: Error Alert
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21.2.3.2

3. You can specify a particular priority by selecting from the drop-down list for the
Priority field.

4. Enter the text for the Subject field. This field has a right-click menu to aid in
editing the text. See Section A.2 for more information.

5. The default recipient is shown in the Recipients field. You can change the name
by clicking the = button.

6. You can add a message by entering it in the Message text box. This field has a
right-click menu to aid in editing the text. See Section A.2 for more information.

7. When the Schedule a Notification dialog is complete, click OK. (Otherwise, click
Cancel).

The notification will appear on the Notifications window at the specified date and
time.

8. When the scheduled notification appears on the Notifications component, a pop-
up alert appears in the lower right corner of the EHR screen.

Mew Motification &
high pricrity

Figure 21-8: Sample New Notification Pop-up Alert

If you click the X, this dismisses the pop-up.

If you click on the text of the pop-up, this selects the scheduled notification on the
Notifications component.

Delete

To remove a selected scheduled notification from the Notification Scheduling dialog,
click Delete to display the Confirm information message

]
‘-?r) Are you sure you wank to delete the selected scheduled notification?

Figure 21-9: Confirm Information Message

Click Yes to delete the selected scheduled notification. (Otherwise, click No.)
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21.2.3.3 Edit

To edit a selected scheduled notification, select it and click Modify to display the
Reschedule a Notification dialog.

|
Defives orc Priarty:
[13Mar-2007 14:00 = [@lew =]
|USER DEMO |
Mecsage:
=
=
oK Cancel |

Figure 21-10: Reschedule a Notification Dialog

1. You can edit the fields as described in adding a new scheduled notification. See
Section 21.2.3.1 for more information.

2. When the Reschedule a Notification dialog is complete, click OK. (Otherwise,
click Cancel.)

21.3 Forwarding a Notification
You can forward a selected notification to other recipients by following these steps:
1. Select a notification you want to forward.

2. Click Forward (or select Forward from the right-click menu) to display the
Notification Recipients dialog.
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Motification Recipients

— WUsees Recipierts

[~ Groups

ACTOM.ERIC ﬂ
ADaMS ROBERT C J
ALCOHOLISMCOUNSELOR STEVE
ALCOHOUISMCOUMSELOR.STEVE
ALDEN.CONTRACT _:_J
ALDEM MARLAN

ALDEM MARY J

ALLARD BRIAN ALBERT
|ALLARD LORI S =]
|

|

AR USER

ADT MGR

APS0 DRUG AWP/AAC NOTIFICA]
BHL QUERY

BLS EXFORT FILE SENT

BMC CHS ALERT |

AR MAMAGER :|
[ |

Comirent:

ok | Canull

Figure 21-11: Sample Notification Recipients

3. You can select Users and/or Groups to become recipients of the selected
notification.
The list in the Users panel comes from the NEW PERSON file. The list in the
Groups panel comes from the MAIL GROUP file.

4. To search for a user or group, enter a few characters in the text box, and the list
below the text box scrolls to the first name it can match with the characters.

5. To add the user or group to the Recipients field, click the right-pointing arrow
(2.

6. To remove a user or group from the Recipients field, select the user and/or group
and click the left-pointing arrow (1| ).

7. Toremove all of the users and/or groups from the Recipients field, click the
double arrow (1| ).

8. You can add comments in the Comments field. This field has a right-click menu
to aid in editing the text. See Section A.2 for more information.

9. When the Notification Recipients dialog is complete, click OK. (Otherwise, click
Cancel.)

10. You can view the entered comments by hovering your cursor over the notification
and viewing the tooltip for it.
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21.4  Processing Notifications
You can process (non information-only) notifications: (1) by clicking the All button,
or (2) by selecting a notification and clicking the Selected button.

21.4.1 Using the All Button
If you click the All button (or select Process All on the right-click menu), you move
to the tab where the particular item can be processed. The EHR might display a dialog
that asks for your electronic signature, for example. You can choose to enter your
electronic signature and then choose the “Next” button in the Processing Notifications
area of the tab to move onto the next item requiring some action on your part.
Proceszing Maotifizations. .

B Hext M Stop

Figure 21-12: Processing Notifications Area
Otherwise, you can ignore the necessary processing and click the Next button. Of
course, you can stop all processing by clicking the Stop button.

21.4.2 Using the Selected Button
Select the notification you want to process and then do one of the following: (a) click
the Selected button, (b) select Process Selected on the right-click menu, or (c) double-
click the notification. You move to the tab where the item can be processed. You can
complete the processing (like by entering your electronic signature).

21.5 Personal Preferences for Notifications
You can control what notifications you want to have notify you. You cannot turn off
mandatory notifications, however. Also, you can choose a surrogate to receive your
notifications within a particular date range. In addition, you can delete pending
notifications.
Follow these steps:
1. Select Tools > Options to display the Options dialog.
2. Make sure you are on the Notifications tab.
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options x|
Nofifications | Order Checks | Teams | Notes | Repats |
Motficaton:
' [T Send me a Mailhian bubstin for lagged oidess
Sunogate Settings... | [ Bemove Pending Notication.. |

Sumogate: <no surogate designated:
Yo can bum on of off these notficabons except those that are mandatorny.

Aleit | onoi | Comment | &

[ Abreemal Imaging Resulls On Mandatony it

O Abrnosmal Lab Resut (Info) O

[ sbrosmal Lab Resuls faction]  On

[#] Admizzion On

O Conzult/Proc Interpretation of

[ Corcubt/Bequest CancelHold On

[ Consut/Request Resolution On

O Corsubt/Flequest Updated o :i
3 Cancel | ooy |

Figure 21-13: Options Dialog

21.5.1 Turning On/Off

Check (or uncheck) those notifications you want to turn on (or off) in the lower grid.

The notification having “Mandatory” in the Comment column cannot be unchecked

(turned off).

21.5.2 Remove Pending Naotification

In order for the Remove Pending Notification button to be active, your Clinical
Applications Coordinator must set it up for you. Click it to remove pending

notifications. The Confirm information message displays.

T

CALUTICON: This will clear all the current notifications vou have pending.

- If wou say YES, these changes will take place immediatel:,
Are wou sure you wank ko erase all of your notifications?

]

Figure 21-14: Confirm Information Message to Clear Pending Notifications

Click Yes to clear all pending notifications. (Otherwise, click No.)
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21.5.3 Surrogate Settings

You can have a surrogate receive your notifications (optional). Click the Surrogate
Settings button on the Options dialog to display the Surrogate for Notifications

dialog.
<no sunagsle desgnsted:
Iirun:{m
Suirogate: ik < 5
ok | cance |

Figure 21-15: Surrogate for Notifications Dialog

1. Select a surrogate from the drop-down list for the Surrogate field. After selecting
the surrogate name, the “Surrogate Date Range” button becomes active.

Surrogate for Notifications HE
Aguilar lhe
Remove Surogate I from: <riwe
Surrogate: undt < Y

anl,:lal_lhs

Figure 21-16: Sample Selected Name for Surrogate

2. Click the Surrogate Date Range button to a date range (optional); otherwise it will
always be in effect.

Erter a date range Lo begn and and when this will be
in effect. Othenmize it will ahvays be in effect,

Start D ate Stop Date

|| = |
0K | Concel |

Figure 21-17: Date Range Dialog for Surrogate Date Range

Enter the Start and Stop dates or click the =] button to display a calendar from
which to select a date and time.
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Click OK on the Date Range dialog. You return to the Surrogate for Notifications
dialog, with the date range displayed on it. You have the option of removing the
surrogate and/or selecting a different date range.

Aguilss Ik
Remove Sutiogate | from: Det 15,2004@16:58
Su ) unbl: Oct 31, 2004/200:00

[ﬁguilal_lh.s

Figure 21-18: Sample Surrogate for Notifications with Date Range

3. Click OK on the Surrogate for Notifications dialog. This saves the Surrogate
information for your notifications. (Otherwise, click Cancel).

4. You return to the Options dialog with the surrogate name and date range on it.

Noifications | Order Checks | Teams | Notes | Repons |
Motification:
™ Send me a MaiMan bulstin for Aagged onders

Sunogate: Agullar Ihs (from Oct 15200461658 wntil Dct 31, 2004@00:00)
You can turn on of off these notifications except those that are mandatorny.

Mabiication | om0t | Comment |~
[ bnosmal Imaging Fesuks On I andatom |
[¥) Abnocmal Lab Result [Indo) On
O abnoemal Lab Fresults {fction) o
O admission o
[ Corsub/Proc Interpretation o
Consult/Request Cancel/Mold On
[ Corsult/Request Resolution On
[#] Conzult/Request Updated On ;I
ok | Cacel |  speb |

Figure 21-19: Sample Options Dialog with Surrogate and Date Range

5. When the Options dialog is complete, click OK to accept the on/off switches for
the notifications. (Otherwise, click Cancel.)
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22.0 Orders

Orders are placed using options from the Write Orders field. You can place orders for
a variety of items and procedures, such as medications, consults, lab tests, as well as
information about a patient’s adverse reactions.

Fie Vew Ackon Opions

[T - ctres Onden [irciudes Perdng b Flecen Aoty - AL SERALES
[ Serwen | [ | Dussen | Froedes | boses | Cink | Chat B
Ly HICROALBUMSI OED LABIE 5P DHCE Indeston TP 2DRABETES MELLITUS LB Shaet 1 [ sl
METFOAMI 145 DFLAL S00MG Siwn OAZLE
Ou Med:  TAKE OHE TABLET MOUTH TWACE A DA THE BLOGO SUSAR - TWF Step DSZINT  Hlages actem
Chaiartiy 150 ol 3
HYDROCHLOROTHIAZIDE TES 259G Siae OEZIAE
Ouk Mgch | TAKE CINE HALF TABLET MOUTH EVERY MORNING THC BLODD PRESSLIAE Stop DEZIAT | Hages b scieen
Gty X0 Pl 11
ASPEF TABEC §iM0 St D526
Out Mech  TAKE COHE TABLET WOLITH EVERT Dty Slape DRELOT MagaM e
Casrilye ) Fedile 3
Lshi s z TUTBURDE 4G Ta8= ? Sist DLZE
Flashokirgy Ohack Dlafasi Ok Misd: | TAVE 5045 MOUTH EVERY [ TO/HELP CONTROL BLOOD SUGARS Siap OSZIT | Hages M wtn
unst bl Dhnck, Cinbaer Gty 90 Fioil 3
Corvl Fiaattirin FERICELING Sist LZATAM
A drvmnn Oedeey Moy g g b aciivn

Figure 22-1: Sample Orders Window

The Orders window displays information about each order, such as which service the
orders are associated with, the start and stop date of each order, the name of the
provider who entered the order, and the status of the order.

The Orders window has the following features:

e The View Orders category field contains the name of the order category being
viewed (in the right panel). In addition, it can contain the name of the order within
that category.

e The Write Orders type field contains the list of order types that can be selected.
e The right-hand panel contains a list of the orders being viewed.

e Order checks are performed on all orders (after you click Accept Order and before
you sign the order) to prevent errors (such as duplicate orders) from occurring.

e You can specify that an order become active immediately, or specify that an order
be event delayed (inpatient only) and activated when the selected patient is
admitted, transferred, or discharged.
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e You can save common or standard orders as quick orders so they can be placed
more quickly.

Note: The orders listed in the Write Orders field will vary from
site to site. Because of this, some of the orders discussed in
the following sections might not be available to you. The
ORWOR WRITE ORDERS LIST parameter determines
the names that appear in the Write Orders field.

Please note that this section does not cover the “Change Release Event” option on the
right-click menu. Release events are for inpatients. Many of the IHS site are
outpatient only and do not use any inpatient events. Sites that do have inpatients will
start setting up these events when they have inpatient training.

22.1 Viewing Orders

You can control which orders appear on the Orders window by defining specific
criteria. For example, you can specify that only unsigned orders associated with a
specific service or section appear. Unsigned orders appear on the Orders window in
bold, blue lettering.

Follow these steps:

1. Onthe View menu, select one of the following view options (in top of the menu):

|File Wiew Action Options

Active Orders (includes pending, recent ackivity)
Current Orders (active/pending status onty)
Auto DCfRelease Event Crders

Expiring Orders

Unsigned Crders

Custom Order Yiew...

| Wiew

| ‘wibte
[Dela
|6 Save as Defauk view...
| Imag Rsturn bo Default View
N Ot

i ,np:] Detais. .
I Fh Results...

| Text  paculbs Hiskary...
IfLabs 1

[Radi  Refresh F5

Figure 22-2: View Menu Options
2. The appropriate orders will appear in the right-hand panel.
3. Select the Refresh option if you want to update the current Orders window.

4. 1f you would like to filter the orders further, continue with step 5.
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22.1.1 Custom Order View

1. Select View > Custom Order View (or select Custom Order View on the right-
click menu) to view the Custom Order View dialog.

£: Custom Order View |_ O] =} |
Orders - Al
Ordes Status SenacesSection
= Al &l = m N
Active inchedes pending, rec + PHARMALCY
Cuitent [Active & Pending ste & LABORATORY
Dizcontinuwed + IMAGING
Completed/E xpired + DIETETICS
Expinng COMSULTS
Perding VITALS/MEASUREMENTS _ |
On Hold # MURSIMG
Hew Orders SURGERY
r Hl:lil.g.ll::e_da R measpnisa _,ll T Efns'n (Bl lat otk N rrn\Lr'ﬂ
1| ] » 1| | »

I Onby List Orders Placed Duwing Time Penod

i = T =

p FHeyerse Chionological Sequence oE I C i I
[ Group Orders by Service

Figure 22-3: Sample Custom Order View Dialog

2. Select the criteria for the orders that you want to display on the Orders window by
doing one or more of the following:

e Select an order status from the Order Status scroll list. (Click the + sign to
expand a heading.)

e Select a service or section from the Service/Section scroll list. (Click the +
sign to expand a heading.)

e If you would like to limit the orders to a specific date range, check the Only

List Orders Placed During Time Period checkbox and enter the from and through
dates. Click the =] button to choose a date from a calendar.

e Check the Reverse Chronological Sequence checkbox if you want the oldest
orders to appear at the top of the orders list.

e Check the Group Orders by Service checkbox if you want the orders to be
sorted according to the service with which they are associated.

3. Click OK. The orders that meet the criteria you specified on the Custom Order
View dialog will display on the Orders window.

4. The criteria for the displayed orders appears above the Service column (in the
right panel).
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If all of the active orders are not displayed on the Orders window, the & icon will
appear above the last column on the right side of the screen.

Current Orderz [Active & Pending Statuz Only] - ALL SERVICES %

Figure 22-4: Example of Active Orders Not Displayed

5. If you choose Active Orders, you will see the Active and Pending orders that have
seen activity in the past number of hours your site specifies in a parameter. (Some
sites use this to see all activity in the past 24, 48, or 72 hours. The Clinical
Applications Coordinator can set the number of hours.)

22.1.2 Default View for Orders
A default view for your orders is one you particularly use the most and want it to be
the view that displays when you enter the Orders window. Follow these steps:
1. Establish the view that you want as your default view.
2. Select View > Save as Default View to display the Save Default Order View
information message.
=
a9 The current order view Is:
</
Active Orders
Sort order dabes in reverse chronological crder
Group orders by service
Do youw wish to save this as your default view?
ho
Figure 22-5: Sample Save Default Order View Information Message
3. Click Yes to save the view as your default view. (Otherwise, click No.)
4. If you are in another view on the Orders window, you can return to your default
view by selecting View > Return to Default View.
22.2 Medication Orders
When ordering medications, you can order Outpatient or Inpatient Medications,
including IV Fluids and Unit Doses. Outpatient medications and Inpatient
medications are defined by Pharmacy.
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22.2.1

22.2.2

Note: If a medication is preceded by an asterisk (*), the asterisk
indicates that the order was changed by the pharmacy
service.

If you would like to view additional information about a medication order, double-
click the order or select a medication order and choose View > Details to display the
Order Details pop-up. See Section 22.11 for more information.

To order outpatient medications, select Outpatient Medications on the Write Orders
field. The ordering activities are the same ordering them on the Medications window.
See Section 20.5 for more information.

To order inpatient medications, select Inpatient Medications on the Write Orders
field. The ordering activities are the same ordering them on the Medications window.
See Section 20.6 for more information.

ADRSs Button

The ADRs button appears on many of the medication dialogs within the Orders menu.
Click the ADRs button to show the Patient Postings information about the current
patient (contains the patient’s allergies as well as Crisis notes, etc.). See Section 8.0
for more information.

Holding Pharmacy Orders

Only active pharmacy orders can be placed on hold. Orders placed on hold will
continue to show under the ACTIVE heading on the profiles until they are removed
from hold. An entry is placed in the order’s Activity Log recording the person who
placed/removed the order from hold and when the action was taken.

The Hold option might not active on your system. This option is controlled by a
parameter that must be turned on in the RPMS.

Make sure a visit is selected. Follow these steps to place an order on hold:

1. On the Orders window, select the pharmacy order you want to be placed on hold.

2. Select Action > Hold (or select Hold on the right-click menu) to display the Hold
Order dialog.
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& Hold Drder =10l x|

The following order will be placed on hold:

“GLYBURIDE GG TaB™
TAKE BG MOUTH EVERY DAY TO HELP COMTROL BLOOD SUGARS
[uantite: 90 Refillz: 3

Enter a reason for the hold:

[k I Cancel

Figure 22-6: Sample Hold Order Dialog

3. The “Enter a reason for the hold” is a required, free text field. See Section A.2 for
more information about editing the text.

4. Click OK.

The pharmacy order will have Status = Hold on the Orders window.

5. You can sign the order now or later. See Section 22.13.5 for more information.

22.2.3 Releasing a Pharmacy Order from Hold

The Release Hold option might not be available on your system. This option is
controlled by a parameter that must be turned on in the RPMS.

Make sure a visit is selected. Follow these steps to release a pharmacy order from
hold:

1. On the Orders window, select a pharmacy order with a Status = Hold.

2. Select Action > Release Hold to display the Release Order from Hold dialog.

& Release Order from Hold 10l x|

The following order will be releazed from hold:

*Hold GLYEURIDE 5kG TAB™
TAKE BiG MOUTH EVERY DAY TO HELP COMTROL BLOQD SUGARS
[uantite: 90 Refillz: 3

ok I Cancel
Figure 22-7: Sample Release Order from Hold Dialog
3. Click OK. (Otherwise, click Cancel.)
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The selected pharmacy order will have Status = Unreleased on the Orders
window.

4. You can sign the order now or later. See Section 22.13.5 for more information.

22.2.4 Renewing Medications

The Clinical Applications Coordinator can set the renew limit for expired medication
orders. This is the maximum number of days following the expiration of a
prescription that it may still can be renewed.

Only active orders or those which have been expired less than renew limit (discussed
above) can be renewed. You must have Outpatient Pharmacy 7.0 loaded in order to
renew a medication order. The Duration for the order (to renew) must have a Stop
Date after the current visit date.

After a renewed order is accepted, the Start Date/Time for the renewed order becomes
the Start Date/Time of the original order. The original order’s status is changed to
Renewed (after signing the order).

Once an order has been renewed, it cannot be renewed again or edited.
Make sure a visit is selected. Follow these steps to renew a medication order:

1. Select the pharmacy order to be renewed. You can select more than one order.

2. Select Action > Renew (or select Renew on the right-click menu) to display the
Renew Orders dialog.

i

The following orders will be renewed:

HYDROCHLOROTHIAZIDE TAR 25MG
TAKE OME-HALF TABLET MOUTH EVERY MORMING THC BLOOD PRESSURE
Cuantity: 30 Refillz: 11 [pick up at ‘wWindow)

“GLYBURIDE SMG TaB=
TAKE BMG MOUTH EVERY DAY TO HELP COMTROL ELOOD SUGARS
Cuantity: 90 Refillz: 3 [pick up at Window)

Change... | | ] I Cancel

Figure 22-8: Sample Renew Order Dialog for Two Orders

3. If you need to change the Refill/Pick Up information, select the order’s text in the
Renew Orders dialog and the button label changes:
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=ioi x|
The following orders will be renewed:
i |LIF.I'II'HLIZIF.FIT|-I AZ1I0E JuF‘ 29MG

SURE

GL‘r’ELIFIIE'E EMG T.ﬂ.EI
TAKE 584G MOUTH EVERY Dy TO HELP CONTROL BLOOD SUGARS
Quantity. 30 Refilz; 3 (pack up at Wirdow]

Change Refilz/Pick Lp.. [ ok | concal |

Figure 22-9: Renew Order with Change Refills/Pick Up Button

Click the Change Refills/Pick Up button to display the Change Refills dialog.

& Change Refills for Dutpatient Medication =10] x|

[SIMVASTATIN TAE 20MG
TAKE ONE TABLET MOUTH QPM
Quanitity: 30 Rehllz: 11 [pick up at Window)]

Freflls Pick Up
fin [t ‘window |

[ oK ] _Concel |

Figure 22-10: Change Refills Dialog

You can manually change the number of refills and can change the Pick Up

information by selecting from the drop-down list.

Click OK on the Change Refills dialog to return to the Review Orders dialog.

4. You can repeat the above process, if needed. Click OK on the Renew Orders

dialog. (Otherwise, click Cancel.)

The renewed pharmacy order appears on the Orders window with Status =

Unreleased.

5. You will need to either sign the order now or later. See 22.13.5 for more

information.

After signing the order, this changes the order to have Status = Renewed.

22.3 Ordering Lab Tests

When ordering lab test, a parameter in the RPMS establishes the number of days back
in time to look for duplicate lab orders. This is part of the order checking process.
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Make sure a visit is selected and that the current view is Active Orders. Follow these
steps to place an order for a lab test (this is the “generic” lab order method):

1.

2.

Select Lab Tests in the Write Orders field. (The lab tests order might be labeled
differently or might not be available from the Write Orders field.)

The Order a Lab Test dialog displays.

& Order a Lab Test ||

Avadable Lab Tests

Collect Sample I vi

<O AND PAHA‘S:}:E
10608 <ALPHA-T-ANTITR : lﬁ
4400 cAMAS [ Specimen =
100454 <AMGIOTEMSIN COI FouTiE o]
100462 <ACETYLCHOLINE § Urgency [ROUTINE -
100495  <ALDOLASE:

100457 <ALKALINE PHOS I£
100504 <ALDOSTERONE> =|

Collection Type Colection Dale/Time

[SendPatierttoLab =] [TODAY Bfonce I

.

Figure 22-11: Sample Order a Lab Test Dialog

You can search for a lab test by entering a few characters in the free text field
below the “Available Lab Tests” label. In this case, the list will scroll to the first
lab test containing those characters, if no quick orders begin with those characters.
(Remember the system searches the quick orders first, then the list of available lab
tests.)

All free form fields, like Collective Date/Time, contain a right-click menu to edit
the text. See Section A.2 for more information.

Select the desired lab test in the Available Lab Tests list box.

The field in the lower part of the dialog shows information about the selected lab
test. This field has a right-click menu for copying selected text. You can paste this
text into another free-text field in the EHR or into another application (like MS
Word). See Section A.2 for more information.
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Aveadable Lab Tests 1HR TOLERAMWCE TEST. GLUCOSE
1 HE TOLERANCE TEST GLUCKNNUNN TRk
05956 <RAST GLUTEN: =] o o oee [ hd

106036 cAMYLASE ISOEN W -
cHEMaGRAN pecmen [SERUM

HOVANA BY PCR [ p—

1 HR GLUCOSE SCREEM Uigency |ROUTINE =

1 HR TOLERAMCE TEST, GL

1.25 DIHYDROMY WIT D. po/r
1.25DIHYDROXY <1.250IH-x]

Collection Typs Cobection Date/Time Hotw Oftend Hew Lianig?
|Safb:lF'aherHuLab :I ITEIDA"(' _j | ;J |
Clhrical Indication:

I 5

1HR TOLERANCE TEST, GLUCOSE BLOOD SERUM SPOMCE

Figure 22-12: Sample Lab Order Showing Information in Lower Part of Dialog

In some cases, a warning message will display in the lower part of the dialog.

(Click outside the message to dismiss it.)

I,

SUBMIT FULL LAVENDER TOP TUBE TO LAE.
0O NOT FREEZE.

3

=]
=

Figure 22-13: Sample Warning Message for Lab Order

F S

[

6. You can change the default values for the Collect Sample, Specimen, and/or
Urgency fields. If you cannot change a field, the text label (to the left of the field)

will be dimmed.

7. You can change the collection type from the Collection Type drop-down list.

8. You can manually change the collection date and time (cannot be earlier than the
current date/time). Otherwise, click the button to select from a calendar.

9. The Clinical Indication field is required (in order to save). Select an option from

the drop-down list to populate this field.

If you want to enter free-text in this field, select the “Other” option to display the

Clinical Indication dialog.
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Clinical Indication

Enter an indication for this order;

0k I Cancel

Figure 22-14: Clinical Indication Dialog

Enter the text of the clinical indication into the field (free-text field). Click OK to
add the text to the Clinical Indication field.

If you click Cancel, the Clinical Indication field will be blank.

10. Complete the “How Often?” and “How Long?” fields (if necessary).
11. Click Accept Order.
12. When finished ordering lab tests, click Quit.

Note: The Lab Test order must be signed before it is sent. You
can either sign the order now or wait until later. See Section
22.13.5 for more information.

22.4  Ordering Imaging/Radiology
Make sure a visit is selected and that the current view is Active Orders. Follow these
steps to order any type of imaging or radiology (like nuclear medicine) order:
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& Order an Imaging Procedure x|
[magng Tipe Hittory & Reason for Exam

GENERAL RADIOLOGY E
Imaging Procedue

ABDOMEM 3 0R MORE VIEWS -

ABDOMEM FLIB

CALCANEDUS 2VIE'WS ;j
CHEST 2WIEWS PakLAT

CLAVICLE Aequested Date  Ligency Tranzpoart i Pielp Schedulsd
FACIAL BONES. LESS THAN 3VIEWS o [rooay .| [ROUTINE j {AMBULATOR' =] | |
Avalable Modfiess  Selected Modfiers  Category L
[ |OUTPATIENT =] [Ra =] I lsolaion
BILATERAL EXAM Examsz Over the Last 7 Days

LEFT  Pracran

OPERATING ROOE

PORTABLE EXAM . Unknown

RIGHT " Yes

" No
Hemove |
=| Accept ﬂrdafl
F Cuat |

Figure 22-15: Sample Order an Imaging Procedure Dialog

1. Select Imaging in the Write Orders field. The imaging order might be labeled
differently or might not be available from the Write Orders field.

The Order an Imaging Procedure dialog displays.
Select the imaging type from the Imaging Type drop-down list (required field).

Select a procedure from the Imaging Procedure scroll list (required field).

o M w

Enter a history and a reason for the imaging order in the History & Reason for
Exam field (required). This field has a right-click menu to aid in editing the text.

6. Select one or more modifiers from the Available Modifiers field, if needed.

The modifiers you select will be displayed in the Selected Modifiers field.

Note: You can remove a modifier by selecting it and clicking
Remove.

7. If necessary, change the Requested Date, Urgency, Transport, and Category
fields.

8. Complete the Submit To field (if necessary).

9. Check the Isolation checkbox (if necessary).
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10.

11.

If necessary, select the time that the PreOp Scheduled field by doing one of the
following:

e Enter a date (e.g., 6/21/01 or June 21, 2001).

e Enter a date formula (e.g., T-2).

e Click the button to select from a calendar.

Select a radio button in the Pregnant group box. (required).

Note: The Pregnant group box only displays for female patients
of reproductive age (12 to 55 inclusive).

12.
13.

Click Accept Order.
When you are finished ordering imaging/radiology procedures, click Quit.

You can either sign the order now or wait until later. See Section 22.13.5 for more
information.

22.5 Text Orders

Text only orders such as Parameters, Activity, Patient Care, and Free Text orders are
different kinds of orders that are placed for nursing and ward staff to take action on.
They print only at the patient’s ward/location, and are not transmitted electronically
to other services.

Examples of text only orders include:

Order Type | Order

Parameters Vital signs

Activity Bed rest, ambulate, up in chair

Patient Care Skin and wound care, drains, hemodynamics

Free text Immunizations

Predefined nursing orders (quick orders) might be available under various sub-menus.

22.5.1 Entering Text Orders

Make sure a visit is selected and that the current view is Active Orders. Follow these
steps to place a text only order:

1.

2.

Select Text Only Order in the Write Orders field. The text only order might be
labeled differently (such as word processing) or might not be available from the
Write Orders field.

The Text Only Order dialog displays.
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x
Order: |
Start Date/Time: [NCW = |
Stop Date/Time: | =
B hcﬂﬂtlidﬂl
o am |

Figure 22-16: Text Only Order Dialog

3. Complete the text for the order in the Order field. The field has a right-click menu
to aid in editing the text. See Section A.2 for more information.

4. Enter a start date and time and a stop date and time by doing one of the following:

e Enter a date (e.g., 6/21/01 or June 21, 2001).
e Enter a date formula (e.g., T-2).
e Click the ellipsis button to select from a calendar.

5. Click Accept Order.
6. When finished ordering, click Quit.

Note: The Text Only order must be signed before it is sent. You
can either sign the order now or wait until later. See Section
22.13.5 for more information.

22.5.2 Complete Text Order

You can cause a (signed) text order to be dropped from the Active Order list. Follow
these steps:

1. Select the signed Text Order.

2. Select Action > Complete to display the Complete Order dialog.
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=i
The following order will be martked as completed:
»» Need lemp taken

Electrorac Signature Code

| [1]4 I Cancel

Figure 22-17: Sample Complete Order Dialog

3. Enter your electronic signature and click OK. The text order will be dropped from
the Active Order list. (Otherwise, click Cancel).

22.6  Adverse Reactions/Allergies

Adverse Reactions apply to allergies and to adverse drug reactions. You can also
enter no known allergies.

22.6.1 Ordering Adverse Reactions/Allergies

Make sure a visit is selected for the current patient and that the current view is Active
Orders. Follow these steps to enter an allergy from the Orders window:

1. Select Allergies from the Write Orders field to display the Look up Allergy/ADR
dialog. The allergy order might be labeled differently or might not be available
from the Write Orders field.

2. Enter the causative agent in the text field. This field has a right-click menu to aid
in editing the text. (At a minimum, you must enter the first three letters of the
agent.)

3. Click Search.

4. If there are no matching agent, the field will be empty and the following message
will appear in the lower part of the dialog.

|N|:| matching items Found, Click O to use wour entry ansisay,
Figure 22-18: No Matching Agent Message
In this case, repeat Step 2, if necessary.

5. If there are matches, they will appear in the “Select from one of the following
items” field.
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Look up Allergy/ ADR

Erites causative agent for Allesgy of Adverse Dug Reaction:
[Erter ot leact 3 characters)

pre __Seach_|

Select fiom one of the fobowing fems

AOWA Allergees File [mo makches)
=+ Drug Ingredients File (1)
WiME
WA Diug Class File [no mstches)
2% National Diug File - Genenic Drug Hame [rno matches)
G+ Mational Drug file - Trade Mame [1)

[ Mo Ko Allerin ok | Cancal

Figure 22-19: Sample Look Up Allergy/ADR Dialog
6. Select an agent. (Click + to expand a heading.)
7. Click OK to display the Enter Allergy Information dialog.

If a patient does not have known allergies, the “No Known Allergies” will have a
check in the checkbox.

If a patient does have known allergies, the Current button will be active (as shown
below).

€ Enter Allergy Information

Observer - :
™" No Known Allergies _ID.:ru‘l. |Doctor, Test | Dbseived C Historical |
Causative agent Reaction Date/Time
[COUGH FORMULA DM
Tupa of Reaction:

IDmg

Ia.N:mETv

Fieachon to COUGH FORMULA-DM ;i Accapt

Figure 22-20: Sample Enter Allergy Information Dialog
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10.
11.

12.

13.

14.

15.

16.
17.

To view a patient’s current allergies, click Current to display the Patient Postings
pop-up (showing the patient’s allergies, etc.). See Section 24.0 for more
information.

Change the Type of Reaction field (if necessary).
Select an observer from the Observer scroll list. (required)
Indicate whether the entry is an observed or historical allergy. (required).

If needed, enter a reaction date and time in the Reaction Date/Time field. Click
the button to select from a calendar.

If you are entering an observed allergy, enter a severity. (The Severity field is not
available for historical allergies.)

If needed, choose the appropriate signs or symptoms from the Signs/Symptoms
scroll list.

The signs and symptoms you select will appear in the Selected Symptoms field.

You can select a date and time for a specific symptom by selecting the symptom
and clicking Date/Time (optional) to select from a calendar.

You can remove a sign or symptom by selecting the symptom and clicking
Remove (optional).

Enter any comments for the allergy in the Comments field, as needed. This field
has a right-click menu to aid in editing the text. See Section A.2 for more
information.

Click Accept.

When finished ordering allergy (adverse reaction) orders, click Quit.

Note: The information goes to the Allergy file.

22.6.2 Entering No Known Allergies
This action applies to patients that do not have any recorded allergies.

Make sure a visit is selected and that the current view is Active Orders. Follow these
steps to enter an assessment of No Known Allergies:

1.

2.

Select Allergies from the Write Orders field. The Allergy order might be labeled
differently or might not be available from the Write Orders field. In this case,
select the appropriate order.

The Look up Allergy/ADR dialog displays.
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3. Check the No Known Allergies checkbox in the lower portion of the dialog.

Look up Allergy/ADR

mit-for Aer o or Ackvedee (g Besction

lErﬂ'ﬂ d: ha:sl.a d'saradutx.

Figure 22-21: No Known Allergies Checkbox
4. Click OK.

5. The Enter Allergy Information dialog displays.

f-_.. Enter .ﬂ.ul_‘n'h' Information

e Obsarer
W NoKnown Aleiges _ Cunent | [Doctor Test |L€ Observed & Historedl |
Causative agent - Reacton Date/Time
I'l_':f- button to search - g _I l .....J
T ppe of Beaction D ontmi,J ames
| T fowpeak o
[ Sigre/Symptoms Selecled Spmptors T Cortrant
AGITATION -
AGRAMULOCYTOSIS
ALOPECLA
ANAFHYLE=IS
ANEMIA
||aNOREXA LI Diate/ |I Retnonve I
Mo Krown Alergies =] ﬂl
;l Quat |

Figure 22-22: Sample Enter Allergy Information for No Known Allergies
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6. Click Accept.

7. Arow is added to the Orders window that appears as follows:

Servicel Order | Diuration | Provider | Nursel Clerk: | Ehartl Status
Allergy  No Known Allergies Doctor, T unreleasze

Figure 22-23: Row Added to Orders Window for No Known Allergies

8. After you sign the order, the Status becomes Active.

22.7 Change Orders

You can change the elements of an existing order. For example, you might need to
change the Dosage of a pharmacy order. This function cannot be used for controlled
substances.

Make sure a visit is selected and that the view is set to Active Orders. Follow these
steps to change an order:

1. Select the order (cannot be a cancelled order) to change.

2. Select Action > Change (or select Change on the right-click menu) to display the
order dialog for the selected record.

3. Complete the changes, as appropriate, on the order dialog.
4. Click Accept Order.

5. You can sign the changed order now or later. See Section 22.13.5 for more
information.

22.8 Discontinue Order

When an order is discontinued, the application changes the order’s Stop Date/Time to
the date/time the action is taken. Pending and Non-verified orders are deleted when
the medication order is discontinued and will no longer appear on the patient’s
profile. An entry is placed in the order’s Activity Log recording who discontinued the
order and when the action was taken.

The list in the Reason to Discontinue field is controlled by a parameter in the RPMS.
Make sure a visit is selected for the current patient. Follow these steps to discontinue
an order:

1. Select the order you want to discontinue.

2. Select Action > Discontinue/Cancel (or select Discontinue on the right-click
menu) to display the Discontinue/Cancel Orders dialog.
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£ Discontinue / Cancel Orders

T he following arderz will be dizcontinued -

BUPROFEM TaE bOOMG

TAKE OME TABLET BY MOUTH THREE TIMES A DAy
Juantite: 15 Refillz: 3

Fieazon for Discontinue [zelect one|
D uplicate Order

R equesting Phyzician Cancelled

Obzalete Order
Entered in errar k. I Cancel

Figure 22-24: Sample Discontinue/Cancel Orders Dialog

3. Select the appropriate reason to discontinue from the Reason to Discontinue field
and click OK.

The word “Discontinue” will appear in the Order column for the selected order
and the Status = Unreleased on the Orders window. (for medication orders)

Dizcontinue ERYTHROMYCIM SUSP Doctor, T unreleased
200MG /SML Stop: 10431704

TAKE 1 TEASPOONFUL BY MOUTH

EVERY & HOURS

Quantity: 200 Refills: O

*UNSIGNED=

<R equesting Physician Cancelled>

Figure 22-25: Example of Discontinued Medication Order

Other types of orders, like imaging, will have Status = Discontinue and the reason
will appear in the Order column.

CLaWICLE Start; 03/14/07
Imaging | <Entered in ermor: Stop: 031407 Uzer,D dizcontinued
10:45

Figure 22-26: Example of Discontinue Imaging Order

22.9 Copy to New Order
You can copy an existing order to a new order. This process lets you: (1) copy the
exact elements of the existing order to create a new order or (2) change the order
elements to create a new order.
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Make sure a visit is selected. Follow these steps to copy an order to a new order:

1. Select the order to be copied.

2. Select Action > Copy to New Order (or select Copy to New Order on the right-
click menu) to display the Copy Orders dialog.

& Copy Orders

"Littlewalf Peggy LYNN is cusrently st 01GENERAL

No isaling speciahy it avadable.
% Release copied orders immediately
" Delay release of copied oders Cancal I

Figure 22-27: Copy Orders Dialog

3. Make sure the “Release copied orders immediately” radio button is enabled. (The
Delay release of copied orders is used for inpatients only.) Click OK.

4. The New Order dialog displays.
x|

Hedication: ASPIRIN TAB, EC GSLHG ol
Inscruceions: S1HG ORAL DAILY
Fig: TAKE ONE TAELET HOUTH EVERY DAY
Paciene Inscruccioms:

Scarc: 0
Days Supply: 30
Quancicy: 30
RPefills: 3

Pick Up: WINDOW |

[ Accent | Edt | Cancel

Figure 22-28: Sample New Order Dialog
You can do one of the following on this dialog:

If you click Accept, this means the order elements are the ones you want to use. If
you click Cancel, this will stop the Copy to New Order process.

If you click Edit, the order dialog will display. You can change the elements of
the order on this dialog. After you complete the edit process, click Accept Order.

5. You can sign the order now or wait until later. See Section 22.13.5 for more
information.
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22.10 Order Comments
This function allows you to add comments to an order. The comments appear on the
Order Details pop-up.
Make sure a patient is selected. Follow these steps to add order comments:
1. Select the order to which you want to add comments.
2. Select Action > Order Comments to display the Comments for Order dialog.
€. Comments for Drder
"ACE TAMINOPHEN SOLN ORAL 100MG/ML
GIVE 2.3MLS BY MOUTH EVERY 4 T0 6 HOURS FOR FEVER GREATER THAN
Comments:
I
[Tk ] caa |
Figure 22-29: Sample Comments for Order Dialog
3. Enter the comments in the Comments field. Please note that there is a right-click
menu to aid in editing the text. See Section A.2 for more information.
Click OK when the dialog is complete.
4. You can view the comments on the details for the order. (See the next section).
22.11 Order Details
You can view the details of an order that provides information about the order.
Follow these steps:
1. Select an order on the Orders window.
2. Select View > Details (or select Details on the right-click menu).
3. The Details dialog displays. The following shows the comments highlighted.
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€ Order Details - ST318%2 B
GIVE 2.3MLS BY MOUTH EVERY 4 TO & HOURS FOR FEVER GREATER THAN 101 al

uarticy: 15 Refiliz: 4

Actiwvity:
10002004 17:00 HMew Order sncered by DOCTOR . TEST (PHYSICIAN)
Order Text: ACETAMINOFHEN SOLM,ORAL
SEWISH AROUND I.3MLS BY MOUTH EVERY 4 TO & HOURS FOR
FEVER GREATER THAN 101 Rsfills: 4
Hature of Order: ELECTROMNICALLY ENTERED
Elac Signature: DOCTOR,TEST (PHVSICIAM) om 1070172004 17:0Z
L070LFZ004 47010 Changs sncersd by ADAMS ROBERT C
Changed to: ACETAMINOPHEN SOLM,ORAL 100HG/PL

GIVE Z.3MLS BY MOUTH EVERY 4 TO & HOURS FOR FEVER
GREATER THAN 101
Quancity: 15 Refills: 4

Hature of Order: SERVICE CORRECTION

Slgnaturs: SERVICE CORRECTION TO SICGNED ORDER

ard/Clinic Cumts: Take with

on. of water sach Cime.

Current Datm:
Treating Specialty:

Ordering Locatilon: 18 OFTORMETRY
Start Date Time: 100172004
Stop Date/Time: 10/0Z 2005
Current Status: ACTIVE

Orders that are active or have besn accepted by the service for processing.
®#.g., Discetic orders are active upon being ordered, Pharmacy orders are
active when the order is verified, Lab orders are active whean the sample
has been collected, Fadiology orders are active upon registracion.

Order #572183

Order:

Fledication: ACETAMINOPHEN S0LN,ORAL 100FG/ML
Trcrraerd mre - F ANTE ABAT A48H

<

Figure 22-30: Sample Order Details Pop-up

4. Note that you can print the text of the details by clicking Print.
dismiss the pop-up.

22.12 Results History

Follow these steps to view the results history of a lab order:

Select an order whose results you want to view.

The Order Results History pop-up displays.

A w o

You can print the text of the results by clicking Print.

22.13 Miscellaneous Ordering Features

Click Close to

Select View > Results History (or select Results History on the right-click menu).

Several convenience features are available to facilitate order entry and tracking:

e Alerting user when order results are available
e Flagging an Order

e Unflagging an Order

e Quitting an Order
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e Sign Selected

22.13.1 Alerting User when Order Results are Available

22.13.2

You can select a recipient to receive a notification when order results are available.

Note: A recipient must have the Flag Order For Clarification alert
set to ON in order to receive the alert. To set this, select
Tools > Options; use the Notification tab.

Follow these steps to notify a user when the results of an order are available:

1. Select an order.

2. Select Action > Alert when Results to display the “Alert when Results Available”
dialog.

& Alert when Results Available ' -0l x|

The following order will zend alerts when results are available:

RaST, GLUTEM ELOOD SERUM SF OMCE Indication: HYPERTEMSION LB #35

Alert Recipient:

Uszer.Dema j 0k, I Cancel

Figure 22-31: Sample Alert when Results Available Dialog

3. Choose an alert recipient from the Alert Recipient drop-down list.

4. Click OK.

Flagging an Order

You can flag an order to draw attention to it. When an order is flagged, the order will
appear on the Orders window with a red flag icon before the Service column. The
order will remain flagged until someone unflags the order. The application records
the name of the person who flagged the order and the date and time that it was
flagged. You can choose an alert recipient to receive a notification about the flagged
order.

Note: A recipient must have the Flag Order For Clarification alert
set to ON in order to receive the alert. To set this, select
Tools > Options; use the Notification tab.

Follow these steps to flag an order:
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1. Select the order that you would like to flag.

2. Select Action > Flag.

3. The Flag Order dialog displays.

€. Flag Order =] E3

SIMVASTATIMN TAR 20MG
TAKE OME TABLET BY MOUTH EVERY Dty
Quantity: 30 Refillz: 1

Reazon for Flag

[

Alert Recipient

I j | k. l Cancel

Figure 22-32: Sample Flag Order Dialog

4. Enter a reason for the flag in the Reason for Flag field. This field has a right-click
menu to aid in editing the text.

5. Choose an alert recipient from the Alert Recipient drop-down list, if necessary.
6. Click OK to complete the flagging process.

The corresponding order will now have a flag indicator:

w SIMVASTATIM TAR 20MG Start: 08/127/04 Dactar, T active
TAKE OME TABLET BY MOUTH EVERY | Stop: 08/11/05
DAY

(uantity: 30 Refills: 1

Figure 22-33: Sample Flagged Order on Orders Window

22.13.3 Unflagging an Order
It is easy to remove the flag from an order. You can enter a reason for removing the
flag, but this is not required.

In the Order Detail display for the unflagged order, the name of the person who
removed the flag and the date and time that it was removed is recorded.
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£ Order Details - 573200;1
=> TPE EJP

Lotivity:
100472004 16: 55 New Order entered by DOCTOR, TEST (PHYSICIAN)
Order Text: TPE ESP
Nature of Order: ELECTRONICALLY ENTERELD
Elec Signature:

04 09:34
Flagoged by: 0

o4 11

Tnflagged by:

Figure 22-34: Sample of Order Detail Showing Flag and Unflag Information
Follow these steps to unflag an order:

1. Select the flagged order you want to unflag.
2. Select Action > Unflag to display the Unflag Order dialog.

£ Unflag Order = =l

SIMVASTATIMN TAR 20MG
TAKE OME TABLET BY MOUTH EVYERY Dy
Guantity: 30 Refills: 1

FLAGGED: Oct 04, 2004¢516:46 by DOCTOR. TEST
reminder

Comment [optional]

k. I Cancel

Figure 22-35: Sample Unflag Order Dialog

3. Enter a comment, if desired. See Section A.2 for more information about editing
the text.

4. Click OK to complete the unflagging order process.

22.13.4 Quitting an Order

If you start an order (does not apply to Text Only order), complete the information
and then click Quit, the application displays the Unsaved Order information message.
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22.13.5

22.14

22.14.1

Unsaved Order |

€ ,  Accept the Following order:
-
S

17-HYDROEYPROGESTERCOKNE BLOOD SERUM SP 2
Yes I Mo

Figure 22-36: Sample Information Message After Clicking Quit

Click Yes to save the order and exit the order dialog. Click No to not save the
order and exit the order dialog.

Sign Selected

When you have an unsigned orders (appears in bold, blue lettering) on the Orders
window, you can sign it. Follow these steps:

1. Select an unsigned order on the Orders window.

2. Select Action > Sign Selected (or select Sign Selected on the right-click menu) to
display the Review/Sign Changes dialog. See Section 9.1 for completing the
dialog.

Quick Orders

Quick Orders are commonly placed orders with no special conditions. Many sites
create Quick Orders to help clinicians quickly place common orders. You can also
create personal quick Orders from the order dialogs themselves.

Types of Quick Orders

There are two types of quick orders: (1) site-wide quick orders and (2) personal quick
orders.

Site-wide Quick Orders

Many sites have created an entire set of Quick Orders that they use. The IRM staff at
each site can customize the Write Orders field with a selection that will bring up the
Quick Order menus they have created. This item might be called Assign New Orders,
Common Orders, or whatever the site deems appropriate. When a clinician clicks on
this item, EHR brings up the menu containing Quick Orders and other orders defined
by the site. Sites can set up orderables to be Quick Orders. See your Clinical
Applications Coordinator if you have items you want to have set up as site-wide
Quick Orders.

Personal Quick Orders
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You can create personal Quick Orders while in the base ordering dialog.

22.14.2 Creating Personal Quick Orders

Make sure a visit is selected for the current patient and that the current view is Active
orders.

Follow these steps to create a quick order.

1

2

. On the Orders window, select the type of order and complete the information
about the order on the particular dialog.

. Select Options > Save as Quick Order to display the Add Quick Order dialog.

& add Quick Order (Lab) =]

17 HYDROXYPROGESTERONE BLODD SERUM 5P

Entter the name that should be used for this quack order.

ﬂ

Comenon List for Lab

<MNew Quick Dider:

Figure 22-37: Sample Add Quick Order Dialog

3.

Enter the name of the quick order in the “Enter the name that should be used for
this quick order” field. This field has a right-click menu to aid in editing the text.
See Section A.2 for more information.

The name appears in the “Common List” field.

The edit features for the Common List field are discussed in Section 22.14.3for
more information.

Complete the Add Quick Order dialog.
Click OK to create the quick order.

You return to the order dialog.
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9. Click Accept Order on the order dialog.

10. You will find the quick order added to the order dialog the next time you access
that type of order.

11. The quick orders will appear before the list of available orders on the order
dialog. In the following example, “hydro-blood serum” is the quick order name.

Axailable Lab Testz

I
bdro-blood serim ﬂ

17 HYDRO=YPROGESTERO!
17 OHP <17-HYDROXYPROC
17-ALPHA HYDROXYFROGE!
17-HYDRO=YPROGESTEROE
17-NH <1 7-HY DR PR

Figure 22-38: Sample of Quick Order on Order Dialog

22.14.3 Editing the Common List

The common list contains the quick orders for a particular type of order. Follow these
steps:

1. On the Orders window, select the type of order for which you want to edit the
common list.

2. When the order dialog displays, select Options > Edit Common List to display the
“Edit Common Order List” dialog.

€ Edit Common Order List (Lab)

Common List for Lab

+
Fydreay-blood semum
Fpdro-bdood equm
[
Renam: |
Delete I

ok | cance |

Figure 22-39: Sample Edit Common Order List Dialog
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£ Rename =]

Fename Quick Order

You can arrange the quick orders listed in the “Common List” field by using the
up and down arrows.

If you want to rename a quick order in the Common List field, highlight the quick
order and then click Rename to display the Rename dialog.

| k. I Cancel |

Figure 22-40: Sample Rename Dialog for Quick Orders

5.

Enter the new name in the “Rename Quick Order” field. This field has a right-
click menu to aid in editing the text. See Section A.2 for more information.

Click OK to have the “new” name appear in the “Common List” field of the Edit
Common Order List dialog.

If you want to delete a quick order in the Common List field, select the quick
order and then click Delete to display the Remove Quick Order information
message.

Remove Quick Order |

@ Remove the Following quick order from wour list?

hrydro-blood serum

Figure 22-41: Sample Remove Quick Order Information Message

8.
9.

Click Yes to remove the quick order from the Common List field.

Finish the Edit Common Order List dialog as needed.

10. Click OK to accept your changes to the common list.

11. Your changes to Common List will appear on the order dialog next time you

select that particular type of order.
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22.15 Order Checking

Order Checking is based on a system of rules that review orders to see if they meet
defined criteria. If they meet the criteria, an electronic message is sent to the ordering
provider before the order is completed (such as duplicate order, drug-lab interaction,
etc.). The provider can then choose to cancel the order or override the order check
and place the order.

22.15.1 Prepackaged Order Checks

The Order Checking system lets users determine when order checks and notifications
are sent. To accomplish this, the application includes several prepackaged order
checks as well as three menus for setting Order Checking parameters such as enabling
and disabling specific order checks. Order Checks can also be configured to be
mandatory by the Clinical Applications Coordinator or IRM. If this feature is enabled,
individual order checks cannot be edited by the end users. Non-mandatory order
checks can be enabled or disabled through the Tools > Options menu.

Order checks exported with EHR

e ALLERGY-CONTRAST MEDIA INTERACTION

e ALLERGY-DRUG INTERACTION

e AMINOGLYCOSIDE ORDERED

e BIOCHEM ABNORMALITY FOR CONTRAST MEDIA
e CLOZAPINE APPROPRIATENESS

e CT & MRIPHYSICAL LIMITATIONS

e DRUG-DRUG INTERACTION

e DUPLICATE DRUG CLASS ORDER

e DUPLICATE DRUG ORDER

e DUPLICATE ORDER

e ESTIMATED CREATININE CLEARANCE

e GLUCOPHAGE-CONTRAST MEDIA

e LAB ORDER FREQ RESTRICTIONS

e MISSING LAB TESTS FOR ANGIOGRAM PROCEDURE
e ORDER CHECKING NOT AVAILABLE

e RECENT BARIUM STUDY

e RECENT ORAL CHOLECYSTOGRAM

e RENAL FUNCTIONS OVER AGE 65
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Note: All of these order checks are exported in the disabled state
at the system level. Sites can then turn them on for
individuals or teams, as determined by the site. Clinical
Application Coordinators, individuals, or services can also
disable individual order checks, if they so choose.

22.15.2 Personal Preferences for Order Checks

You can control what order checking you want to have executed for your orders. You
cannot turn off mandatory order checks, however.

Follow these steps to turn on or off order checks:

1. Select Tools > Options to display the Options dialog. Then click the Order

Checks tab.
Options HE

Notifcations [ Oider Checks | Teams | Notes | Repots |

Order Checks

o’ Enable or dizable pour oeder checks.
v

You can bum on or off these notifications except those that are mandatory.

Order Check | onsot | Comment | «
[ Allesgy-Condrast Media Interaction On
[ &llesgy-Diug Interaction On
B Aminoglycoside Ordesed On
Biochem Abnomality For Contrast. . On =
B CT & b Phwsical Limitations On
Clozapire Appropiateness On
[ Critical Dinug Intesaction On
[¥] Dizpence Dug Mot Selected On
Duplicate Diug Class Dides on
[¥] Duplicate Dmg Order On
[ Duplicaate Opicid Medications i =l

o J_omen |0 |

Figure 22-42: Order Checks Tab of Options Dialog

2. You can check or uncheck the various order checks, except for mandatory ones
(the word “Mandatory” will appear in the Comment column).

3. When the Options dialog is complete, click OK to dismiss it.

22.16 Printing an Order

You can print a selected order by selecting the Print option on the File menu.
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If necessary, you can set up the printer by selecting the Printer Setup option on the

File menu. See Section A.4 for more information.

Follow these setup to print a selected order:

1. Select File > Printer Setup to display the Print Orders dialog.

_inix|

One of mone of the lollowing prints are available for thes s=4 of orders.
Check thoze you desire and selact a device, if neceszary.

Grayed temz ate not avadable,
Print to device:
[~ ChatCopies |

Im Labels I

Figure 22-43: Print Orders Dialog

2. 'You need to check at least one checkbox in order to print.

g

Oine of maone of the following ponts are availabls for thes se8 of orders.
Check those you desire and selact a device, i necezzany.

Greyed itemz aie not avalable,

Print to device:

[ ChatCopies |

| I

Print All Checked lleme | Cancel Prirt

Figure 22-44: Print Orders Dialog with Checked Item

3. You can change the “Print to device” field by clicking the Change button.

The Printer Selection dialog displays.
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x
—Remote Prinbers 1
LASER 132 ;1
F-LABEL 96
VUECENTRIC TECH SUPFPORT 78

Copes: [1

Save as pow defeull printer [

Figure 22-45: Sample Printer Selection Dialog

Select a printer. If you need to change the setup for the selected printer, click the
Setup button.

If other setups are needed (after selecting your printer), click the Setup button to
display the Print Setup dialog. See Section A.4 for more information.

4. After the Printer Selection dialog is complete, click OK. (Otherwise, click
Cancel).

5. Click the Print All Checked Items button on the Print Orders dialog. The contents
of the (checked) orders output to the selected printer.

| Note: The Cancel Print button only closes the Print Orders dialog.
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23.0 Patient Education

The Patient Education component enables you to view, edit, delete and add Education
events for a patient.

23.1 Education Component

The Education component displays the current patient’s education events from the
RPMS. This information appears on the grid below the “Education” label. The
following fields are displayed for each Education record: Visit Date, Education
Topic, Comprehension, Status, Objectives, Comments, Provider, Education Length,
and Location of the Education.

ﬁ Education i/)| show Standard | &dd | Edit | Deleke
izit Date © |Eduu:atiu:un Topic | Comprehension | Status | Objectives «
03/0552007  Allergies-Mutrition OO0

01052007 Anemia-Dizease Process GOOD

05/22/2006  Diabetes Melitus-Dizeaze Proces:  GOOD

03/01/2006  Azthma-Exercise GOOD

12/16/2004 | Hypertension-Medications GOOD |
03/02/2004  Abdominal Pain-Medications GOOD

03/25/2000  Diabetes Mellitus-Exercise GOOD

EIEIH2EI£2EIEIEI Laboratorny-T estz | OO0 GOAL MET _ILI
1 3

Figure 23-1: Sample Education Component

You can sort the Patient Education information by clicking on a column heading. If
no Education information is present in the RPMS for a patient, the grid will be empty.

23.1.1 Functional Requirements

Operation Description

Add Click the Add button to select an education topic and then display the Add
Education dialog (except for selection by Pick List).

Edit Highlight an Education record and then click the Edit button to display the

Edit Education dialog. The application automatically populates this dialog
with the data from the selected Education record.

Delete Highlight an Education record and then click the Delete button to display a
confirmation asking if you want to delete the selected record. If you select
“Yes” the selected record will be removed from the RPMS.

Show Standard | Click this button to display the Standard and Desired Outcome Statement
for a selected Education record. You can print the information.

|£J Click this button to go to a Web site for a specified topic.
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23.1.2

23.2

The right-click menu on the Education component has the following options: Add
Patient Education, Edit Patient Education, and Delete Patient Education. These
options do the same thing as clicking the Add, Edit, and Delete buttons (respectively).

Business Rules

Rule Description

Security Keys In order to add, edit or delete an Education record you must be
assigned the PROVIDER key and cannot hold the BGOZ
VIEW ONLY key.

Deleting Education Events | In order to delete an education event you must either have
entered it or be the primary provider, and the visit cannot have
been billed or exported.

The Patient Education component can be configured so that a user or class cannot
add/edit patient education information.

Web Reference Search

The Web Reference Search for the Patient Education component depends on if any
records are present or not.

Condition 1: If there are records present, select one and click the V] putton (or select
the Web Reference option on the right-click menu) to go to the UpToDate Reference
Web site for the topic associated with the selected record. You can change to another
Web site by selecting from the Reference Site drop-down list (on the Web site).

Condition 2: If there are no records present, click the L V] putton (or select the Web
Reference option on the right-click menu) to display the Web Reference Search
dialog.

i, Web Reference Search x|

Reference Site: I UpToDate j

Search Term:| Search

Figure 23-2: Web Reference Search Dialog

Select a Reference Site, if needed; the default is the UpToDate site. After entering a
term and clicking Search, you go to the selected Web site for the specified term. You
can change to another Web site by selecting from the Reference Site drop-down list
(on the Web site).
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23.3 Education Topic Selection

To add an Education record, you must first select an education topic. The selection
can be done using one of five different selection dialogs by either clicking on one of
the icon buttons or enabling one of the radio buttons.

Many of the selection dialogs have the Display Outcome & Standard button. After
selecting a topic and clicking the button, the outcome and standard for the selected
education topic displays.

23.3.1 Selection by Category List

To select the Education Topic using the by Category List (f&b method, you must
expand the category of interest to display its associated education topics and then
either double-click on the desired entry or select it and click the Select button.

5
Bl @142
Select By + CategonyList ¢ Dizease & TopcEnty Pick List

" MName Lockup  Piocadure & Topic Entry

| ltems [~ Selact
: ABDOMINAL PAIN

ADMINIS TRATIVE FUNCTIONS
; ADMISSION TO HOSPITAL Lancel
| ADVANCE DIRECTIVES

Alcohol and Other Drugs
| ALLERGIES
| ALZHEIMERS DISEASE

ANEMIA

ANESTHESIA

COMPLICATIONS

EQUIFMEMT

FOLLOW-UP

INCEMTIVE SPIROMETREY

INTUBATION

LITERATURE

PAIN MANAGEMEMT

FOSTOPERATIVE

FREOPERATIVE .

PROCEDURES e

TURN, COUGH, DEEF BREATH | | Standad

N FEBRARAPERERMEAHRE

Figure 23-3: Selecting Education Topic by Category List

After clicking Select, the Add Patient Education Event dialog displays.

23.3.2 Selection by Name Lookup

To select the Education Topic using the Name Lookup (ﬁb method, select an entry
by either double-clicking the education topic entry in the list or highlighting the topic
and clicking Select.
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To access an entry, you can either manually scroll the list or add the first few
characters of its name to reposition the scroll list. Highlight the desired name.

& Education Topic Selection |
LEPEL IPANE
SelectBy: (~ Categoylist  DiseasedTopicEnty Pick List

= Name Lockup (~ Procedure & Topic Entry

jal Select
Alcabed And Dther L—'-ll_Jg'j'::-I: |:.||.|:.! - ANORE
Alcohol fnd Other Drugs-Contiren 0f Care =l Carael
Alcobol And Other Drugs-Culural/ spintual Aspects OF Health

Aleokol And Other Drugs-Disease Process

Alcohol fnd Other Drugs-Exercize

Abcohol And Other Drugs-Lileside Adaptations

Aleoked And Other Drugs-edical Mulsition Therapy

Alcohol And Other Drugs-Medications:

Alcohol And Other Drugs-Nutrition

Alcobol And Other Drugs-Patent Infarmation Litersture

Aleokod And Other Dirugs-FPlacement

Alcobol And Other Drugs-Prevention

Alcohol And Other Drugs-Soneening

Aleohed And Other Drugs-Siress Management

Alcokol And Other Drugs-Tests

Alcohol And Other Drugs-wellness

Allerges-Digeaze Process

AllergeesFollow-up Diisplay
AllergesLitestyle Adsphons x Digeome &
| | » Standmd

Figure 23-4: Selecting Education Topic by Name Lookup

After clicking Select, the Add Patient Education Event dialog displays.

23.3.3 Selection by Disease and Topic Entry

To select the Education Topic using the Disease and Topic Entry (ﬂ) method, you
must select both a Diagnosis code and a corresponding topic and then click the OK
button.

You can select the diagnosis from an ICD table lookup or pick the purpose of visit
(POV) for the current encounter if it has been entered yet.
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. Education Topic Selection i x|
E|2I8N2
Select Byt ( CategomyList  + Diseasedh TopicEnty ¢ Pick List
i Mame Lockup  Procadure & Topic Entry

Enter both the Disease/Conditionflliness and oK
the Topic for the Education activity.

Digease/Tondtioniness Selection: Cancel
Disease/lness | E
POV

Topic Sedection

AMATOMY AND PHYSIOLOGY “
COMPLICATIONS

DISEASE PROCESS

EQUIPMENT

EXERCISE

FOLLOW LIP

HOME MANAGEMENT

HGIEME

LIFESTYLE ADAPTATION

PATIENT INFORMATION LITERATURE
MEDICATIONS

MUTRITION =

Figure 23-5: Selecting Education Topic by Diagnosis and Topic Entry
Follow these steps to complete the Education Topic Selection dialog:

1. The Disease/lllness field can be populated in one of two methods:

Method 1: Select the information in the POV field; the information will populate
the Disease/llIness field.

Method 2: Click the = button by the Disease/llIness field to display the Diagnosis
Lookup dialog. See Section A.1.9 for more information.

Select one of the items on the lookup dialog and click OK to have the selected
item added to the Disease/llIness field on the Education Topic Selection dialog.

2. Select an item from the Topic Selection field and click OK.

After clicking OK, the Add Patient Education Event dialog displays.

23.3.4 Selection by Procedure and Topic Entry

To select the Education Topic using the Procedure & Topic Entry (ﬁ) method, you
must enter both a CPT code and the corresponding topic and then click OK.
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k3|
k|| @142

Select Bu: ( Category List ¢ Dizeaseh TopicEntyy Pick List
™ Mame Lockup (' Procedure & Topic Entry

Enter both the CPT Service and the Topic for oK
the Education activiby. — ||

[~ Serace Selechion: T Cancel

cer| Ellk=——

Wish Services

Topic Selection

AMATOMYT AND PHYSIOLOGY “
COMPLICATIONS 0
DISEASE PROCESS

EQUIPMEMT

EXERCISE

FOLLOW LIP

HOME MANAGEMENT

HYGIEHE

LIFESTYLE ADAPTATION

PATIENT INFORMATION LITERATURE
MEDICATIONS

NUTRITION hd

Figure 23-6: Selecting Education Topic by Procedure & Topic Entry
Follow these steps to complete the Education Topic Selection dialog:

1. The CPT field can be populated in one of two methods:

Method 1: Select the information in the Visit Services field; this information will
populate the CPT field.

Method 2: Click the = button by the CPT field to display the Procedure Lookup
dialog. See Section A.1.8 for more information.

Select one of the items on the lookup dialog and click OK to have the selected
item added to the CPT field on the Education Topic Selection dialog.

2. Select a topic in the Topic Selection field and click OK. After clicking OK, the
Add Patient Education Event dialog displays.

23.3.5 Selection by Pick List

To select the Education Topic using the Pick List (@) method, you select one or
more options from a Pick List.

One of two conditions are possible: (1) the Pick List field is populated or (2) the Pick
List field is empty.
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Populated Pick List

5
B 2| @ 2| 1703 iems
Select By ¢ Categorp Lt  Disease & Topic Enfry {* Pick Lest
" Mame Lookup (" Procedurs & Topic Entiy

Pick Lists _|[Diabetes Educaion =] ok |
[1 Diabetes Melbtus-Compbeations C |
[ Disbetes Melitus-Diseaze Process -

"] Disbetes Mellbus-Foot Cae

[] Disbetes Melbtus-Lifectdes Adaptabons
] Deabetes Melbius-Nulrition

[[] Disbetes Mebtus-Preverton

Tvpe of Training + Indwidual ¢ Gioup
Comprehension Leyel [GOOD |

Length i [rmini]

Figure 23-7: Populated Pick List Selection Method

The education category is displayed in the drop-down list next to the Pick Lists
button. If there is more than one category, select one. In the above example, the
education category is Diabetes Education.

You can check one or more items from the displayed Pick List.

Select the Type of Training, Comprehension Level, and length of time (in whole
numbers) that specifies the number of minutes for the education. If you select more
than one education topic, the Length of time is divided equally amongst the topics.

Click OK to add those items to the Education grid.
Empty Pick List

When the selection dialog is empty, you need to create a pick list.
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EETTT—
EECEE

Select By ( CategoryList " Dicease & Topsc Enbyy & Pick List
" Name Lockup  Piocedure & Topic Entry

_ Pektits | T SOE

Type of Training: * Indiidual ™ Group
Comprehension Leyst [G00D =]

Lengtht [ (min)

Figure 23-8: Selecting Education Topic by Pick List

Follow these steps to create a new Pick List.

1. Click the Pick Lists button to display the Manage Education Quick Picks dialog.

w. Manage Ediucation l_1|:|||:|-! Picks ﬂ
Education Topic BickLists: | Disbetes Education *|  EdtPickLing
DIA-PATIENT INFORMATION LITERATURE Add
DM-COMPLICATIONS Raname
DM-FOLLOMW UP B ——
PT-TREATMENT Delete
Copy
sy
e Freq.
Impot
Expail
Figure 23-9: Sample Manage Education Quick Picks
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2. Click the Edit PickLists button to display the Manage Categories dialog.

w, Manage Categories ] -El

Figure 23-10: Manage Categories Dialog

3. Click the Add button to display the Add Category dialog.

x|
Category Hams: | LLI
_ Comcel |

Hesp. Location: |
Cliie: |
Brovider |

Prov, Discipine |

b Ll

Managers;

_Add |
nm|

Figure 23-11: Add Category Dialog
4. Populate the Category Name.
5. You need to choose how the pick list will display from the methods listed below.

If you do not select a display method, the pick list will be available to all users in all
locations.

Hospital Location The pick list will be available to anyone who is in the selected
hospital location.

Clinic The pick list will be available to anyone who is in the selected the
clinic.
Provider The pick list will be available to the selected provider.
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Clinic The pick list will be available to anyone who is in the selected the
clinic.

Provider Discipline | The pick list will be available to anyone who is in the selected provider
discipline.

6. To prevent other users from editing your pick list, add your name, and any other
user allowed to edit your menu (in the Managers field).

7. Click OK when complete.
8. You need to add education codes to the pick list category after its creation.

9. On the Manage Education Quick Pick dialog, choose your pick list category from
the Education Topic Pick Lists field.

w, Manage Ediucation b k Picks

Figure 23-12: Manage Education Quick Picks Dialog with no Pick Lists

10. Click the Add button and search for the code on the lookup utility. Select an
education code you would like to add and click OK. The education codes will be
added to the pick list. Repeat this step as needed to add more codes
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w. Manage Education Quick Picks ,.E.I

Education Topic BickLists: | Disbetes Education x| EdtPickliss

EdnaﬁanﬁnP‘bkuulm

| 15 PELIFIELD-MEDILATIUMNS
DIAPATIENT INFORMATION LITERATURE R
DM-COMPLICATIONS Rename
DM-FOLLOW UP —
PT-TREATMENT Delste

Zemo Freg.

Export

Figure 23-13: Manage Education Quick Picks with Pick Lists

Additional options can help you manage the pick list.

Button Meaning

Rename Highlight the education code you want to rename and click the Rename
button. A window will open enabling you to rename the education code.
Note: renaming the code does not result in changing the way the
education code is documented.

Delete Highlight the education code you want to remove from the pick list and
click the Delete button.

Copy Click the Copy button to copy education codes from another menu to your
new pick list.

Query Click the Query button to list the most commonly used patient education

codes used by a provider or a clinic.

Zero Frequency

Every time you use an education code, the frequency is recorded and
displayed on the pick list. This function will reset the frequency for all of
the education codes.

Import This button is used to import an education code pick list from another
user.
Export This button is used to export an education code pick list to your desktop

computer. This file can be shared with other EHR users.

11. Completing the Education Topic Selection dialog:
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L3

m, Education Topic Selection

&l 61N

Select Buc  Category List " Diceased Topc Enty % Pick List
{~ Mame Lockup (" Procedure & Topic Entry

Pick Lists; ‘Ill'_'ltahere: Education j Ok

Azthima, Unspecihed Meadicabon:
| Dia-Patert Information Literabue Cancel
[7] De-Complications
Divr-Follow Up
] Pr-Treatment

Type of Tianing. = Indadusl Group
Comprehension Leyet |EODD j

Lengh[  min)

Figure 23-14: Education Topic Selection Dialog to Complete

Select one or more options in the field below the Pick Lists button. Select the
Type of Training, Comprehension Level, and length of time (in whole numbers)
that specifies the number of minutes for the education. If you select more than one
education topic, the Length of time is divided equally amongst the topics.

Click OK to have the selected items populate the Education component.

23.4  Adding an Education Event

After selecting an education topic, you can add either new or historical Patient
Education events:

e New Patient Education are those that are given for a current visit

e Historical Patient Education are those that were given in the past and are typically
would be for an outside facility or place

It’s important to note that for non-historic visits, the date and location of the
Education must correspond to the currently selected encounter in the EHR (which can
be for past dates).

In order to add an Education record you must be assigned the PROVIDER key and
cannot hold the BGOZ VIEW ONLY key.
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.-f:.:fi- dd Patient Education Event I ﬂ

[Education Topic [Mhmu-l?ﬁcase Process ;I

(rsb)
Cancel

Iype of Training & Individual ¢ Group

Comprehension Level
Length {nin} ™ Historical
Comment Display
Cuwboonme B
Standard
Provided By [TETER, SHIRLEY l|
Stabus/Outcome ims Learning Health |

" GoalSet " GoalMet ( GoalNotMet ‘

Figure 23-15: Add Patient Education Event Dialog

In conjunction with adding education event information, you can add health factor
information as well as a refusal for a selected topic.

The following information is divided into three parts: (1) Completing the Patient
Education Information, (2) Entering Historical Patient Education Information, (3)
Completing the Health Factors and Refusal Information.

23.4.1 Completing the Patient Education Information
Follow these steps to complete the Add Patient Education Event dialog for the current
visit:
1. Select the type of training, if needed.

2. The default for the Comprehension Level is Good and should be changed
accordingly, along with the Provided By field, if necessary.

The patient’s Comprehension Level (also called Level of Understanding) can be
classified as the following:

e Good (examples: verbalizes understanding; able to return demonstration or
teach-back correctly)

o Fair (examples: verbalizes need for more education; incomplete return
demonstration or teach-back indicates partial understanding)

e Poor (examples: does not verbalize understanding; unable to return
demonstration or teach-back)

e Group — No Assessment (examples: education provided in group; unable to
evaluate individual response)

e Refused
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You can add a comment to the patient education code that provides further
description of the encounter. Comments can be used for describing the name of a
lesson plan or education material provided to the patient (limited to 100
characters). The Comment field has a right-click menu to aid in editing the text.
See Section A.2 for more information.

If another provider is needed for the Provided By field, click the = button to
select from a lookup utility.

Goals are optional for the patient education documentation. Goals can be
documented as Goal Set, Goal Met, or Goal Not Met. The free-text field in the
Status/ Outcome group box is limited to 20 characters (that describes something
about the goal).

Click Display Outcome & Standard to display the Outcome and Standard
statement for the displayed education topic, if needed.

When the Add Patient Education Event dialog is complete, click Add to have the
education topic added to the Education component. (Otherwise, click Cancel.)

23.4.2 Entering Historic Patient Education

When you check the Historical checkbox on the Add Patient Education dialog, the
Historical group box is added to the dialog.

Another way to enter the historical patient education event is to have NO visit
selected and click the Add button. The Add Patient Education Event with the
Historical checkbox checked will display.

The historical record contains the Historical group box.
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&% ndd patient Education Event ~ x|
Education Topic E-ﬁﬂhma{iutase Process ;l
(hcbra)
Type of Training ¢ Indevidual " Group Cancel
Comprehension Level [6000 |
Length [ (i) [+ Historical
Comment \ Display
Outcome &
Standard
Provided By [TETER,SHIRLEY _.J
StatusjOutcoms - :::1;&;5 Learning Health

(" GoalSst ( GoalMet ( GoalNot Mat ‘

Event Dats | -]
Location I ;I

i Faciliy " Other

Figure 23-16: Historical Patient Education Event
The Event Date and Location determine the date and location of the education event.

The Event Date must be a past date. Either manually enter it or click the ellipsis (=)
button to display a calendar from which to select a date.

The Location can be either an IHS Facility or Other (at another facility or office). If
you enable the Facility radio button, you can enter a valid IHS Facility name or click
the =] button to display a lookup utility from which to select one. If the manually-
entered facility name is not a valid one, the EHR displays the lookup utility. See
Section A.1.2 for more information.

If your site has been configured with a default outside location, type OTHER in the
Location field. Then when you display the View Visit Detail pop-up, the default
outside location will display at the LOC. OF ENCOUNTER field.

If you enable Other, you can enter the name of another place or office where the
education event took place (like Dr. Brown’s Office).

You complete the fields in the other parts of the dialog like you do when entering a
non-historical education event.
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23.4.3 Completing the Health Factors and Refusal Information

This part of the Patient Education dialog is optional. By clicking the Patient’s
Learning Health Factors button, you can add health factors information for the
selected patient.

This information is divided into two parts: (a) completing the health factors
information and (b) completing the refusal information.

Follow these steps to complete the health factors information:

1. Click the Patient’s Learning Health Factors button on the Patient Education dialog
to display the Add Health Factor and Add Refusal dialog.

B2 BARRIERS TD LEARNING
# LEARMING PREFEREMNCE
# READINESS TO LEARN

Figure 23-17: Add Health Factor and Add Refusal Dialog

23.4.3.1 Add Health Factor Tab

2. 'You need to expand one of the Items in order to select a health factor under that
item.
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N x|

Add Health Factor | Add Refusal ] o
Ibemrs b—
BARRIERS TD LEARNING
# LEARMING PREFEREMCE Cancel

= READINESS TO LEARMN
READINESS TO LEARM-NOT READY
READINESS TO LEARM-PAIN
READINESS TO LEARN-RECEFTIVE
READINESS TO LEARN-SEVERITY OF ILLMESS
READINESS T0O LEARM-UNRECEPTIVE

Ot

Figure 23-18: Expanded Item for Particular Health Factor

3. Highlight the particular health factor and click Add.

This adds the particular health factor to the Health Factor component and it
displays in the Patient’s Learning Health Factors field on the Add/Edit Patient
Education dialog.

23.4.3.2 Add Refusal Tab
1. Make sure you are on the Add Refusal tab to add a refusal.

I x|
Add Heath Factor I Add Refusal = I
Refusal Type ([ ] Education Topic || Measuemsent
[ EKG (] Medication/Dug Cancel |
v I | PP Smear
1 Imemurazation ] Radbology Exam
[JLab (] Skin Test
[ Marmamogram
Exam [CHEST ExXaM =]
Date Refused [04/10/2007 =l

Comment

Figure 23-19: Add Refusal Tab
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Do not use the Education Topic refusal type. This method does not record the
refusal for patient education correctly. See Section 23.4.4 on how to correctly
enter a patient education refusal.

2. You can check any of the checkboxes (only one) in the Refusal Type field. The
label for the second field will reflect what is checked in the Refusal Type field.
See Section 26.4 for more information about entering a refusal.

3. The Comment field is a free-text field that contains a right-click menu to help you
in editing the entered text. See Section A.2 for more information.

4. After you complete this dialog, click Add to have the information added to the
patient refusal file.

It shows up in the Personal Health component under refusals (it does not display
in the Patient’s Learning Health Factors field on the Add/Edit Patient Education
dialog).

23.4.4 Entering a Patient Education Refusal
Follow these steps to add a patient education refusal:

1. Use the Disease and Topic method of selecting a disease and topic on the
Education Topic Selection dialog.

2. Click the =] button to search for a Disease/llIness. The Diagnosis Lookup dialog
displays. Search for refusal in the Search Value field.

Lookup Optiorc  Lesicon % ICD
Search Vahse [refus Search
Select from one of the following tems:
Code | Diagnosis |

36968  Profnd Impair/near Mom

VB4 05 Vacoin Noddmm Refuse Caregr
VE4.0E Vaccr Mo Adrm Refuze Patient
VB4 08 Vaccn Noddmin Refuse Patient

[ Rehun Search Text as Manative ok I Lancel

Figure 23-20: Diagnosis Lookup for Refusal of Treatment
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3. Select the Refusal Of Treatment diagnosis and click OK. (Do not check the
“Return Search Text as Narrative” checkbox.)

4. The diagnosis is added to the Education Topic Selection dialog.

5
SelectBy  CategornyList  + Disease & Topic Entry " Pick List
" Mama Lookup (" Procedure & Topic Entiy

Enter both the Disease/Conditionflliness and 114 |
the Topic for the Education activity.

- Dissasa/Condiion/linass 5siackion Cancel |
Qhauaﬂimlﬁﬂusa Of Treaiment E
20

[~ Topic Selection

ANATOMY AND PHYSIOLOGT =
COMPLICATIONS

DISEASE PROCESS

EQUIFMENT

EXERCISE

FOLLOW LP

HOME MANAGEMENT

HYGIENE

LIFESTYLE ADAPTATION

PATIENT INFORMATION LITERATURE
MEDICATIONS

NUTRITION =l

Figure 23-21: Refusal of Treatment Added to Education Topic Selection Dialog

5. Select a topic from the Topic Selection field and click OK.

6. This diagnosis is added to the Add Patient Education Event dialog.
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&% ndd patient Education Event

[ = R el e usal OF Tresbment-Exercice
{Refusal OF Treatment)
Ivpe of Training  (F Incividual
Comprehension Leyel [cocD
teogth [ (i)
Comment |

™ Group

Provided By [LUSER, DEMO

= Stabus/Outcoms
‘ ~ GoalSet (" GoalMet (~ Goal Not Met
(§

Figure 23-22: Refusal Of Treatment Added to Add Patient Education Event

7. Complete this dialog and click Add to have this saved on the Patient Education
component. (Otherwise, click Cancel).

23.5 Editing an Education Event
In order to edit an Education record you must be assigned the PROVIDER key and
cannot hold the BGOZ VIEW ONLY key.
Make sure a visit is selected. Follow these steps to edit an education event:
1. Select an Education Event you want to edit.
2. Click the Edit button (or select Edit Patient Education on the right-click menu) to
display the Edit Patient Education Incident dialog.
.-f-.--ﬁdit. Patient Education Incident x|
Education Topic [Abdarminal Pain-Fallow-Up ;|
{Abdominal Pain)
Type of Training & Individual Group Cancel |
Comprehension Level BRI - |
kength [ (min) I istarica
Comment I Display
Cukocime &
Provided By [LSER, DEMO :_|
— Status/Cutcome 2 Em-t;s Learning Health
 GoalSet ™ GoalMet (= Goal Not Met
Figure 23-23: Sample Edit Patient Education Incident Dialog
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23.6

23.7

3. See Section 23.3 for information about how to select another education topic for
the Education Topic field.

4. You can update all of the data fields of the original education event. See Section
23.4 for completing the dialog.

If the selected record is an historical patient education event, you cannot change
the event date or place (in the Historical group box).

5. When the Edit Patient Education Event dialog is complete, click Save to update
the education topic in the Education component. (Otherwise, click Cancel.)

Deleting an Education Event

In order to delete an Education record you must be assigned the PROVIDER key and
cannot hold the BGOZ VIEW ONLY Kkey.

Note: Any Health Factor/Refusal information entered for the
selected education event is NOT removed by the Delete
function.

Make sure a visit is selected. Follow these steps to delete an education event:

1. Select an Education Event you want to delete.

2. Click Delete (or select Delete Patient Education on the right-click menu) to dis-
play the “Remove Patient Education?” information message.

Remove Patient Education?

Figure 23-24: Delete an Education Event Information Message

3. Click Yes to delete the selected record. (Otherwise, click No.)

Outcome and Standard Statement

You can display and print the Outcome and Standard Statement for a selected
education event by clicking the Show Standard button (or by selecting Show Standard
on the right-click menu) on the Education component. The same thing happens when
you click the Display Outcome & Standard button on the Education Topic Selection
dialog and on the Add/Edit Patient Education dialogs.
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i
HYPERTENSION-MEDICATIONS =]
OUTCOME :

If on medication, the patient will verbally summarize their medication
regimen and the importance of full participation with therapy.

STANDARD :

1. Review proper use, benefics and common side effects of prescribed
medications.

2. Explain the imporcance of avoiding over-the-counter medications
without checking with a physician.

. off

Fork [T g2 Pint. |  Ciose |

Size;

Figure 23-25: Example of Outcome and Standard Statement

The Standard pop-up contains the outcome and standards for a selected education
topic.

Click Close to dismiss the pop-up.

You can change the font size of the text displayed in this pop-up by adjusting the size
in the Font Size field (enter manually or use the up and down arrows). Note that this
does not change the size of the text on the output (when you print).

Click Print to choose a printer and to output the (entire) contents of this pop-up to the
specified printer. Note that the Print button might be there; it is according to how your
application is configured.

The Standard pop-up has a right-click menu where you can copy selected text and
paste it into any free-text field within the EHR or into another application (like MS
Word). See “Right-Click Menu to Edit Text” on page 365 for more information.

23.8 Display Visit Detalil

The Education component has the “Display Visit Detail” option on the right-click
menu. Use this option to display the Visit Detail pop-up for a selected record. See
Section A.2 for more information.
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24.0 Patient Postings

Pazting

Click the Postings button _&_|to display the Patient Postings pop-up.

€€ patient Postings

Allergies Severity Signg 4 Symptams
Lizinoprl Coughing
Acetaminophen Drermatitiz

Criziz Motes, "Warning Maotes, Directives

&LLERGIES
CRISIS NOTE 20-0ct-2004 10:44

Figure 24-1: Sample Patient Postings Pop-up

If you click an item in the Allergies field, you get a pop-up with information about

the selected allergy. You can print the information by clicking Print.

¥ Lisinopril Coughing

Observed/Historical:Historical

]
Eli:lzr:: I 95‘ Print....

Cauzative agent: LISTHNOPRIL —
Signs/symptons: COTGHING

Drug Classes: ACE IMNHIBITORS
Originated: DOCTOR, TEST PHYSICIAN
WVerified: Hao

o

Cloze |

Figure 24-2: Sample Information About the Selected Allergy
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If you click an item in the Crisis Notes, Warning Notes, Directives field, you get a
pop-up with information about the selected note. You can print the information by
clicking Print.

€ CRISIS NOTE 20-0ct-2004 10:44

TITLE: CRI3I3 NOTE —
DATE OF NOTE: OCT 20, Z004E10:44 ENTEY DATE: OCT 20, 2004@10:45:36
AUTHOFR: DOCTOR,TE3T EXP CO3IGNER:
URGENCY: JTATS: COMPLETED

This is crisis note

Jea/ TEST DOCTOR
MEDICAL RECOFD ADMIN
Figned: 1072072004 10:45

" o

Eli:lzr;t: I@ Print... | Close |

Figure 24-3: Sample Information About the Selected Note

Pozting

The Posting button L_42 | can have one or more codes on it. The following table
describes the meaning of these codes.

Code | Meaning

A There are allergies present.

C There are Crisis Notes present.

D There are Directive Notes present.
W There are Clinical Warnings present.

The codes for crisis notes, directive notes, and clinical warnings come from the title
of the note when the clinician entered the progress note. For example, you can select
the title “Crisis Note” to enter a progress note classified as a Crisis Note.
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Progress Mote Properties )

Progress Mote Tite: |EEIEIERAEANS | ok |

CRI5IS <CRISIS MOTE: Cancel |

" <CLIMICAL WaRMNIMNG:
DELETED <DELETED PROGRESS WOTE:

DELETED PROGRESS MOTE

DIABETES «<DIABETES PROGRAM MOTE:

CIABETES PROGRAM WOTE ﬂ

Date/Time of Maote; IDS-ND\-‘-EDD# 14:33 _I

Athor: ID::u:tu:ur,T est ;l

Figure 24-4: Selecting Title for Crisis Note
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25.0 Patient Selection
The Patient Identification Header component shows the current patient’s name,
hospital number (SSN or HRN), date of birth, age and gender.
*Littlewolf_Peggy LYMH
2184 20-Mar-1938 (BE)
Figure 25-1: Sample Patient Identification Header
Most functions in the EHR require that a patient be selected. This component can be
configured so that the last patient selected will be the current patient once you re-
enter the EHR; see your Clinical Applications Coordinator about this functionality.
25.1 Patient Selection Dialog
Clicking on the patient identification header or selecting Patient > Select displays the
Patient Selection dialog.
patient Selection |
Pabient Lists [ D emographacs
o . *Littlewolf_Jusnila K
e ol S
" Speciakies o
. Qs Dacano e e T
o ol Latx LitlewollJuaria K PR T
“Litthewwcll Paggy LYMH
"Aadeshon e Aladine
"Aadeshuise Cahan Gers
:Flsch:shw;l:.J arnes Lavwence
erariosogtor oo Posirt Deta
“Hideshouze Foberd W
“Standsorverbull Brett T,
Aapan Wicios Curtis
Abbey Areah
Abbey Brent
dbbotle Saflkanm ) smes
b Lyridon Paul
Abe. Tyzon Edward
Abefta Lynette .
Abeila,Shely
| EE:.B.!CEE&WIG
bl lra Pichard
| Abe Jarnes L
Abel Krster Hope
ﬁ-b-:l.;‘;:rlzn!.:rﬁu
Al ales
et g ] oo
Figure 25-2: Sample Patient Selection Dialog
This dialog is divided into three group boxes labeled Patient Lists, Patients, and
Demographics (from left to right).
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25.1.1 Patients Group Box

25.1.1.1

25.1.1.2

The Patients group box contains a list of patients from which you can select one. This

list has two parts separated by a horizontal line.

Demao By
TestJohn

Test Inpatient M
Demo,Tesn

DemoBoyp
Derno,F ather
DemoFemale A
Demo Inpatient F
Do Mothe: R
Demo, Tesn
Do, Toddler
Patient Demo
Patient, Sercitive
Test, John
TestInpatient M
TestJohn

Tl Patient &
Test Patiert B
Test Patiest C
Test Patert D
Test Pabert E
Test Pabert F
Test,Pabent G

Figure 25-3: Sample Patients Panel

Short List and Long List

The top part, known as the short list, changes according to the list type selected in the
Patient Lists group box. The bottom part, the long list, represents a list of all patients

registered to the site to which the user is connected.

You can preview a patient by single-clicking an entry from either the short or long
list. The patient’s information is presented in the Demographics group box. To make
the highlighted patient the active patient, either double-click the highlighted name or

click OK.

Patient Identifier

In addition to selecting a patient from the list, you can type a patient identifier into the
lookup text box at the top of the Patients group box. Valid identifiers are the patient’s
name (last, first), hospital number (SSN or HRN), Last+4 (first initial of last
name-+last 4 digits of the SSN), birthday, and potentially other lookup identifiers set
up for your site. Typing an identifier followed by a short pause will cause all
matching entries to be displayed in the short list (or for patient names, the list scrolls

to the first matching entry).
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Patient Name Must be entered as LAST,FIRST (note - no space between last and first
name.

Chart numbers | Must be at least four characters in length. If the chart number < four
characters, add preceding zeros. Example, chart number 32 should be
entered as 0032.

Birthdays Must be in the format: BMMDDYY. For example, a birthday of March 4,
1982 would be entered into the EHR as: B030482 - B for birthday, 03 for
March, 04 for the fourth day, and 82 for the year 1982.

25.1.2 Demographics Group Box

The Demographics Group Box, located on the right of the Patient group box, shows
information about the currently highlighted patient. A red font color indicates that this
is also the currently active patient. For all other patients, the font color will be black.

25.1.3 Patient Detail Button

Clicking Patient Detail presents the patient detail view, as shown below. Because this
view is site-customizable, its contents might differ significantly from what is shown
here.
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~loix|
iTES'T.,PﬁTIEHT & TTE8-65-4321 OCT 12,1948 -
COORDINATING MASTER OF RECORD: NOT LISTED
Address: 590 CHERRY TREE LANE Temporary: N0 TEMPORARY ADDRESS
TUOL5A, 0K 77676
County: UNSPECIFIED From/To: NOT APPLICABLE
Phone: 803 443-4567 Fhone: HOT APPLICABLE

Office: UNSPECIFIED
Ead Addr:

Confidential Address: Confidential Address Categories:

N0 CONFIDENTIAL ADDRESS
From/To: NOT APPLICABLE

PO5: UNSPECIFIED Claim #: UNSPECIFIED
Relig: CATHOLIC Bex: MALE
Race: THANSWERED Ethnicicy: UNANSWERED

Primary Eligibilitcy: UNSPECIFIED

Other Eligibilities:

Jratus : PATIENT HAS N0 INPATIENT OF LODGER ACTIVITY IN THE COMPUTER
Future Appointments: NONE

Femarks:

Jervice Connection/Rated Disabilities:

Service Connected: NO

Rated Dizabilities: NOT A VETERAN =||
| »
Font .

Size: | Pirt. |  Close |

Figure 25-4: Sample Patient Detail Pop-up

See Section A.3 to review how to use the controls on this pop-up.

25.2 Patient Lists Group Box
The Patient Lists group box provides radio buttons to indicate the categories with
which patients are associated. For example, the Provider radio button would display
those patient lists associated with a particular provider.
These radio buttons are a means of filtering the patient lists. You can select of one of
several types of patient lists. The available entries depend upon how your site is
configured. Some list types can be disabled or site-specific custom lists might be
present.

25.2.1 Al
The patient list entitled “All” is always available. This list includes all patients
registered to the facility to which you are connected. If the “All” list type is selected,
the short list represents a history list of the most recently selected patients.
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25.2.2 Other Entity Types

25.2.3

Selecting any other list causes a list of entries to appear below the radio buttons.
These entries are specific to the selected entity type. For example, the following
graphic shows that the user has selected the “Wards” type which in turn presents a list

of selectable wards.

Patient Lists 1 (- Patients [General)
[ = |Dem.Father
~ ﬂ .:sl Demo.Inpatient F
~ Ieumlm Test Inpateent M
; Specialies
Chnics
& \Wads . Demo Bo
? i.m Lists Demo,Famale &
|| || Deme.Irpatient F
s feruees
[T - | | 0o, Todder
liews Patient Demo
Murzerny Patient, Sencive
Ob'ward Test, John
Peds Wad Test.Inpatent M
| Testiohn
Test Patient &
Test,Fabent B
Test,Pabent C
Test,Pabert [
Test Pabent E
ﬂ Test Pabert F
Test Patiert G
| Test Philly

Figure 25-5: Patient Selection by Wards

Selecting a ward then produces a list of patients registered to that ward in the short
list of the Patients group box.

Save Settings Button

To save the currently viewed list as the default, click Save Settings to display the
Save Patient List Settings information message.

Save Patient List Settings |

Save "Pediatric” Ward
as your defaulk patient list setting?

Figure 25-6: Sample Save Patient List Settings Information Message

Click Yes to create a shortcut to that list at the top of the group box.
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25.3

¥ Defaul: Pediatics

i~ Providers

" Teams

" Specialies
Clinicz

™ wiards

™ Perzonal Lists

Al

Figure 25-7: Sample of a Defined Default Patient List

Personal Lists

For user-managed lists, such as personal lists, enable the Personal Lists radio button
and then click the Manage List button. Clicking this button activates the list manager
function. In this mode, the application replaces the Demographics group box by the
Manage Personal Lists group box as shown below.

The field below the Manage Personal Lists label contains a list of personal list names.
Selecting one of these names displays the member patients in the field below the
Personal List label. These members can be managed using the buttons to the
immediate left. Besides managing a list’s members, you can also create, delete, and
rename personal list names using the New, Delete, and Rename buttons, respectively.

To exit the list management mode, click OK to save any pending changes, or click the
Cancel button to cancel pending changes. The application returns to the patient
selection mode.
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~Patient Lists 1 1~ Patients

Ho Peizonal Lists Found i

“Ackaty.John W

"Decrane Bemice Jowce
Litthecldman Sue

| Lithowck Jusratak, |
||| Litthewecdt Peggy LN
“Rideshors s Aladine
“Rideshorzs, Cabain Gene
“Rideshorza James Lavrence
“Hidechorza, Justin Paul
“Rideghorze, Maty Jans
“Rideghorze Robent W
"Slandsoverbul Brett C,

T
(T |

)

I

Personal Lt Hone sslected

Aupen Victol Curlis
Abbey Atesh
Abbey Brent
Abbothe \wiliam . ames
Abe Lyndon Paul
b, Tyzon E dward
Abwita, Lynstbe )
Abweita, Shedy
Ak, D acme MNoede
I bl Diuanes W
Abel lra Richaed
| ibed Jarnes L
Abel Krisher Hope
bl Miniam LYHN
Abel Sandes Lee
Abel Tirathy Alan [1]4 Cancel
| [1Abel Vincent Les

; LEELEE

L

Figure 25-8: Sample Patient Selection Dialog for Personal Lists

25.4 Managing You Personal List Names
The field below the Manage Personal Lists label contains the names of your personal
lists.
25.4.1 Creating a New Personal List Name
Click the New button in the Manage Personal Lists group box to display the Create a
New List dialog.
]
Lizt Mame
]
Ok | Cancel
Figure 25-9: Create a New List Dialog
Type the name of the new personal list in the text box (free-form text field). See
Section A.2 for more information about editing the text. Click OK to have the name
added to the Personal Lists field.
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25.4.2

25.4.3

25.5

tanage Personal Lists——

Speciality Patients

Figure 25-10: New Name Added to Personal List Names Field

Rename a Personal List Name

To rename a selected personal list name, click the Rename button to display the
Rename List dialog.

Renameist x|

Mew Name

o peciality Fatients

(1] 8 I Cancel

Figure 25-11: Sample Rename List Dialog

Type the new name in the text box (free-form text field). See Section A.2 for more
information about editing the text. Click OK to save the edited name.

Deleting a Personal List Name

To delete a selected personal list name, click the Delete button to display the Confirm
information message.

I 5

2) Doyouuehto delete the selected eniry?

Figure 25-12: Confirm Information Message

Click Yes to remove the selected personal list name from the Personal Lists field.
(Otherwise, click No.)

Managing the Patient Names in a Personal List

The patients in a selected personal list appear the in the field below the Personal List
label.
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To add a patient to a selected personal list, select the patient name in the Patients
group box and then click Add. The patient name appears in the Personal List field for
the selected personal list.

Personal List: Specialiy Pabents
Demo, T odder

Figure 25-13: Name Added to Personal List of Patients

The following table describes the functionality of the buttons.

Button What It Does

Add Adds the currently highlighted patient to the list.

Import Adds all patients displayed in the short list of the Patient panel. Because the
short list can be changed by selecting different list types in the Patient Lists
panel, the import feature can be used to import entries from any other list.

Current Pt | Adds the currently active patient to the list.

Remove Removes the highlighted entry from the list (Remove button) while clicking
Remove All clears the personal list entirely.

Apply Saves all pending changes.

Restore Restores the list to its last saved state.

25.6  Clearing the Patient Context

The functionality of clearing the patient context must be set up by your local CAC.
The Clear function can be one of the following: (1) a menu on the toolbar (where the
Patient menu is located, for example) or (2) an option on a menu, for example an
option on the File menu or the Patient menu.

This feature clears the patient information from the EHR. This means that no patient
data display on any tab. In order to use the EHR after using the Clear feature, you
must select a patient and visit.
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26.0 Personal Health
The Personal Health component has features where you can record data regarding:
Asthma Status, Status Infant Feeding, Birth Measurements, Reproductive History,
Refusal, Treatment Contract, and Functional Status.
Various options are available from the drop-down list, depending on the selected
patient.
*|* Personal Health | To sdd, select & form.. *| = Add | it | ;'J-_-f-_-'cl
T ade a Form
Funchonal Status
Refusal
Repaductive Histo
Figure 26-1: Personal Health Panel
What choices are on the drop-down list depends upon the appropriate BGOZ keys
that are assigned; contact your CAC about the available keys.
This component can be configured so that a particular user or class cannot add/edit
reproductive history information.
The following do not require a visit to selected in order to add, edit, or delete: birth
measurements and refusals. The other options do require a visit.
26.1 Asthma
The Asthma option on the drop-down list is where you record information about the
current patient’s asthma status on the current visit. Those users who have key to
access the Asthma Registry (BATZMENU) key will be able to manage the registry
through the EHR under this option. If you do NOT have the Asthma Registry key,
then the Asthma Register group box will NOT display.
Select the Asthma Status option and click Add to display the Add Asthma Record
dialog.
You populate the various fields about the current patient’s asthma condition by either
manually entering the data or by selecting from the drop-down lists.
When all data has been entered, click OK to add a record to the Personal Health
component.
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w, Add Asthma Record EJ
Sevecty [ ~|  A+hea Management Plan -] 0K |
 LungFunction—— -

Triggers Cancel
EEV1 Env. Tobacco Smoke I vl 4
FEF 2575 Particiate batter I 'I

EEF/estFE [ pustiie [ =]
~ Asihma Begisty
Status Inactive Activate |
' | . i | =]
B

J . o

Figure 26-2: Add Asthma Record Dialog with Asthma Register

26.1.1 Add to Asthma Registry
The following gives the process to Activate the current patient in the Asthma
Registry.
— Asthma Hegishy
Status Inactive Activate I
! | Z ! | 2

- 3

—

|

: -

| | _"l_l
Figure 26-3: Asthma Registry Inactive
Click the Activate button to display the Please Confirm (to activate) information
message.
£

\_‘;:) Are you sUre you want to activate this patient in the asthma registry?

ves [
Figure 26-4: Please Confirm to Activate
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Click Yes to display the Update Asthma Register dialog. (Otherwise, click No.)

m. Update Asthma Registry

x|
UKl
_Cancdl |

Case Manager | |

Figure 26-5: Update Asthma Registry Dialog

You enter asthma-related visit information on this dialog and click OK. The Asthma
Registry group box changes on the Add Asthma Record dialog.

Asthma Registry
Status Active Inaciivate Edit |

Last Asthma Visit 3/5/2007

Calculated Date Due 3M12/2007
Hext Appointment
Caze Manager
Comments

Figure 26-6: Sample Asthma Registry Active

26.1.2 Inactivate/Edit Asthma Registry
Once the Asthma Registry is active for the current patient, you can inactivate or edit
the information.
Click the Inactivate button to display the Please Confirm (to inactivate) information
message.
5
\:I:) Are you sure you want to inactivate this patient in the asthma registry?
= |
Figure 26-7: Confirm Inactivate Asthma Status
Click Yes to inactivate the patient in the asthma registry; the patient’s status will be
Inactive. (Otherwise, click No.)
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Click the Edit button to display the Update Asthma Registry dialog, where you can
change the asthma-related visit information.

26.2 Functional Status

The Functional Status option on the drop-down list is where you record the activities
of daily living.

Select the Functional Status option and click Add to display the Enter Functional
Status Record dialog.

x|
- Activies of Dady Living | [ Instrumental Activities of Daily Living
Toleting [Independert =] Fingnces: [Needs Help =] Ok J
Bathing [Need: Help = Cooking [Totally Dependent =] | Cancel J
Direzsing [Neede Help ﬂ Shopping | Totally Dependent ﬂ
Transfess: [Turaly D eperdes EI Hourewaork: ]Heedz Help ﬂ
Eeeding | Independent =] Medications: |Independent x|

Cogfinence: | Totaly Dependent = | Transportation: | Tctally Dependert = |

Change of Status: Patiert is Caregiver [No =]

Figure 26-8: Sample Enter Functional Status Record Dialog

You can select any one drop-down list to record these associated activities. Click OK
to add the record to the Personal Health component.

26.3 Infant Feeding

The Infant Feeding option on the drop-down list is where you record information
about infant feeding choice for the current patient on the current visit. This applies to
patients < 5 years old.

Select the Infant Feeding option and click Add to display the Infant Feeding Choice
dialog.

. Infant Feeding Choice

[7] Exclusive Breastfeeding
[] Mozt Bre eding

2 Farmula

[ Moty Farmula
[] Farmula Only

Figure 26-9: L Infant Feeding Choice Dialog
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The list allows only one selection. To change a selection, de-select it. Click OK to
add the record to the Personal Health component.

26.4 Refusal

The Refusal option on the Add drop-down list is where you record that the patient
refused treatment or assessment on the current visit. A refusal demonstrates that an
intention was attempted but the patient declined or stated not to perform the treatment
or assessment.

Select the Refusal option and click Add to display the Enter Refusal dialog.
x|
Refusal Type Medication/D
: C]FAP SmI::r ™ Add |
[] Radiology Exam
[]5kin Test Cancel |
| Measwement
Refusal[tem | = |

Date Refused [04/17/2007 =]

: | Mammogram

Comiment

Figure 26-10: Enter Refusal Dialog

Each refusal type is described below.

26.4.1 EKG
Check the EKG checkbox on the Enter Refusal dialog.
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x

[] Medication/Tiug

[ Exam 1 PAP Smear Add |

] Iverwarization [] Radiclogy Exam

[ Lab [ Skan Test Carcel |

(| Mammogram

| Measwemant

EKG [EKG L]
Date Refused [06/23/2007 =]

Comiment

Figure 26-11: Enter Refusal for EKG

Click the = button for the EKG field to display the Lookup Diagnostic Procedure for
EKG where you select a Diagnostic Procedure for EKG (if any).

The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.

You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.

After you click Add, this adds a record to the Personal Health component.

26.4.2 Exam
Check the Exam checkbox on the Enter Refusal dialog.
[ EnterRefusal x|
Refusal Type [ EKG [] Medcation/Drug
v EETI | F:F Smea ad |
1 Intvwsrazation [] Fadiclogy Exam
[ILab (] Skin Test Cancel |
| Mammogram
] Measwement
v | -]
Date Refused [04/17/2007 =
Comment

Figure 26-12: Enter Refusal for Exam
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Click the = button for the Exam field to display a lookup utility where you select an
exam name.

The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.

You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.

After you click Add, this adds a record to the Personal Health component as well as
to the Exams component.

26.4.3 Immunization
Check the Immunization checkbox on the Enter Refusal dialog.
x|
Refuzal T EKG | Medcation/Din
il E xaem | FAF Smear : Add |
Al | reevwanicz ation 1 H&dﬂbﬁl Ewafn
Lab (] Skin Test Canxel
Mammograim
Measmemeant
Irnenurization | =
Date Refused [04/17/2007 =
Coaameent
Figure 26-13: Enter Refusal for Immunization
Click the =1 button for the Immunization field to display the Vaccine Selection dialog
where you select a vaccine.
The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the = button to select from a calendar. The date
cannot be a future date.
You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.
After you click Add, this adds a record to the Personal Health component as well as
to the Immunizations component.
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26.4.4 Lab
Check the Lab checkbox on the Enter Refusal dialog.
x]
Refuzal Type EKG [[] Medication/Tinug
Ewxam [[] PAP Smeat Add |
| Iz alion [] Radiclogy Exam
_u": ] Skin Test Cancel |
|| Mammogram
| Measwement
Lab | -]
Date Refused [04/17/2007 =]
Comiment

Figure 26-14: Enter Refusal for Lab

Click the = button for the Lab field to display a lookup utility where you select an lab
test name.

The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.

You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.

After you click Add, this adds a record to the Personal Health component.

26.4.5 Mammogram
Check the mammogram checkbox on the Enter Refusal dialog.
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wm, Enter Refusal

Refuzal Twpe [[C]EKG
1 Exam
1 Ivrwarazation
] Lalp
v
| Measwmement

[[] MedicationDiug
[[] PAP Smear

[[] Radiclogy Exarm
[ Skin Tesl

I amnenoaram Ih'FAI'-'I MOGRAM

-]

Date Refused [05/23/2007

=

Comamnent

%l
_ |
Camﬂl

Figure 26-15: Enter Refusal for Mammogram

Click the =1 button for the Mammogram field to display a lookup utility for radiology

where you select a radiology exam for mammogram.

The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date

cannot be a future date.

You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See

Section A.2 for more information.

After you click Add, this adds a record to the Personal Health component.

26.4.6 Measurement
Check the Measurement checkbox on the Enter Refusal dialog.
x|
Refuzal Type [ JEKG [ Medcation/Dirug
] Exam [ PAP Smear Add |
Cllmewrizalion ] Radiclogy Exam
[Lab [ Skin Test Cancel |
| Mammogram
EqMeacement
Measwement ' E
Date Refused [04/17/2007 =
Comiment
Figure 26-16: Enter Refusal for Measurement
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Click the = button for the Measurement field to display a lookup utility where you
select a vital measurement name.

The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.

You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.

After you click Add, this adds a record to the Personal Health component.

26.4.7 Medication/Drug
Check the Medication/Drug checkbox on the Enter Refusal dialog.
x|
Refusal Type [EKG P edication/Druo [
Exam PAP Smear Add
] nenwanization ] Radiclogy Exam _l
Lt [1Skm Test Cancel
| Mammogram

Measmement

Medication/Drug || []
Date Refuzed |04/17/2007 =
Comiment
Figure 26-17: Enter Refusal for Medication/Drug
Click the =] button for the Medication/Drug field to display a lookup utility where
you select a drug name.
The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.
You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.
After you click Add, this adds a record to the Personal Health component.
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26.4.8 PAP Smear
Check the PAP Smear checkbox on the Enter Refusal dialog.
x|
Riefuzal T EFG | Medhcation/Dns
A¥pe o J add |
| ez ation [] Radclogy Exam
[lLab [] Skin Test Cancel |
Mammogram
Heasufrnert
AP Smea [PAP SMEAR L]
Date Refused [06/23/2007 =]
Comiment
Figure 26-18: Refusal for PAP Smear
Click the =1 button for the PAP Smear field to display the Lookup Lab Test for PAP
Smear to select a lab test for PAP Smear.
The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.
You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.
After you click Add, this adds a record to the Personal Health component.
26.4.9 Radiology Exam
Check the Radiology Exam checkbox on the Enter Refusal dialog.
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26.4.10

x
Refuzal Type |[]EKG [ Medcation/Tiug
] Exam O] PAP Smear |
] Ieerwarization Kol P schology Exam
] Lab [ Skin Test Cancel |
] Mammogram
| Measmement
Badiology Exam | E
Date Refused [04/17/2007 =
Comment

Figure 26-19: Enter Refusal for Radiology Exam

Click the =] button for the Radiology Exam field to display a lookup utility where you
select a radiology exam name.

The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.

You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.

After you click Add, this adds a record to the Personal Health component.

Skin Test
Check the Skin Test checkbox on the Add Refusal dialog.

w, Enter Refusal

Refusal Type [ EKG

x|
_ A
_Coel |

| Mammogram
| Measuwemant

Skin Test | []

Date Refused [04/17/2007 =]

Comiment

Figure 26-20: Enter Refusal for Skin Test
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Click the = button for the Skin Test field to display a lookup utility where you select
a skin test name.

The Date Refused field defaults to the current date. You can change the date by
entering it manually or by clicking the == button to select from a calendar. The date
cannot be a future date.

You can enter comments about the refusal in the Comment field. This field is a free-
text field that contains a right-click menu to help you in editing the entered text. See
Section A.2 for more information.

After you click Add, this adds a record to the Personal Health component as well as
to the Skin Tests component.

26.5 Birth Measurements

The Birth Measurements option on the drop-down list is where you record birth
measurement information about the current infant on the current visit. This applies to
patients < 8 years old.

Select the Birth Measurements option and click Add to display the Update Birth
Measurements dialog.

=T

T entar Buth Weight in lbe and oz, enber bwo values sapersted by

a hyphen. Alzo you can enfter K. after the value for kiograms [kg]. ok
and likewize for grams enter G after the value, -

Examples: 7 2 fee 7 Ibs 2 023 E_l

32K foe 3.2 kilograms
J200G for 3200 grams

Birth 'Weight | (hs-cz]
Bith Qrder [

Feeding Choices must contain a number and then either a D for Dags,
W for Week s, M for Months or 'y for pears,

Foumnila Started
Breast Feading Stopped E
Solids Started f

Mother or Guardian [ __]

Figure 26-21: Sample Update Birth Measurements Dialog

The unit of measure for birth weight is automatically changed for the following:

e Changes to kilograms if “k” or “K” is typed.
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e Changes to grams if “g” or “G” is typed.
e Changes to Ibs.-oz. if a hyphen or space is typed.
The resulting value is appropriately validated.

The Mother or Guardian field has a lookup utility where you can search for a name.
Click OK to add the record to the Personal Health component.

26.6  Reproductive History

The Reproductive History option on the drop-down list records important data
regarding the current patient’s reproductive history on the current visit. This applies
to female patients only.

Select the Reproductive History option and click Add to display the Update
Reproductive History dialog.

x|
s B ep B Eub B nb B Weonmm .| o« |
Eamly Plaring Method x| DaeFPBegec[— | |
[ Pregnant  Exi Deliven l—,_! Determined By, | Date |

Figure 26-22: Sample Update Reproductive History Dialog

When you are entering data for the G, P, LC, SA, or TA fields, you can either directly
type the number in the field, or click on the up and down arrows (%) to adjust the
value up or down by increments of one.

Panel (Name) Action to Take

G (Gravidity) Enter the number of times this patient has
been pregnant.

P (Parity) Enter the number of times that the patient
has given birth.

LC (Living Children) Enter the patient’'s number of living children.

SA (Spontaneous Abortions) Enter the number of naturally occurring

expulsions of a nonviable fetus.

TA (Therapeutic Abortions) Enter the number of abortions induced when
pregnancy constitutes a threat to the
physical or mental health of the mother.

LMP (Last Menstrual Period) Enter the date of the patient’s last menstrual
period using the calendar (click the =]
button).

Follow these steps to complete the remaining fields:
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1. Family Planning Method: Enter the patient’s method of family planning from
the drop-down list.

2. Date FP Began: Enter the date the patient began her current method of family
planning using the calendar (click the - button).

3. Pregnant: Click the checkbox if the patient is pregnant. This will activate the Est.
Delivery and Determined By fields.

If you have Est. Delivery and/or Determined By fields populated and uncheck
Pregnant, then the Est. Delivery and Determined By fields become blank.

4. Est. Delivery: Enter the patient’s estimated delivery date using the calendar (click

the - button) or by manually entering the date.

5. Determined By: Select from the drop-down list the method by which the
estimated delivery date was determined.

Click OK to add the record to the Personal Health component.

26.7 Treatment Contract
The Treatment Contract option on the drop-down list is where you record that the
treatment contract was made with the patient.
Select the Treatment Contract option and click Add to display the Add Treatment
Contract Record dialog.
x
Type:— ak.
f* Fain —
i~ Mental Health Caa]
Date Initisted; [04/18/2006 o |
Provider: [ ISER DEMDI [
Figure 26-23: Add Treatment Contract Record Dialog
Select either type of contract in the Type field.
The Date Initiated field defaults to the current date. You can change the date by
entering it manually or by clicking the = button to select from a calendar. The date
cannot be a future date.
The Provider field has a lookup utility where you can search for a name. See Section
A.1.3 for more information.
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Click OK to add the record to the Personal Health component.

26.8 Right-Click Menu

The Personal Health panel contains the following right-click menu:

&dd
Edit
Delete

Display Wisit Detail
Figure 26-24: Options on Right-Click Menu
Overview of the options:

The Add, Edit, and Delete options work like the Add, Edit, and Delete buttons on the
Personal Health component.

Display Visit Detail: select a record and click Display Visit Detail to display a popup
showing information about the visit (you can view and/or print the information). See
Section A.3 for m